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License Agreements 
STRUCTUREPOINT EVALUATION SOFTWARE LICENSE AGREEMENT 

BY CLICKING THE “I AGREE” ICON BELOW, OR BY INSTALLING, COPYING, OR 
OTHERWISE USING THE SOFTWARE OR USER DOCUMENTATION, YOU AGREE TO BE 
BOUND BY THE TERMS OF THIS AGREEMENT, INCLUDING, BUT NOT LIMITED TO, THE 
WARRANTY DISCLAIMERS, LIMITATIONS OF LIABILITY AND TERMINATION 
PROVISIONS BELOW. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO 
NOT INSTALL OR USE THE SOFTWARE OR USER DOCUMENTATION, EXIT THIS 
APPLICATION NOW AND RETURN THE SOFTWARE AND USER DOCUMENTATION TO 
STRUCTUREPOINT.  

STRUCTUREPOINT, 5420 OLD ORCHARD ROAD, SKOKIE, ILLINOIS 60077, GRANTS THE 
CUSTOMER A PERSONAL, NONEXCLUSIVE, LIMITED, NONTRANSFERABLE LICENSE TO 
USE THIS SOFTWARE AND USER DOCUMENTATION SOLELY FOR TRIAL AND 
EVALUATION PURPOSES ONLY IN ACCORDANCE WITH THE TERMS AND CONDITIONS 
OF THIS AGREEMENT. SOFTWARE AND USER DOCUMENTATION IS SUPPLIED TO 
CUSTOMER EITHER BY STRUCTUREPOINT DIRECTLY OR THROUGH AN AUTHORIZED 
DEALER OF STRUCTUREPOINT (HEREAFTER DEALER). 

WHILE STRUCTUREPOINT HAS TAKEN PRECAUTIONS TO ASSURE THE CORRECTNESS 
OF THE ANALYTICAL SOLUTION AND DESIGN TECHNIQUES USED IN THIS SOFTWARE, 
IT CANNOT AND DOES NOT GUARANTEE ITS PERFORMANCE, NOR CAN IT OR DOES IT 
BEAR ANY RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN 
CONNECTION WITH WHICH THIS SOFTWARE MAY BE USED. DEALER (IF ANY) HAS NOT 
PARTICIPATED IN THE DESIGN OR DEVELOPMENT OF THIS SOFTWARE AND NEITHER 
GUARANTEES THE PERFORMANCE OF THE SOFTWARE NOR BEARS ANY 
RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN CONNECTION WITH 
WHICH THIS SOFTWARE IS USED. 

STRUCTUREPOINT AND DEALER (IF ANY) EXPRESSLY DISCLAIM ANY WARRANTY 
THAT: (A) THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET THE 
REQUIREMENTS OF CUSTOMER OR OPERATE IN COMBINATIONS THAT MAY BE 
SELECTED FOR USE BY CUSTOMER; (B) THE OPERATION OF THE SOFTWARE WILL BE 
FREE OF ALL "BUGS" OR PROGRAM ERRORS; OR (C) THE SOFTWARE CONFORMS TO 
ANY PERFORMANCE SPECIFICATIONS. CUSTOMER ACKNOWLEDGES THAT 
STRUCTUREPOINT IS UNDER NO OBLIGATION TO PROVIDE ANY SUPPORT, UPDATES, 
BUG FIXES OR ERROR CORRECTIONS TO OR FOR THE SOFTWARE OR USER 
DOCUMENTATION.  

THE LIMITED WARRANTIES IN SECTION 6 HEREOF ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY 
IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS 
FOR A PARTICULAR PURPOSE, EACH OF WHICH IS HEREBY DISCLAIMED. EXCEPT 
AS SET FORTH IN SECTION 6, THE SOFTWARE AND USER DOCUMENTATION ARE 
PROVIDED ON AN "AS-IS" BASIS.  

IN NO EVENT SHALL STRUCTUREPOINT OR DEALER (IF ANY) BE LIABLE FOR: (A) LOSS 
OF PROFITS, DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, PUNITIVE, 
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CONSEQUENTIAL OR OTHER DAMAGES, EVEN IF STRUCTUREPOINT OR DEALER (IF 
ANY) HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES; (B) ANY CLAIM 
AGAINST CUSTOMER BY ANY THIRD PARTY; OR (C) ANY DAMAGES CAUSED BY (1) 
DELAY IN DELIVERY OF THE SOFTWARE OR USER DOCUMENTATION UNDER THIS 
AGREEMENT; (2) THE PERFORMANCE OR NON PERFORMANCE OF THE SOFTWARE; (3) 
RESULTS FROM USE OF THE SOFTWARE OR USER DOCUMENTATION, INCLUDING, 
WITHOUT LIMITATION, MISTAKES, ERRORS, INACCURACIES, FAILURES OR 
CUSTOMER'S INABILITY TO PROVIDE SERVICES TO THIRD PARTIES THROUGH USE OF 
THE SOFTWARE OR USER DOCUMENTATION; (4) CUSTOMER'S FAILURE TO PERFORM 
CUSTOMER'S RESPONSIBILITIES; (5) STRUCTUREPOINT NOT PROVIDING UPDATES, BUG 
FIXES OR CORRECTIONS TO OR FOR ANY OF THE SOFTWARE OR USER 
DOCUMENTATION; (6) LABOR, EXPENSE OR MATERIALS NECESSARY TO REPAIR 
DAMAGE TO THE SOFTWARE OR USER DOCUMENTATION CAUSED BY (a) ACCIDENT, (b) 
NEGLIGENCE OR ABUSE BY CUSTOMER, (c) ACTS OF THIRD PERSONS INCLUDING, BUT 
NOT LIMITED TO, INSTALLATION, REPAIR, MAINTENANCE OR OTHER CORRECTIVE 
WORK RELATED TO ANY EQUIPMENT BEING USED, (d) CAUSES EXTERNAL TO THE 
SOFTWARE SUCH AS POWER FLUCTUATION AND FAILURES, OR (e) FLOODS, 
WINDSTORMS OR OTHER ACTS OF GOD. MOREOVER, IN NO EVENT SHALL 
STRUCTUREPOINT BE LIABLE FOR WARRANTIES, GUARANTEES, REPRESENTATIONS 
OR ANY OTHER UNDERSTANDINGS BETWEEN CUSTOMER AND DEALER (IF ANY) 
RELATING TO THE SOFTWARE OR USER DOCUMENTATION. 

THIS AGREEMENT CONSTITUTES THE ENTIRE AND EXCLUSIVE AGREEMENT BETWEEN 
CUSTOMER AND STRUCTUREPOINT AND DEALER (IF ANY) WITH RESPECT TO THE 
SOFTWARE AND USER DOCUMENTATION TO BE FURNISHED HEREUNDER. IT IS A 
FINAL EXPRESSION OF THAT AGREEMENT AND UNDERSTANDING. IT SUPERSEDES ALL 
PRIOR COMMUNICATIONS BETWEEN THE PARTIES (INCLUDING ANY EVALUATION 
LICENSE AND ALL ORAL AND WRITTEN PROPOSALS). ORAL STATEMENTS MADE BY 
STRUCTUREPOINT'S OR DEALER'S (IF ANY) REPRESENTATIVES ABOUT THE SOFTWARE 
OR USER DOCUMENTATION DO NOT CONSTITUTE REPRESENTATIONS OR 
WARRANTIES, SHALL NOT BE RELIED ON BY CUSTOMER, AND ARE NOT PART OF THIS 
AGREEMENT. 

1. LICENSE RESTRICTIONS  
a. Except as expressly provided in this Agreement or as otherwise authorized in writing by 

STRUCTUREPOINT, Customer has no right to: (1) use, print, copy, display, reverse 
assemble, reverse engineer, translate or decompile the Software or User Documentation in 
whole or in part; (2) disclose, publish, release, sublicense or transfer to another person any 
Software or User Documentation; (3) reproduce the Software or User Documentation for the 
use or benefit of anyone other than Customer; or (4) modify any Software or User 
Documentation. All rights to the Software and User Documentation not expressly granted to 
Customer hereunder are retained by STRUCTUREPOINT. All copyrights and other 
proprietary rights except as expressed elsewhere in the Software or User Documentation and 
legal title thereto shall remain in STRUCTUREPOINT. Customer may use the Software 
only as licensed by STRUCTUREPOINT on designated workstation at Customer's site at 
any given time. Customer may not transmit the Software licenses electronically to any other 
workstation, computer, node or terminal device whether via a local area network, a wide 
area network, telecommunications transmission, the Internet or other means now known or 
hereafter created without prior written permission by STRUCTUREPOINT.  
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b. Customer acknowledges that this is a limited license for trial and evaluation purposes only. 
This limited license shall automatically terminate upon the earlier of: (1) ten executions of 
the Software on the computer on which it is installed; or (2) fifteen days after the installation 
of the Software. Thereafter, Customer may only use the Software and Documentation if it 
acquires a production license for the same.  

2. TERM AND TERMINATION  
a. This Agreement shall be in effect from the date Customer clicks the “I AGREE” icon below 

or installs, copies or otherwise uses the Software or User Documentation until: (1) it is 
terminated by Customer, by Dealer (if any) on behalf of Customer or STRUCTUREPOINT 
or by STRUCTUREPOINT as set forth herein; or (2) the limited trial and evaluation license 
terminates.  

b. This Agreement may be terminated by STRUCTUREPOINT without cause upon 30 days' 
written notice or immediately upon notice to Customer if Customer breaches this Agreement 
or fails to comply with any of its terms or conditions. This Agreement may be terminated by 
Customer without cause at any time upon written notice to STRUCTUREPOINT.  

3. BACKUP AND REPLACEMENT COPIES  
Customer may make one copy of the Software for back-up and archival purposes only, provided 
STRUCTUREPOINT's copyright and other proprietary rights notices are included on such copy.  

4. PROTECTION AND SECURITY  
a. Customer shall not provide or otherwise make available any of the Software or User 

Documentation in any form to any person other than employees of Customer with the need 
to know, without STRUCTUREPOINT's written permission. 

b. All Software and User Documentation in Customer's possession including, without 
limitation, translations, compilations, back-up, and partial copies is the property of 
STRUCTUREPOINT. Upon termination of this Agreement for any reason, Customer shall 
immediately destroy all Software and User Documentation, including all media, and destroy 
any Software that has been copied onto other magnetic storage devices. Upon 
STRUCTUREPOINT’s request, Customer shall certify its compliance in writing with the 
foregoing to STRUCTUREPOINT. 

c. Customer shall take appropriate action, by instruction, agreement or otherwise, with any 
persons permitted access to the Software or User Documentation, to enable Customer to 
satisfy its obligations under this Agreement with respect to use, copying, protection, and 
security of the same. 

d. If STRUCTUREPOINT prevails in an action against Customer for breach of the provisions 
of this Section 4, Customer shall pay the reasonable attorneys' fees, costs, and expenses 
incurred by STRUCTUREPOINT in connection with such action in addition to any award 
of damages. 

5. CUSTOMER'S RESPONSIBILITIES  
The essential purpose of this Agreement is to provide Customer with limited use rights to the 
Software and User Documentation. Customer accepts full responsibility for: (a) selection of the 
Software and User Documentation to satisfy Customer's business needs and achieve Customer's 
intended results; (b) the use, set-up and installation of the Software and User Documentation; 
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(c) all results obtained from use of the Software and User Documentation; and (d) the selection, 
use of, and results obtained from any other software, programming equipment or services used 
with the Software or User Documentation. 

6. LIMITED WARRANTIES  
STRUCTUREPOINT and Dealer (if any) warrants to Customer that: (a) STRUCTUREPOINT 
and Dealer (if any) has title to the Software and User Documentation and/or the right to grant 
Customer the rights granted hereunder; (b) the Software and User Documentation provided 
hereunder is STRUCTUREPOINT's most current production version thereof; and (c) the copy of 
the Software provided hereunder is an accurate reproduction of the original from which it was 
made.  

7. LIMITATION OF REMEDY  
a. STRUCTUREPOINT AND DEALER (IF ANY) HAS NO LIABILITY UNDER THIS 

AGREEMENT. CUSTOMER'S EXCLUSIVE REMEDY FOR DAMAGES DUE TO 
PERFORMANCE OR NONPERFORMANCE OF ANY SOFTWARE OR USER 
DOCUMENTATION, STRUCTUREPOINT, DEALER (IF ANY), OR ANY OTHER 
CAUSE WHATSOEVER, AND REGARDLESS OF THE FORM OF ACTION, 
WHETHER IN CONTRACT OR IN TORT, INCLUDING NEGLIGENCE, SHALL BE 
LIMITED TO CUSTOMER STOPPING ALL USE OF THE SOFTWARE AND USER 
DOCUMENTATION AND RETURNING THE SAME TO STRUCTUREPOINT.  

b. NEITHER STRUCTUREPOINT NOR DEALER (IF ANY) IS AN INSURER WITH 
REGARD TO THE PERFORMANCE OF THE SOFTWARE OR USER 
DOCUMENTATION. THE TERMS OF THIS AGREEMENT, INCLUDING, BUT 
NOT LIMITED TO, THE LIMITED WARRANTIES, AND THE LIMITATION OF 
LIABILITY AND REMEDY, ARE A REFLECTION OF THE RISKS ASSUMED BY 
THE PARTIES. IN ORDER TO OBTAIN THE SOFTWARE AND USER 
DOCUMENTATION FROM STRUCTUREPOINT OR DEALER (IF ANY), 
CUSTOMER HEREBY ASSUMES THE RISKS FOR (1) ALL LIABILITIES 
DISCLAIMED BY STRUCTUREPOINT AND DEALER (IF ANY) ON THE FACE 
HEREOF; AND (2) ALL ACTUAL OR ALLEGED DAMAGES IN CONNECTION 
WITH THE USE OF THE SOFTWARE AND USER DOCUMENTATION. THE 
ESSENTIAL PURPOSE OF THE LIMITED REMEDY PROVIDED CUSTOMER 
HEREUNDER IS TO ALLOCATE THE RISKS AS PROVIDED ABOVE. 

8. U.S. GOVERNMENT RESTRICTED RIGHTS  
This commercial computer software and commercial computer software documentation were 
developed exclusively at private expense by STRUCTUREPOINT, 5420 Old Orchard Road, 
Skokie, Illinois, 60077. U.S. Government rights to use, modify, release, reproduce, perform, 
display or disclose this computer software and computer software documentation are subject to 
the restrictions of DFARS 227.7202-1(a) (September 2007) and DFARS 227.7202-3(a) 
(September 2007), or the Restricted Rights provisions of FAR 52.227-14 (December 2007) and 
FAR 52.227-19 (December 2007), as applicable. 

9. GENERAL  
a. No action arising out of any claimed breach of this Agreement or transactions under this 

Agreement may be brought by Customer more than two years after the cause of such action 
has arisen. 
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b. Customer may not assign, sell, sublicense or otherwise transfer this Agreement, the license 
granted herein or the Software or User Documentation by operation of law or otherwise 
without the prior written consent of STRUCTUREPOINT. Any attempt to do any of the 
foregoing without STRUCTUREPOINT’s consent is void.  

c. Customer acknowledges that the Software, User Documentation and other proprietary 
information and materials of STRUCTUREPOINT are unique and that, if Customer 
breaches this Agreement, STRUCTUREPOINT may not have an adequate remedy at law 
and STRUCTUREPOINT may enforce its rights hereunder by an action for damages and/or 
injunctive or other equitable relief without the necessity of proving actual damage or posting 
a bond therefor. 

d. THE RIGHTS AND OBLIGATIONS UNDER THIS AGREEMENT SHALL NOT BE 
GOVERNED BY THE UNITED NATIONS CONVENTION ON CONTRACTS FOR THE 
INTERNATIONAL SALE OF GOODS, THE APPLICATION OF WHICH IS 
EXPRESSLY EXCLUDED, BUT SUCH RIGHTS AND OBLIGATIONS SHALL 
INSTEAD BE GOVERNED BY THE LAWS OF THE STATE OF ILLINOIS, 
APPLICABLE TO CONTRACTS ENTERED INTO AND PERFORMED ENTIRELY 
WITHIN THE STATE OF ILLINOIS AND APPLICABLE FEDERAL (U.S.) LAWS. 
UCITA SHALL NOT APPLY TO THIS AGREEMENT. 

e. THIS AGREEMENT SHALL BE TREATED AS THOUGH IT WERE EXECUTED IN 
THE COUNTY OF COOK, STATE OF ILLINOIS, AND WAS TO HAVE BEEN 
PERFORMED IN THE COUNTY OF COOK, STATE OF ILLINOIS. ANY ACTION 
RELATING TO THIS AGREEMENT SHALL BE INSTITUTED AND PROSECUTED IN 
A COURT LOCATED IN COOK COUNTY, ILLINOIS. CUSTOMER SPECIFICALLY 
CONSENTS TO EXTRATERRITORIAL SERVICE OF PROCESS. 

f. Except as prohibited elsewhere in this Agreement, this Agreement shall be binding upon and 
inure to the benefit of the personal and legal representatives, permitted successors, and 
permitted assigns of the parties hereto.  

g. All notices, demands, consents or requests that may be or are required to be given by any 
party to another party shall be in writing. All notices, demands, consents or requests given 
by the parties hereto shall be sent either by U.S. certified mail, postage prepaid or by an 
overnight international delivery service, addressed to the respective parties. Notices, 
demands, consents or requests served as set forth herein shall be deemed sufficiently served 
or given at the time of receipt thereof.  

h. The various rights, options, elections, powers, and remedies of a party or parties to this 
Agreement shall be construed as cumulative and no one of them exclusive of any others or 
of any other legal or equitable remedy that said party or parties might otherwise have in the 
event of breach or default in the terms hereof. The exercise of one right or remedy by a party 
or parties shall not in any way impair its rights to any other right or remedy until all 
obligations imposed on a party or parties have been fully performed. 

i. No waiver by Customer, STRUCTUREPOINT or Dealer (if any) of any breach, provision, 
or default by the other shall be deemed a waiver of any other breach, provision or default.  

j. The parties hereto, and each of them, agree that the terms of this Agreement shall be given 
a neutral interpretation and any ambiguity or uncertainty herein should not be construed 
against any party hereto. 
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k. If any provision of this Agreement or portion thereof is held to be unenforceable or invalid 
by any court or competent jurisdiction, such decision shall not have the effect of 
invalidating or voiding the remainder of this Agreement, it being the intent and agreement 
of the parties that this Agreement shall be deemed amended by modifying such provision to 
the extent necessary to render it enforceable and valid while preserving its intent or, if such 
modification is not possible, by substituting therefor another provision that is enforceable 
and valid so as to materially effectuate the parties’ intent.  

Except as set forth herein, this Agreement may be modified or amended only by a written instrument 
signed by a duly authorized representative of STRUCTUREPOINT and Customer. 
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STRUCTUREPOINT SOFTWARE LICENSE AGREEMENT 
BY CLICKING THE “I AGREE” BELOW, OR BY INSTALLING, COPYING, OR OTHERWISE 
USING THE SOFTWARE OR USER DOCUMENTATION, YOU AGREE TO BE BOUND BY THE 
TERMS OF THIS AGREEMENT, INCLUDING, BUT NOT LIMITED TO, THE WARRANTY 
DISCLAIMERS, LIMITATIONS OF LIABILITY AND TERMINATION PROVISIONS BELOW. IF 
YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT INSTALL OR USE 
THE SOFTWARE OR USER DOCUMENTATION, EXIT THIS APPLICATION NOW AND 
RETURN THE SOFTWARE AND USER DOCUMENTATION TO STRUCTUREPOINT FOR A 
FULL REFUND WITHIN THIRTY DAYS AFTER YOUR RECEIPT OF THE SOFTWARE AND 
USER DOCUMENTATION. 

STRUCTUREPOINT, 5420 OLD ORCHARD ROAD, SKOKIE, ILLINOIS 60077, GRANTS THE 
CUSTOMER A PERSONAL, NONEXCLUSIVE, LIMITED, NONTRANSFERABLE LICENSE TO 
USE THIS SOFTWARE AND USER DOCUMENTATION IN ACCORDANCE WITH THE TERMS 
AND CONDITIONS OF THIS AGREEMENT. SOFTWARE AND USER DOCUMENTATION IS 
SUPPLIED TO CUSTOMER EITHER BY STRUCTUREPOINT DIRECTLY OR THROUGH AN 
AUTHORIZED DEALER OF STRUCTUREPOINT (HEREAFTER DEALER). 

WHILE STRUCTUREPOINT HAS TAKEN PRECAUTIONS TO ASSURE THE CORRECTNESS 
OF THE ANALYTICAL SOLUTION AND DESIGN TECHNIQUES USED IN THIS SOFTWARE, 
IT CANNOT AND DOES NOT GUARANTEE ITS PERFORMANCE, NOR CAN IT OR DOES IT 
BEAR ANY RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN 
CONNECTION WITH WHICH THIS SOFTWARE IS USED. DEALER (IF ANY) HAS NOT 
PARTICIPATED IN THE DESIGN OR DEVELOPMENT OF THIS SOFTWARE AND NEITHER 
GUARANTEES THE PERFORMANCE OF THE SOFTWARE NOR BEARS ANY 
RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN CONNECTION WITH 
WHICH THIS SOFTWARE IS USED. 

STRUCTUREPOINT AND DEALER (IF ANY) EXPRESSLY DISCLAIM ANY WARRANTY 
THAT: (A) THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET THE 
REQUIREMENTS OF CUSTOMER OR OPERATE IN COMBINATIONS THAT MAY BE 
SELECTED FOR USE BY CUSTOMER; (B) THE OPERATION OF THE SOFTWARE WILL BE 
FREE OF ALL "BUGS" OR PROGRAM ERRORS; OR (C) THE SOFTWARE CONFORMS TO 
ANY PERFORMANCE SPECIFICATIONS. CUSTOMER ACKNOWLEDGES THAT 
STRUCTUREPOINT IS UNDER NO OBLIGATION TO PROVIDE ANY SUPPORT, UPDATES, 
BUG FIXES OR ERROR CORRECTIONS TO OR FOR THE SOFTWARE OR USER 
DOCUMENTATION.  

THE LIMITED WARRANTIES IN SECTION 7 HEREOF ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY 
IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS 
FOR A PARTICULAR PURPOSE, EACH OF WHICH IS HEREBY DISCLAIMED. EXCEPT 
AS SET FORTH IN SECTION 7, THE SOFTWARE AND USER DOCUMENTATION ARE 
PROVIDED ON AN "AS-IS" BASIS.  

IN NO EVENT SHALL STRUCTUREPOINT OR DEALER (IF ANY) BE LIABLE FOR: (A) LOSS 
OF PROFITS, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, PUNITIVE, 
CONSEQUENTIAL OR OTHER DAMAGES, EVEN IF STRUCTUREPOINT OR DEALER (IF 
ANY) HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES; (B) ANY CLAIM 
AGAINST CUSTOMER BY ANY THIRD PARTY EXCEPT AS PROVIDED IN SECTION 8 
ENTITLED "INFRINGEMENT"; OR (C) ANY DAMAGES CAUSED BY (1) DELAY IN 
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DELIVERY OF THE SOFTWARE OR USER DOCUMENTATION UNDER THIS AGREEMENT; 
(2) THE PERFORMANCE OR NONPERFORMANCE OF THE SOFTWARE; (3) RESULTS FROM 
USE OF THE SOFTWARE OR USER DOCUMENTATION, INCLUDING, WITHOUT 
LIMITATION, MISTAKES, ERRORS, INACCURACIES, FAILURES OR CUSTOMER'S 
INABILITY TO PROVIDE SERVICES TO THIRD PARTIES THROUGH USE OF THE 
SOFTWARE OR USER DOCUMENTATION; (4) CUSTOMER'S FAILURE TO PERFORM 
CUSTOMER'S RESPONSIBILITIES; (5) STRUCTUREPOINT NOT PROVIDING UPDATES, BUG 
FIXES OR CORRECTIONS TO OR FOR ANY OF THE SOFTWARE OR USER 
DOCUMENTATION; (6) LABOR, EXPENSE OR MATERIALS NECESSARY TO REPAIR 
DAMAGE TO THE SOFTWARE OR USER DOCUMENTATION CAUSED BY (a) ACCIDENT, (b) 
NEGLIGENCE OR ABUSE BY CUSTOMER, (c) ACTS OF THIRD PERSONS INCLUDING, BUT 
NOT LIMITED TO, INSTALLATION, REPAIR, MAINTENANCE OR OTHER CORRECTIVE 
WORK RELATED TO ANY EQUIPMENT BEING USED, (d) CAUSES EXTERNAL TO THE 
SOFTWARE SUCH AS POWER FLUCTUATION AND FAILURES, OR (e) FLOODS, 
WINDSTORMS OR OTHER ACTS OF GOD. MOREOVER, IN NO EVENT SHALL 
STRUCTUREPOINT BE LIABLE FOR WARRANTIES, GUARANTEES, REPRESENTATIONS 
OR ANY OTHER UNDERSTANDINGS BETWEEN CUSTOMER AND DEALER (IF ANY) 
RELATING TO THE SOFTWARE OR USER DOCUMENTATION. 

THIS AGREEMENT CONSTITUTES THE ENTIRE AND EXCLUSIVE AGREEMENT BETWEEN 
CUSTOMER AND STRUCTUREPOINT AND DEALER (IF ANY) WITH RESPECT TO THE 
SOFTWARE AND USER DOCUMENTATION TO BE FURNISHED HEREUNDER. IT IS A 
FINAL EXPRESSION OF THAT AGREEMENT AND UNDERSTANDING. IT SUPERSEDES ALL 
PRIOR COMMUNICATIONS BETWEEN THE PARTIES (INCLUDING ANY EVALUATION 
LICENSE AND ALL ORAL AND WRITTEN PROPOSALS). ORAL STATEMENTS MADE BY 
STRUCTUREPOINT 'S OR DEALER'S (IF ANY) REPRESENTATIVES ABOUT THE SOFTWARE 
OR USER DOCUMENTATION DO NOT CONSTITUTE REPRESENTATIONS OR 
WARRANTIES, SHALL NOT BE RELIED ON BY CUSTOMER, AND ARE NOT PART OF THIS 
AGREEMENT. 

1. LICENSE RESTRICTIONS  
l. Except as expressly provided in this Agreement or as otherwise authorized in writing by 

STRUCTUREPOINT, Customer has no right to: (1) use, print, copy, display, reverse 
assemble, reverse engineer, translate or decompile the Software or User Documentation in 
whole or in part; (2) disclose, publish, release, sublicense or transfer to another person any 
Software or User Documentation; (3) reproduce the Software or User Documentation for the 
use or benefit of anyone other than Customer; or (4) modify any Software or User 
Documentation. All rights to the Software and User Documentation not expressly granted to 
Customer hereunder are retained by STRUCTUREPOINT. All copyrights and other 
proprietary rights except as expressed elsewhere in the Software or User Documentation and 
legal title thereto shall remain in STRUCTUREPOINT. Customer may use the Software 
only as licensed by STRUCTUREPOINT on designated workstation at Customer's site at 
any given time. Customer may not transmit the Software licenses electronically to any other 
workstation, computer, node or terminal device whether via a local area network, a wide 
area network, telecommunications transmission, the Internet or other means now known or 
hereafter created without prior written permission by STRUCTUREPOINT. 

m. Customer acknowledges that the registration process for the Software results in the 
generation of a unique license code. Once the license code is entered DURING THE 
INSTALLATION PROCESS, the Software will only work on the computer on which the 
Software LICENSE is INITIALLY installed. If you need to deinstall the Software license 
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and reinstall the Software license on a different computer, you must contact 
STRUCTUREPOINT to obtain the necessary reinstallation procedures. 

2. CHARGES AND PAYMENTS  
All payments for the Software and User Documentation shall be made to either 
STRUCTUREPOINT or Dealer (if any), as appropriate. 

3. TERM AND TERMINATION  
n. This Agreement shall be in effect from the date Customer clicks the “I AGREE” below or 

installs, copies or otherwise uses the Software or User Documentation until it is terminated 
by Customer, by Dealer (if any) on behalf of Customer or STRUCTUREPOINT or by 
STRUCTUREPOINT as set forth herein. 

o. This Agreement may be terminated by STRUCTUREPOINT without cause upon 30 days' 
written notice or immediately upon notice to Customer if Customer breaches this Agreement 
or fails to comply with any of its terms or conditions. This Agreement may be terminated by 
Customer without cause at any time upon written notice to STRUCTUREPOINT.  

4. BACKUP AND REPLACEMENT COPIES  
Customer may make one copy of the Software for back-up and archival purposes only, provided 
STRUCTUREPOINT's copyright and other proprietary rights notices are included on such copy.  

5. PROTECTION AND SECURITY  
p. Customer shall not provide or otherwise make available any of the Software or User 

Documentation in any form to any person other than employees of Customer with the need 
to know, without STRUCTUREPOINT's written permission. 

q. All Software and User Documentation in Customer's possession including, without 
limitation, translations, compilations, back-up, and partial copies is the property of 
STRUCTUREPOINT. Upon termination of this Agreement for any reason, Customer shall 
immediately destroy all Software and User Documentation, including all media, and destroy 
any Software that has been copied onto other magnetic storage devices. Upon 
STRUCTUREPOINT’s request, Customer shall certify its compliance in writing with the 
foregoing to STRUCTUREPOINT. 

r. Customer shall take appropriate action, by instruction, agreement or otherwise, with any 
persons permitted access to the Software or User Documentation, to enable Customer to 
satisfy its obligations under this Agreement with respect to use, copying, protection, and 
security of the same. 

s. If STRUCTUREPOINT prevails in an action against Customer for breach of the provisions 
of this Section 5, Customer shall pay the reasonable attorneys' fees, costs, and expenses 
incurred by STRUCTUREPOINT in connection with such action in addition to any award 
of damages. 

6. CUSTOMER'S RESPONSIBILITIES  
The essential purpose of this Agreement is to provide Customer with limited use rights to the 
Software and User Documentation. Customer accepts full responsibility for: (a) selection of the 
Software and User Documentation to satisfy Customer's business needs and achieve Customer's 
intended results; (b) the use, set-up and installation of the Software and User Documentation; (c) 
all results obtained from use of the Software and User Documentation; and (d) the selection, use 
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of, and results obtained from any other software, programming equipment or services used with 
the Software or User Documentation. 

7. LIMITED WARRANTIES  
STRUCTUREPOINT and Dealer (if any) warrants to Customer that: (a) STRUCTUREPOINT 
and Dealer (if any) has title to the Software and User Documentation and/or the right to grant 
Customer the rights granted hereunder; (b) the Software and User Documentation provided 
hereunder is STRUCTUREPOINT's most current production version thereof; and (c) the copy of 
the Software provided hereunder is an accurate reproduction of the original from which it was 
made. 

8. INFRINGEMENT  
t. STRUCTUREPOINT shall defend Customer against a claim that the Software or User 

Documentation furnished and used within the scope of the license granted hereunder 
infringes a U.S. patent or U.S. registered copyright of any third party that was issued or 
registered, as applicable, as of the date Customer clicked the “I AGREE” below or installed, 
copied or otherwise began using the Software or User Documentation, and 
STRUCTUREPOINT shall pay resulting costs, damages, and attorneys' fees finally 
awarded, subject to the limitation of liability set forth in Section 9 entitled "Limitation of 
Remedy," provided that: 
1. Customer promptly notifies STRUCTUREPOINT in writing of the claim. 
2. STRUCTUREPOINT has sole control of the defense and all related settlement 
negotiations.  
3. If such claim has occurred or in STRUCTUREPOINT's opinion is likely to occur, 
Customer shall permit STRUCTUREPOINT at its sole option and expense either to procure 
for Customer the right to continue using the Software or User Documentation or to replace 
or modify the same so that it becomes noninfringing. If neither of the foregoing alternatives 
is reasonably available in STRUCTUREPOINT's sole judgment, Customer shall, on one 
month's written notice from STRUCTUREPOINT, return to STRUCTUREPOINT the 
Software and User Documentation and all copies thereof. 

u. STRUCTUREPOINT shall have no obligation to defend Customer or to pay costs, damages 
or attorneys' fees for any claim based upon (1) use of other than a current unaltered release 
of the Software or User Documentation, or (2) the combination, operation or use of any 
Software or User Documentation furnished hereunder with any other software, 
documentation or data if such infringement would have been avoided but for the 
combination, operation or use of the Software or User Documentation with other software, 
documentation or data. 

v. The foregoing states the entire obligation of STRUCTUREPOINT and Customer’s sole 
remedy with respect to infringement matters relating to the Software and User 
Documentation. 

9. LIMITATION OF REMEDY  
w. STRUCTUREPOINT'S AND DEALER'S (IF ANY) ENTIRE LIABILITY AND 

CUSTOMER'S EXCLUSIVE REMEDY FOR DAMAGES DUE TO 
PERFORMANCE OR NONPERFORMANCE OF ANY SOFTWARE OR USER 
DOCUMENTATION, STRUCTUREPOINT, DEALER (IF ANY), OR ANY OTHER 
CAUSE WHATSOEVER, AND REGARDLESS OF THE FORM OF ACTION, 
WHETHER IN CONTRACT OR IN TORT, INCLUDING NEGLIGENCE, SHALL 
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BE LIMITED TO THE AMOUNT PAID TO STRUCTUREPOINT OR DEALER (IF 
ANY) FOR THE SOFTWARE AND USER DOCUMENTATION. 

x. NEITHER STRUCTUREPOINT NOR DEALER (IF ANY) IS AN INSURER WITH 
REGARD TO THE PERFORMANCE OF THE SOFTWARE OR USER 
DOCUMENTATION. THE TERMS OF THIS AGREEMENT, INCLUDING, BUT 
NOT LIMITED TO, THE LIMITED WARRANTIES, AND THE LIMITATION OF 
LIABILITY AND REMEDY, ARE A REFLECTION OF THE RISKS ASSUMED BY 
THE PARTIES. IN ORDER TO OBTAIN THE SOFTWARE AND USER 
DOCUMENTATION FROM STRUCTUREPOINT OR DEALER (IF ANY), 
CUSTOMER HEREBY ASSUMES THE RISKS FOR (1) ALL LIABILITIES 
DISCLAIMED BY STRUCTUREPOINT AND DEALER (IF ANY) ON THE FACE 
HEREOF; AND (2) ALL ACTUAL OR ALLEGED DAMAGES IN EXCESS OF THE 
AMOUNT OF THE LIMITED REMEDY PROVIDED HEREUNDER. THE 
ESSENTIAL PURPOSE OF THE LIMITED REMEDY PROVIDED CUSTOMER 
HEREUNDER IS TO ALLOCATE THE RISKS AS PROVIDED ABOVE.  

10. U.S. GOVERNMENT RESTRICTED RIGHTS  
This commercial computer software and commercial computer software documentation were 
developed exclusively at private expense by STRUCTUREPOINT, 5420 Old Orchard Road, 
Skokie, Illinois 60077. U.S. Government rights to use, modify, release, reproduce, perform, 
display or disclose this computer software and computer software documentation are subject to 
the restrictions of DFARS 227.7202-1(a) (September 2007) and DFARS 227.7202-3(a) 
(September 2007), or the Restricted Rights provisions of FAR 52.227-14 (December 2007) and 
FAR 52.227-19 (December 2007), as applicable. 

11. GENERAL  
y. No action arising out of any claimed breach of this Agreement or transactions under this 

Agreement may be brought by Customer more than two years after the cause of such action 
has arisen. 

z. Customer may not assign, sell, sublicense or otherwise transfer this Agreement, the license 
granted herein or the Software or User Documentation by operation of law or otherwise 
without the prior written consent of STRUCTUREPOINT. Any attempt to do any of the 
foregoing without STRUCTUREPOINT’s consent is void.  

aa. Customer acknowledges that the Software, User Documentation and other proprietary 
information and materials of STRUCTUREPOINT are unique and that, if Customer 
breaches this Agreement, STRUCTUREPOINT may not have an adequate remedy at law 
and STRUCTUREPOINT may enforce its rights hereunder by an action for damages and/or 
injunctive or other equitable relief without the necessity of proving actual damage or posting 
a bond therefor. 

bb. THE RIGHTS AND OBLIGATIONS UNDER THIS AGREEMENT SHALL NOT BE 
GOVERNED BY THE UNITED NATIONS CONVENTION ON CONTRACTS FOR THE 
INTERNATIONAL SALE OF GOODS, THE APPLICATION OF WHICH IS 
EXPRESSLY EXCLUDED, BUT SUCH RIGHTS AND OBLIGATIONS SHALL 
INSTEAD BE GOVERNED BY THE LAWS OF THE STATE OF ILLINOIS, 
APPLICABLE TO CONTRACTS ENTERED INTO AND PERFORMED ENTIRELY 
WITHIN THE STATE OF ILLINOIS AND APPLICABLE FEDERAL (U.S.) LAWS. 
UCITA SHALL NOT APPLY TO THIS AGREEMENT.  
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cc. THIS AGREEMENT SHALL BE TREATED AS THOUGH IT WERE EXECUTED IN 
THE COUNTY OF COOK, STATE OF ILLINOIS, AND WAS TO HAVE BEEN 
PERFORMED IN THE COUNTY OF COOK, STATE OF ILLINOIS. ANY ACTION 
RELATING TO THIS AGREEMENT SHALL BE INSTITUTED AND PROSECUTED IN 
A COURT LOCATED IN COOK COUNTY, ILLINOIS. CUSTOMER SPECIFICALLY 
CONSENTS TO EXTRATERRITORIAL SERVICE OF PROCESS.  

dd. Except as prohibited elsewhere in this Agreement, this Agreement shall be binding upon and 
inure to the benefit of the personal and legal representatives, permitted successors, and 
permitted assigns of the parties hereto.  

ee. All notices, demands, consents or requests that may be or are required to be given by any 
party to another party shall be in writing. All notices, demands, consents or requests given 
by the parties hereto shall be sent either by U.S. certified mail, postage prepaid or by an 
overnight international delivery service, addressed to the respective parties. Notices, 
demands, consents or requests served as set forth herein shall be deemed sufficiently served 
or given at the time of receipt thereof.  

ff. The various rights, options, elections, powers, and remedies of a party or parties to this 
Agreement shall be construed as cumulative and no one of them exclusive of any others or 
of any other legal or equitable remedy that said party or parties might otherwise have in the 
event of breach or default in the terms hereof. The exercise of one right or remedy by a party 
or parties shall not in any way impair its rights to any other right or remedy until all 
obligations imposed on a party or parties have been fully performed. 

gg. No waiver by Customer, STRUCTUREPOINT or Dealer (if any) of any breach, provision, 
or default by the other shall be deemed a waiver of any other breach, provision or default.  

hh. The parties hereto, and each of them, agree that the terms of this Agreement shall be given a 
neutral interpretation and any ambiguity or uncertainty herein should not be construed 
against any party hereto. 

ii. If any provision of this Agreement or portion thereof is held to be unenforceable or invalid 
by any court or competent jurisdiction, such decision shall not have the effect of 
invalidating or voiding the remainder of this Agreement, it being the intent and agreement 
of the parties that this Agreement shall be deemed amended by modifying such provision to 
the extent necessary to render it enforceable and valid while preserving its intent or, if such 
modification is not possible, by substituting therefor another provision that is enforceable 
and valid so as to materially effectuate the parties’ intent.  

Except as set forth herein, this Agreement may be modified or amended only by a written instrument 
signed by a duly authorized representative of STRUCTUREPOINT and Customer. 

 

April 2009 

 

 



 

Chapter 1 – Introduction 
Introduction 

Formerly pcaSlab and ADOSS, spSlab is a computer program for the analysis and 
design of reinforced concrete beams and slab floor systems. Two-way slab systems 
are analyzed using the Equivalent Frame Method. Beams and frames of up to 22 
spans can be analyzed and designed. In addition to the design option spSlab has 
the capability of investigating existing beams and slab systems. spSlab includes 
provisions for slab band systems as well as punching shear check and deflection 
calculations using cracked or gross sections. For beams, moment redistribution as 
well as combined shear and torsion design are available. Material quantity take-
offs are computed. In addition to the required area of reinforcing steel at the 
critical sections, spSlab provides a complete bar schedule that includes number of 
bars and bar sizes and lengths. spSlab checks the applicable provisions of the 
relevant code. 

Formerly pcaBeam, spBeam is a limited version of spSlab. It includes all elements 
that apply to beams and one-way slab systems. Topics describing these elements 
are denoted with  icon because they are included in both spSlab and 
spBeam. Two-way slab systems are available in spSlab only and topics related to 
two-way slab systems are denoted with  icon. 

Program Features  
• ACI 318-08, ACI 318-05, ACI 318-02, ACI 318-99, CSA A23.3-04, and CSA 

A23.3-94 

• English and SI units 

• Design and investigation of beams, one and two-way slabs including one-way 
joist systems (standard and wide module) and two-way joist systems (waffle 
slabs) 

• Slab band system design and investigation for CSA A23.3-04 standard 

• Flexure and shear design and investigation 

• Torsion design and investigation for beams/one-way slab systems 
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• Longitudinal reinforcement for combined flexure, shear, and torsion per CSA 
A23.3-04 standard 

• Automatic or manual moment distribution factors and strip widths 

• Moment redistribution for beams/one-way slab systems 

• Calculation of instantaneous and long-term deflections 

• Mixed span types within one-way or two-way systems 

• Auto-input wizard with instantaneous data checking  

• Graphical display of geometry and loads as they are input 

• Print preview of graphical screen 

• User-controlled screen color settings 

• Customizable results report 

• Import input data from ADOSS v6.0x/7.0x and PCA-Beam v1.0x 

• Detailed manual and online help 

Program Capacity  
• 21 supports (22 spans including left and right cantilevers)  

• 6 load cases 

• 50 load combinations 

• 999 partial dead loads per case 

• 999 partial live loads per case 

• 2 top bar layers (Design mode) 

• 2 bottom bar layers (Design mode) 

• 15 bar sets per span 

System Requirements  
Any computer running Microsoft Windows XP, Windows Vista, or Windows 7 
operating system is sufficient to run the spSlab and spBeam programs. For 
instructions on how to troubleshoot system specific installation and licensing 
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issues, please refer to support pages on StructurePoint website at 
www.StructurePoint.org. 

Terms  
The following terms are used throughout this manual. A brief explanation is given 
to help familiarize you with them. 

Windows refers to the Microsoft Windows environment as listed in 
System Requirements. 
 

[ ] indicates equivalent value expressed in metric unit or CSA 
code requirement corresponding ACI code requirement 
 

Click on means to position the cursor on top of a designated item or 
location and press and release the left-mouse button (unless 
instructed to use the right-mouse button). 
 

Double-click on means to position the cursor on top of a designated item or 
location and press and release the left-mouse button twice in 
quick succession. 
 

Marquee select  means to depress the mouse button and continue to hold it 
down while moving the mouse. As you drag the mouse, a 
rectangle (known as a marquee) follows the cursor. Release 
the mouse button and the area inside the marquee is 
selected. 

http://www.structurepoint.org/�
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Conventions  
Various styles of text and layout have been used in this manual to help 
differentiate between different kinds of information. The styles and layout are 
explained below… 

 
placed in a topic header means that the topic applies to both 
spSlab and spBeam 
 

 
placed in a topic header means that the topic applies to 
spSlab only 
 

Italic indicates a glossary item, or emphasizes a given word or 
phrase. 

Bold All bold typeface makes reference to either a menu or 
a menu item command such as File or Save, or a tab such as 
General Information or Columns 

Mono-space indicates something you should enter with the keyboard. For 
example type “c:\*.txt”. 

KEY + KEY indicates a key combination. The plus sign indicates that you 
should press and hold the first key while pressing the second 
key, then release both keys. For example, “ALT + F” 
indicates that you should press the “ALT” key and hold it 
while you press the “F” key. Then release both keys. 

SMALL CAPS Indicates the name of an object such as a dialog box or 
a dialog box component. For example, the OPEN dialog box 
or the CANCEL or MODIFY buttons. 

Installing, Purchasing and Licensing spSlab/spBeam  
For instructions on how to install, purchase, and license StructurePoint software 
please refer to support pages on StructurePoint website at www.StructurePoint.org. 

 

http://www.structurepoint.org/�


 

Chapter 2 – Method of Solution 
Method of Solution 

The user should be aware of the assumptions made by the program during the 
design stage. These include details regarding loading, strip widths, reinforcement 
selection, deflection computations, material quantities, etc. 

Geometric Checks  
spSlab and spBeam provide various geometric checks to avoid an analysis with an 
inconsistent system. Dimensions of slabs, beams, drops, bands and column 
capitals are checked and modified to produce a code compliant system. 

If a slab cantilever length is less than one-half the column dimension in the 
direction of analysis, c1, or less than the lateral extension of the transverse beam 
into the cantilever, the cantilever length will be increased to the larger of these two 
lengths. If the slab width is less than one-half the column dimension transverse to 
the direction of analysis, c2, or less than one-half the longitudinal beam width, the 
slab width will be increased to the larger of these two widths. 

If a drop panel lengths extend beyond the end of the slab cantilevers, the drop 
panel lengths will be reduced so that they extend only to the cantilever tip. The 
drop panel edges will be shifted forward or backward in the transverse direction 
when the slab strip width on either side of the column is less than one-half the 
drop panel width. 

When a column capital is defined, the program checks if capital side slope  
(depth/extension ratio) is more than 1, i.e. the angle between capital side and 
column axis is no greater than 45 degrees1. The upper limit for the side slope is 50. 
If a column with capital frames into a drop panel (or a beam), extension of the 
capital will be automatically adjusted – if necessary – so that projected sides of the 
capital do not fall outside of the drop panel (or the beam) edges before reaching 
slab soffit (see Figure 2-1). The modified column capital extension will be used 
when computing column stiffness and in punching shear calculations. 

                                                           
1 ACI 318-08, 13.1.2; ACI 318-05, 13.1.2; ACI 318-02, 13.1.2; ACI 318-99, 13.1.2; CSA A23.3-04, 
2.2; CSA A23.3-94, 13.1 
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Figure 2-1 Maximum capital width 

Code Checks  

Minimum Thickness – One-Way Construction  
The program checks beam or one-way slab thickness based on minimum 
requirement for ACI-318 code2 as specified in Table 9.5(a) or for CSA code3 
according to Table 9.2. For lightweight concrete with density 
90 lb/ft3 ≤ wc ≤ 115 lb/ft3 [1440 kg/m3 ≤ wc ≤ 1840 kg/m3] for ACI 318-08  
90 lb/ft3 ≤ wc ≤ 120 lb/ft3 [1440 kg/m3 ≤ wc ≤ 1920 kg/m3] for ACI 318-05  
90 lb/ft3 ≤ wc ≤ 120 lb/ft3 [1500 kg/m3 ≤ wc ≤ 2000 kg/m3] for ACI 318-02, and 
ACI 318-99, the minimum slab thickness is additionally increased by adjustment 
factor (1.65 – 0.005wc), but not less than 1.09. For CSA standards, the adjustment 
is calculated as (1.65 – 0.0003wc), but not less than 1.0, for structural low density 
(wc ≤ 1850 kg/m3) and structural semi-low density (1850 kg/m3 ≤ wc ≤ 2150 
kg/m3) concrete4. 

Minimum Slab Thickness – Two-Way Construction  
The program checks slab thickness against minimum slab thickness defined by 
design standards for two-way systems with long to short span ratio not greater than 
2.05. Slabs with thickness below the minimum value will be flagged by the 

                                                           
2 ACI 318-08, 9.5.2.1; ACI 318-05, 9.5.2.1; ACI 318-02, 9.5.2.1; ACI 318-99, 9.5.2.1; 
3 CSA A23.3-04, 9.8.2.1; 
4 CSA A23.3-04, 2.2; CSA A23.3-94 2.1 
5 ACI 318-08, 9.5.3.1, 13.6.1.2; ACI 318-05, 9.5.3.1, 13.6.1.2; ACI 318-02, 9.5.3.1, 13.6.1.2; ACI 318-
99, 9.5.3.1, 13.6.1.2; CSA A23.3-04, 13.2.2, 2.2; CSA A23.3-94, 13.3.2, 13.1 
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program, however, they are allowed provided that calculated deflections do not 
exceed maximum permissible computed deflections6. 

Minimum thickness of slabs with beams spanning between supports on all sides is 
calculated for ACI 318 codes in US customary units from7:  
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in metric unit system for ACI 318-08 and ACI 318-05 from8 
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and in metric unit system for ACI 318-02 and ACI 318-99 from9 

 
( )

y
n

m
fm

y
n

m

f
0.8

1500
120mm, if 0.2 2.0

36 5 0.2
h

f
0.8

1500
90mm, if 2.0

36 9

⎧ ⎛ ⎞
+⎪ ⎜ ⎟

⎝ ⎠⎪ ≥ < α ≤⎪ + β α −⎪= ⎨
⎛ ⎞⎪ +⎜ ⎟⎪
⎝ ⎠⎪ ≥ α >

⎪ + β⎩

l

l

 Eq. 2-3 

                                                           
6 ACI 318-08, 9.5.3.4; ACI 318-05, 9.5.3.4; ACI 318-02, 9.5.3.4; ACI 318-99, 9.5.3.4; CSA A23.3-04, 
13.2.7; CSA A23.3-94, 13.3.6 
7 ACI 318-08, 9.5.3.3; ACI 318-05, 9.5.3.3; ACI 318-02, 9.5.3.3; ACI 318-99, 9.5.3.3 
8 ACI 318M-08, 9.5.3.3; ACI 318M-05, 9.5.3.3 
9 ACI 318M-02, 9.5.3.3; ACI 318M-99, 9.5.3.3 
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where: 

ln = clear span in the direction of analysis, 
β = ratio of the clear spans in long to short direction, 
fy   = yield stress of reinforcing steel, 
αm = average value of α, the ratio of flexural stiffness of a beam 

section to the flexural stiffness of a width of slab bounded 
laterally by centerlines of adjacent panels on either side of the 
beam, for all beams supporting the edges of a slab panel. 

The program assumes that beams are present on all sides of a panel if the span 
under consideration includes a longitudinal beam and there are transverse beams 
defined at both ends of the span. If this assumption is satisfied but in reality beams 
are not present on all sides (e.g. design strip next to the one under consideration 
has no longitudinal beam) then the user is advised to check displacements even if 
slab thickness is larger than the minimum slab thickness reported by the program. 

For the design of ACI slabs without beams (αm ≤ 0.2) spanning between interior 
supports the minimum thickness shall conform to ACI 318 Table 9.5(c) and will 
not be less than 5.0 in. [125 mm for ACI 318M-08/05 or 120 mm for ACI 318M-
02/99] for flat plates (slabs without drop panel) and not less than 4.0 in. [100 mm] 
for two-way flat slab systems (slab with drop panels)10. For flat slabs that contain 
valid drop panels (see Figure 2-2), Table 9.5(c) reduces the minimum thickness by 
approximately 10%. For values of fy between the ones given in the table, minimum 
thickness is determined by linear interpolation. 

For design strips that have neither beams between all supports nor beams between 
interior supports (e.g. exterior strips with beams on the outside edges only), the 
program reports maximum value of minimum slab thickness resulting from both 
Table 9-5(c) and Equations . However, since this case is not explicitly covered by 
the ACI code, the user is advised to check displacements even if slab thickness is 
larger than the minimum slab thickness reported by the program. 

For CSA A23.3 standard11, the minimum thickness of slab with beams spanning 
between all supports is: 

                                                           
10 ACI 318-08, 9.5.3.2; ACI 318-05, 9.5.3.2; ACI 318-02, 9.5.3.2; ACI 318-99, 9.5.3.2; ACI 318M-08, 
9.5.3.2; ACI 318M-05, 9.5.3.2; ACI 318M-02, 9.5.3.2; ACI 318M-99, 9.5.3.2 
11 CSA A23.3-04, 13.2.5; CSA A23.3-94, 13.3.5 
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with the value of αm evaluated for CSA A23.3-04 using the following beam 
moment of inertia: 

 ⎟
⎠

⎞
⎜
⎝

⎛ −=
h
h

15.2
12

hb
I s

3
w

b   Eq. 2-5 

For flat plates and slabs with column capitals12, the minimum slab thickness is: 
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For slabs with drop panels13, the minimum slab thickness satisfies the conditions: 
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where ( )sd hh −  shall not be greater than sh  and 

dx  = dimension from face of column to edge of drop panel, but not 
more than n / 4l  

d n2x / l  = the smaller of the values determined in the two directions 
Δh  = additional thickness of the drop panel below the soffit of the slab 

and shall not be taken more than hs. 

                                                           
12 CSA A23.3-04, 13.2.3; CSA A23.3-94, 13.3.3 
13 CSA A23.3-04, 13.2.4; CSA A23.3-94, 13.3.4 



 

2-6  Method of Solution 

The minimum thickness in a span that contains a discontinuous edge will be 
increased by 10%, if the edge beam provided has a stiffness ratio, α, of less than 
0.80.14 The first and last spans are considered to contain a discontinuous edge as 
well as a span that contains an exterior edge. 

The minimum thickness of slab bands follows the requirements for the beams.15 

Drop Panel Dimensions  
Per ACI16, a valid drop must extend in each direction at least one-sixth the center-
to-center span length in that direction (Figure 2-2). The depth of an invalid drop 
will not be used in the calculation of the depth used to reduce the amount of 
negative reinforcement required over a column17. If the valid drop depth is greater 
than one-quarter the distance from the edge of the drop panel to the face of the 
column (x) the excess depth exceeding ¼x will not be considered in the 
calculation of the effective depth used to reduce the amount of negative 
reinforcement required at a column (Figure 2-3)18. Slabs that contain valid drops 
are allowed a 10% decrease in minimum slab depth19. 

                                                           
14 ACI 318-08, 9.5.3.3 (d); ACI 318-05, 9.5.3.3 (d); ACI 318-02, 9.5.3.3 (d); ACI 318-99, 9.5.3.3 (d), 
CSA A23.3-04, 13.2.3, 13.2.4; CSA A23.3-94, 13.3.3 
15 CSA A23.3-04, 13.2.6 
16 ACI 318-08, 13.2.5; ACI 318-05 (Ref. [1]), 13.2.5; ACI 318-02 (Ref. [3]), 13.3.7.1, 13.3.7.2; ACI 
318-99 (Ref. [4]), 13.3.7.1, 13.3.7.2 
17 ACI 318-08, 13.2.5; ACI 318-05, 13.2.5, 13.3.7; ACI 318-02, 13.3.7; ACI 318-99, 13.3.7 
18 ACI 318-08, 13.3.7; ACI 318-05, 13.3.7; ACI 318-02, 13.3.7.3; ACI 318-99, 13.3.7.3; CSA A23.3-
04 (Ref. [7]), 13.10.7; CSA A23.3-94 (Ref. [9]), 13.11.6 
19 ACI 318-08, 9.5.3.2; ACI 318-05, 9.5.3.2; ACI 318-02, 9.5.3.2, ACI 318-99, 9.5.3.2 
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>h/4 
h 

 
Figure 2-2 Valid drop dimensions 

The input drop dimensions will be used for self-weight computations, when 
computing slab stiffness to determine deflections, moments, shears, and when 
computing punching shear around a column20. 

 
Figure 2-3 Excess drop depth 

                                                           
20 ACI 318-08, R13.2.5; ACI 318-05, R13.2.5 



 

2-8  Method of Solution 

Beam Dimensions  
The program follows linear distribution of strain (plain section) assumption21 for 
flexure design which is applicable to shallow flexural members. In case of deep 
beams22, design standards recommend using non-linear distribution of strain or 
strut-and-tie method. The program checks beam dimensions and if a beam with the 
following clear span, ln, to overall depth, h, ratio is found: 

 

n

n

n

n

4h, ACI 318-05 and ACI 318-02
2.5h, ACI 318-99, continuous spans
1.25h, ACI 318-99, simple spans
2h, CSA A23.3-04 and CSA A23.3-94

≤
≤
≤
≤

l
l
l
l

 Eq. 2-9 

a warning is issued alerting the user that additional deep beam design and detailing 
is required. For cantilevers, the warning is issued only if their clear span is larger 
than overall depth. 

Special Considerations for One and Two-Way Joist Systems  

Rib Dimensions  
Rib dimensions will be considered valid if the rib width is at least 4 in. [100 mm], 
the depth is no more than 3-1/2 times the rib width, and the clear spacing between 
ribs does not exceed 30 in. [800 mm]23. If rib dimensions do not meet these 
requirements (e.g. wide module joist systems) the code requires such ribs to be 
designed as beams24. The program treats the design of wide-spaced joists the same 
way as for valid slabs, regardless of code limitation. If the code limits are 
exceeded, the condition is flagged and the 10% increase of rib shear capacity is not 
used. The user is then responsible to validate the resulting design and reconcile the 
code requirements.  

                                                           
21 ACI 318-08, 10.2.2; ACI 318-05, 10.2.2; ACI 318-02, 10.2.2; ACI 318-99, 10.2.2; CSA A23.3-04, 
10.1.2; CSA A23.3-94, 10.1.2 
22 ACI 318-08, 10.7.1; ACI 318-05, 10.7.1; ACI 318-02, 10.7.1; ACI 318-99, 10.7.1; CSA A23.3-04; 
10.7.1; CSA A23.3-94, 10.7.1 
23 ACI 318-08, 8.13.2, 8.13.3; ACI 318-05, 8.11.2, 8.11.3; ACI 318-02, 8.11.2, 8.11.3; ACI 318-99, 
8.11.2, 8.11.3; CSA A23.3-04, 10.4.1; CSA A23.3-94, 10.4.1 
24 ACI 318-08, 8.13.4; ACI 318-05, 8.11.4; ACI 318-02, 8.11.4; ACI 318-99, 8.11.4; CSA A23.3-04, 
10.4.2; CSA A23.3-94, 10.4.2 
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h

30 in.
b  4 in.

3.5b

 
Figure 2-4 Valid rib dimensions 

Minimum Thickness for Joist Systems  
The minimum slab thickness allowed for joist slabs is one-twelfth the clear rib 
spacing, or 1.5 in [40 mm]for ACI code25 and 50mm for CSA code26. 

Joist System Analysis and Design  
For the purposes of analysis and design, the program replaces the ribbed slab with 
solid slabs of equivalent moment of inertia, weight, punching shear capacity, and 
one-way shear capacity. 

The equivalent thickness based on system weight is used to compute the system 
self-weight. This thickness, hw, is given by: 

 
mod

mod
w A

Vh = , Eq. 2-10 

where: 

Vmod= the volume of one joist module, 
Amod= the plan area of one joist module. 

The equivalent thickness based on moment of inertia is used to compute slab 
stiffness. The ribs spanning in the transverse direction are not considered in the 
stiffness computations. This thickness, hMI, is given by: 

                                                           
25 ACI 318-08, 8.13.5.2; ACI 318-05, 8.11.5.2; ACI 318-02, 8.11.5.2; ACI 318-99, 8.11.5.2;  
26 CSA A23.3-04, 10.4.1; CSA A23.3-94, 10.4.1 
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3
1

rib

rib
MI b

I12h ⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
= , Eq. 2-11 

where: 

Irib = moment of inertia of one joist section between centerlines of 
ribs. 

brib = the center-to-center distance of two ribs (clear rib spacing plus 
rib width). 

The drop panel depth for two-way joist (waffle) slab systems is set equal to the rib 
depth. The equivalent drop depth based on moment of inertia, dMI, is given by: 

 ribMIMI hhd +=  Eq. 2-12 

where: 

hrib = rib depth below slab, 
hMI = equivalent slab thickness based on moment of inertia. 

A drop depth entered for a waffle slab system other than 0 will be added to dMI, 
thus extending below the ribs. 

One–way shear capacity, Vc (increased by 10% for ACI code27), is calculated 
assuming the shear cross-section area consisting of ribs and the portion of slab 
above, decreased by concrete cover. For such section the equivalent shear width of 
single rib is calculated from the formula: 

 vb b d 12= +  Eq. 2-13 

where: 

b = rib width, 
d = distance from extreme compression fiber to tension 

reinforcement centroid. 

The equivalent thickness based on shear area is used to compute the area of 
concrete section resisting punching shear transfer, Ac around drop panels in two-
way joist (waffle) systems. The equivalent slab thickness, hV, used to compute Ac, 
is given by: 

                                                           
27 ACI 318-08, 8.13.8; ACI 318-05, 8.11.8; ACI 318-02, 8.11.8; ACI 318-99, 8.11.8 
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 infre
rib

rib
v d

b
Ah +=  Eq. 2-14 

where: 

Arib = the entire rib area below the slab plus the slab thickness minus 
the distance to the reinforcement centroid, dreinf, within the rib 
width, i.e., the slab depth between the ribs is not considered as 
contributing to shear capacity, 

brib = the center-to-center distance of two ribs (clear rib spacing plus 
rib width), 

dreinf = the distance to reinforcement centroid from the slab top at the 
support. 

Material Properties  
By entering the concrete density and compressive strength of the members, default 
values for the other concrete properties are determined. The slab, column, and 
beam members may have different concrete properties. 

The density of concrete is used to determine the type of concrete, modulus of 
elasticity, and self-weight. 

The concrete type is determined in accordance with Table 2-1. 

ACI 318-08 
ACI 318-05 
ACI 318-02 
ACI 318-99 

wc wc 
Type 

pcf kg/m3 pcf kg/m3 

Normal 

 
135 ≤ wc 2155 ≤ wc 130 ≤ wc 2000 ≤ wc 

Sand-
Lightweight 115<wc<135 1840<wc<2155 105<wc<130 1700<wc<2000 

All-
Lightweight wc ≤ 115 wc ≤ 1840 wc ≤ 105 wc ≤ 1700 
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CSA A23.3-04 CSA A23.3-94 

γc γc Type 

kg/m3 pcf kg/m3 pcf 

Normal 

 
2150 ≤ γc 134.2 ≤ γc 2000 ≤ γc 124.8 ≤ γc 

Low 
Density 

1850< γc<2150 115.5< γc<134.2 1700< γc<2000 106.1< γc<124.8 

Semi-
low 
Density 

γc ≤ 1850 γc ≤ 115.5 γc ≤ 1700 γc ≤ 106.1 

Table 2-1 Concrete Weight Classification 

Once the compressive strength of concrete '
cf  is input, various parameters are set 

to their default values. 

The modulus of elasticity is computed as:28 

 1.5 '
c c cE 33w f= , Eq. 2-15 

where: 

wc = the unit weight of concrete. 

For CSA A23.3 standard29 

 ( )
1.5

' c
c cE 3300 f 6900   

2300
γ⎛ ⎞= + ⎜ ⎟

⎝ ⎠
  Eq. 2-16 

where: 

γc = the density of concrete. 

The square root of '
cf  is limited to 100 psi for the computation of shear strength 

provided by concrete, Vc, and development lengths.30 

                                                           
28 ACI 318-08, 8.5.1; ACI 318-05, 8.5.1; ACI 318-02, 8.5.1; ACI 318-99, 8.5.1; CSA A23.3-04, 
8.6.2.2; CSA A23.3-94, 8.6.2.2 
29 CSA A23.3-04, 8.6.2.2; CSA A23.3-94, 8.6.2.2 
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For CSA A23.3-04 standard the value of square root of '
cf  used to calculate 

factored shear resistance vr shall not exceed 8MPa.31 

The modulus of rupture is used to determine the cracking moment when 
computing the effective moment of inertia for deflection computations. The default 
value of modulus of rupture, fr, is for ACI 318 code set equal to:32 

 '
r cf 7.5 f= λ . Eq. 2-17 

For CSA A23.3 standard, the default value of modulus of rupture fr is:33 

 '
cr f6.0f λ= , Eq. 2-18 

for beams and columns, and 

 
2

f6.0
f

'
c

r
λ

= , Eq. 2-19 

for two-way slabs34. Factor λ  reflecting the reduced mechanical properties of 
lightweight concrete is equal to35: 1.00 for normal density concrete, 0.85 for sand-
lightweight (structural semi-low-density) concrete, and 0.75 for all-lightweight 
(structural low-density) concrete. Refer to Table 2-1 for determination of concrete 
type. 

There is no limit imposed on fr. Entering a large value of fr will produce 
deflections based on gross properties (i.e. uncracked sections). 

The default values for the longitudinal reinforcement yield strength, fy, and shear 
reinforcement yield strength, fyv, if applicable, are set equal to 60 ksi [413 MPa] 
for ACI and 400 MPa for CSA. 

                                                                                                                                      
30 ACI 318-08, 11.1.2; ACI 318-05, 11.1.2; ACI 318-05, 11.1.2; ACI 318-99, 11.1.2 
31 CSA A23.3-04, 13.3.4.2 
32 ACI 318-08, 9.5.2.3; ACI 318-05, 9.5.2.3; ACI 318-02, 9.5.2.3; ACI 318-99, 9.5.2.3; 
33 CSA A23.3-04, 8.6.4; CSA A23.3-94, 8.6.4 
34 CSA A23.3-04, 13.2.7; CSA A23.3-94, 13.3.6;  
35 ACI 318-08, 11.11.2.1; ACI 318-05, 11.2.1.2; ACI 318-02, 11.2.1.2; ACI 318-99, 11.2.1.2; CSA 
A23.3-04, 8.6.5; CSA A23.3-94, 8.6.5;  
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Equivalent Frame Method  
The equivalent frame method, as described in the code36, is used by spSlab for 
both analysis and design. The code specifies procedures for the analysis and design 
of slab systems reinforced for flexure in more than one direction, with or without 
beams between the supports. A two-way slab37 system, including the slab and its 
supporting beams, columns, and walls may be designed by either of the following 
procedures: 

• The Direct Design Method 

• The Equivalent Frame Method 
spSlab uses the Equivalent Frame Method of analysis which is based on extensive 
analytical and experimental studies conducted at the University of Illinois. Note 
also that there are no restrictions on the number of slab spans or on dead-to-live 
load ratios in this method of analysis. 

The first step in the frame analysis is to divide the three-dimensional building into 
a series of two-dimensional frames extending to the full height of the building. 
Horizontal members for each frame are formed by slab strips as shown in Fig. 2-5. 
For vertical loads, each story (floor and/or roof) may be analyzed separately with 
the supporting columns being considered fixed at their remote ends (Figure 2-6). 

Stiffness Characteristics  
The stiffness factors for the horizontal members (the slab beams) and the vertical 
members (the equivalent columns) are determined using segmental approach. 

                                                           
36 ACI 318-08, 13.7; ACI 318-05, 13.7; ACI 318-02, 13.7; ACI 318-99, 13.7; CSA A23.3-04, 13.8; 
CSA A23.3-94, 13.9 
37 Implies a slab supported by isolated supports which permits the slab to bend in two orthogonal 
directions. 
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Figure 2-5 Design strips 

Slab Beams  
The moment of inertia of the slab beam elements between the faces of the columns 
(or column capitals) is based on the uncracked section of the concrete including 
beams or drop panels. The moment of inertia from the face of the column (or 
capital) to the centerline of the column (or capital) is considered finite and is 
dependent on the transverse dimensions of the panel and support. This reduced 
stiffness (as compared to the infinite stiffness assumed in previous codes) is 
intended to soften the slab at the joint to account for the flexibility of the slab away 
from the support. This is consistent with provisions of the code.38 Figure 2-7 
shows the changes in stiffness between a slab, and a drop panel, and a column (or 
capital). 

                                                           
38 ACI 318-08, 13.7.3; ACI 318-05, 13.7.3; ACI 318-02, 13.7.3; ACI 318-99, 13.7.3; CSA A23.3-04, 
13.8.2.3; CSA A23.3-94, 13.9.2.3 



 

2-16  Method of Solution 

 
Figure 2-6 Analytical model for vertical loads for a typical story 

Columns  
The computation of the column stiffness is more complicated as it utilizes the 
concept of an equivalent column. Theoretical slab studies have shown that the 
positive moment in a slab may increase under pattern loads, even if rigid columns 
are used, because of the flexibility of the slab away from the column. However, if 
a two-dimensional frame analysis is applied to a structure with rigid columns, 
pattern loads will have little effect.  

To account for this difference in behavior between slab structures and frames, the 
equivalent column torsional member, as shown in Figure 2-8, runs transverse to 
the direction in which the moments are being determined. The transverse slab 
beam can rotate even though the column may be infinitely stiff, thus permitting 
moment distribution between adjacent panels. It is seen that the stiffness of the 
equivalent column is affected by both the flexural stiffness of the columns and the 
torsional stiffness of the slabs or beams framing into the columns. Note that the 
method of computation of column stiffness is in accordance with the requirements 
of the code39. Figure 2-9 shows a schematic representation of the stiffness of 
typical columns. 

                                                           
39 ACI 318-08, 13.7.4; ACI 318-05, 13.7.4; ACI 318-02, 13.7.4; ACI 318-99, 13.7.4; CSA A23.3-04, 
13.8; CSA A23.3-94, 13.9 
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Figure 2-7 Sections for calculating slab-beam stiffness, Ksb 
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Figure 2-7 continued 

The column stiffness is based on the column height, lc, measured from mid-depth 
of the slab above, to the mid-depth of the slab below. spSlab calculates the 
stiffness of the column below the design slab, taking into account the design slab 
system at its top end. spSlab calculates the stiffness of the column above the 
design slab taking only the slab depth into account at its bottom end; column 
capitals, beams, or drops are ignored. 

The computation of the torsional stiffness of the member requires several 
simplifying assumptions. The first step is to assume dimensions of the transverse 
torsional slab-beam members. Assumptions for dimensions of typical torsional 
members are shown in Figure 2-10. 
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Figure 2-8 Equivalent column 

The stiffness, Kt, of the torsional member is given by the following expression40:  

 CS
t 3

2
2

2

9 E C
K

c1

=
⎛ ⎞

−⎜ ⎟
⎝ ⎠

∑
l

l

, Eq. 2-20 

where: 
Ecs = modulus of elasticity for slab concrete, 
C = cross-sectional constant defined in Eq. 2-21  
c2 = size of rectangular column or capital measured transverse to the 

direction in which moments are being determined, 
l2 = for ACI 318, length of span transverse to l1, measured on each 

side of the column, for CSA A23.3 value of l2 is taken as the 
smaller of average l2 and average l1 on each side of the column. 

                                                           
40 ACI 318-08, 13.7.5; ACI 318-05, 13.7.5; ACI 318-02, 13.7.5; ACI 318-99, 13.7.5; CSA A23.3-04, 
13.8.2.8; CSA A23.3-94, 13.9.2.8 
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The constant C is evaluated for the cross section by dividing it into separate 
rectangular parts and by carrying out the following summation41:  

 ∑ ⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
−=

3
yx

y
x63.01C

3
 Eq. 2-21 

where: 
x = short overall dimension of the rectangular part of a cross section, 
y = long overall dimension of the rectangular part of a cross section. 

The program divides the section into rectangles in such a way that the value of 
constant C is maximum (see Figure 2-10). 

 
Figure 2-9 Sections for calculating the stiffness (Kc) of the column below 

the design floor ( lc-input, lc*-computed) 

Walls perpendicular to the direction analysis can be modeled as wide columns. If 
a column/wall runs full length of the total design strip42, the program modifies 
moment distribution factors to achieve uniform distribution of moments along the 

                                                           
41 ACI 318-08, 13.6.4.2; ACI 318-05, 13.6.4.2; ACI 318-02, 13.0; ACI 318-99, 13.0; CSA A23.3-04, 
13.8.2.9; CSA A23.3-94, 13.9.2.9 
42 For walls running full width of the slab (c2 = l2), the program slightly adjusts the width of the wall to 
avoid singularity in the denominator of Eq. 2-20. 
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column and middle strips. If the width of the wall is less than 75% of the total 
design strip then no modification of distribution factors is applied. For 
column/wall widths between 75% and 100% of total strip widths, moment 
distribution factors are linearly interpolated between regular values and uniformly 
distributed values.  

When beams frame into the column in the direction of analysis, the value of Kt as 
computed in Eq. 2-20 is multiplied by the ratio of the moment of inertia of the slab 
with the beam (Isb) to the moment of inertia of the slab without the beam (Is), as 
shown: 

 
s

sb
tta I

IKK =  Eq. 2-22 

With reference to Figure 2-8, Is is computed from part A (slab without beam), 
whereas Isb is computed from both parts A and B (slab with beam). 

Having the column stiffness, Kc, and the stiffness of the attached torsional 
member, Kt, the stiffness of the equivalent column, Kec, is computed from the 
equation: 

 

r
ta

l
ta

cbct

cbct
ec

KK
KK1

KK
K

+
+

+

+
= , Eq. 2-23 

where: 

Kct = top column stiffness, 
Kcb = bottom column stiffness, 
Kta = torsional stiffness of the left ( l

taK ) and the right ( r
taK ) member. 
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Figure 2-10 Section of the attached torsional members 

Loading  
All applied loads are input as unfactored loads. There are no limitations imposed 
on the ratio of dead to live loads in the Equivalent Frame Method. Results of 
gravity load and lateral load analyses may be combined, however, the effects of 
cracking and reinforcement on stiffness must be accounted for in the lateral load 
analysis. 
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Self-Weight  
The self weight of the system is automatically calculated and assigned to the 
reserved load selfweight load case, SELF, which is by default defined in all new 
data files. The weights of the slabs, drops, and longitudinal and transverse beams 
are considered in the selfweight computations. Only the concrete weight is 
considered, the reinforcement weight is ignored. The weight of longitudinal beams 
is ignored starting at the column centerline, for a length equal to one-half c1, the 
column dimension in the direction of analysis. This will produce slightly less self-
weight than actually present for beams wider than c2, the column’s transverse 
dimension. 

If load case SELF is removed then the program will ignore self weight in all 
ultimate load combinations as well as in internally defined service load 
combination used to calculate displacements. 

Superimposed Loading  
All superimposed vertical loading is considered to act over the entire transverse 
width of the slab. For slab systems with beams, loads supported directly by the 
beam (such as the weight of the beam stem or a wall supported directly by the 
beams) are also assumed to be distributed over the entire transverse width of the 
strip. An additional analysis may be required, with the beam section designed to 
carry these loads in addition to the portion of the slab moments assigned to the 
beam. 

Lateral Loading  
For lateral loads, each frame should be analyzed as a unit for the entire height of 
the building (Figure 2-11). Computer programs, such as spFrame, are available for 
performing such analyses. It should be realized that, for lateral load analysis, slab-
beam elements may have a reduced stiffness due to cracking as well as other 
assumptions made for the effective slab width used for the lateral analysis. The 
moments obtained from such an analysis may then be input into the equivalent 
frame model using the program to determine the appropriate design moments 
under combined vertical and lateral loads. 
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Figure 2-11 Analytical model for lateral loads 

The program distributes the effect of the superimposed lateral load moments to the 
column strip and middle strip according to the moment distribution factors 
computed for gravity loads (see Table 2-2 through Table 2-4 later in this chapter). 

Loading Patterns  
The analysis of floor systems requires the consideration of several loading 
configurations. For example, the two adjacent spans loaded may produce the 
maximum shear stress around a column, while the alternate spans loaded may 
produce the maximum flexural moments. To cover different loading scenarios the 
program generates live load case based on the following load patterns (Figure 
2-12): 

• Pattern No. l (All): All spans loaded with live load, 

• Pattern No. 2 (Odd): Starting at span 1, alternate spans loaded with live load, 

• Pattern No. 3 (Even): Starting at span 2, alternate spans loaded with live load, 

• Pattern No. 3+N (SN): Two spans adjacent to support No. N loaded with live 
load. 

The program reduces the magnitude of live load patterns No. 2 through No. (3+n) 
by a predefined ratio. For two-way systems, the default live load pattern ratio 
selected by the program equals 75% as permitted by the code43. The user has the 
ability to select different value for the pattern ratio within the range 0-100%. If 0% 
is selected then load patterning effects will be neglected. However, the pattern 

                                                           
43 ACI 318-08, 13.7.6.3; ACI 318-05, 13.7.6.3; ACI 318-02, 13.7.6.3; ACI 318-99, 13.7.6.3; CSA 
A23.3-04, 13.8.4; CSA A23.3-94, 13.9.4 
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No. 1 with all spans loaded (as specified by the user) is always considered with 
full unreduced magnitude.  

Live Load

Dead Load

Dead Load

Dead Load

Dead Load

Live Load

Live Load

Live Load
Support No. 3 Under
Consideration

LOADING PATTERN NO. 1 (All)

LOADING PATTERN NO. 2 (Odd)

LOADING PATTERN NO. 3 (Even)

LOADING PATTERN NO. 6 (S3)  
Figure 2-12 Live load patterns 

Load Combinations  
The program allows defining up to 20 load combinations. The user has full control 
over the combinations. The program contains predefined (build into the program) 
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default primary load combinations for the supported codes. These default 
combinations are created when starting a new project. 

For the ACI 318-08, ACI 318-05 and ACI 318-02 codes, the default combinations 
of the Dead (D), Live (L), Snow(S), Wind (W) and Earthquake (E) loads 
considered by the program are44:  

U1 = 1.4D 
U2 = 1.2D + 1.6L + 0.5S 
U3 = 1.2D + 1.0L + 1.6S 
U4 = 1.2D + 1.6S + 0.8W 
U5 = 1.2D + 1.6S – 0.8W 
U6 = 1.2D + 1.0L + 0.5S + 1.6W 
U7 = 1.2D + 1.0L + 0.5S – 1.6W 
U8 = 0.9D + 1.6W 
U9 = 0.9D – 1.6W 
U10 = 1.2D + 1.0L + 0.2S + 1E 
U11 = 1.2D + 1.0L + 0.2S – 1E 
U12 = 0.9D + 1.0E 
U13 = 0.9D – 1.0E 

For the ACI 318-99 code, the default combinations of the Dead (D), Live (L), 
Wind (W) and Earthquake (E) loads considered by the program are45:  

U1 = 1.4D + 1.7L 
U2 = 0.75(1.4D + 1.7L + 1.7W) 
U3 = 0.75(1.4D + 1.7L – 1.7W) 
U4 = 0.75(1.4D + 1.7W) 
U5 = 0.75(1.4D – 1.7W) 
U6 = 0.9D + 1.3W 
U7 = 0.9D – 1.3W 
U8 = 0.75(1.4D + 1.7L + 1.7*1.1E) 
U9 = 0.75(1.4D + 1.7L – 1.7*1.1E) 
U10 = 0.75(1.4D + 1.7*1.1E) 
U11 = 0.75(1.4D – 1.7*1.1E) 
U12 = 0.9D + 1.43E 
U13 = 0.9D – 1.43E 

                                                           
44 ACI 318-08, 9.2; ACI 318-05, 9.2; ACI 318-02, 9.2 
45 ACI 318-99, 9.2 
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For the CSA A23.3-04 code load combinations are compliant with 2005 NBCC. 
The default combinations of the Dead (D), Live (L), Snow (S), Wind (W) and 
Earthquake (E) loads considered by the program are46: 

U1 = 1.4D 
U2 = 1.25D + 1.5L 
U3 = 1.25D + 1.5L + 0.5S 
U4 = 1.25D + 1.5L + 0.4W 
U5 = 1.25D + 1.5L – 0.4W 
U6 = 0.9D + 1.5L 
U7 = 0.9D + 1.5L + 0.5S 
U8 = 0.9D + 1.5L + 0.4W 
U9 = 0.9D + 1.5L – 0.4W 
U10 = 1.25D + 1.5S 
U11 = 1.25D + 0.5L + 1.5S 
U12 = 1.25D + 0.4W + 1.5S 
U13 = 1.25D – 0.4W + 1.5S 
U14 = 0.9D + 1.5S 
U15 = 0.9D + 0.5L + 1.5S 
U16 = 0.9D + 0.4W + 1.5S 
U17 = 0.9D – 0.4W + 1.5S 
U18 = 1.25D + 1.4W 
U19 = 1.25D + 0.5L + 1.4W 
U20 = 1.25D + 1.4W + 0.5S 
U21 = 1.25D – 1.4W 
U22 = 1.25D + 0.5L – 1.4W + 0.5S 
U23 = 1.25D – 1.4W + 0.5S 
U24 = 0.9D + 0.5L + 1.4W 
U25 = 0.9D + 0.5L + 1.4W 
U26 = 0.9D + 1.4W + 0.5S 
U27 = 0.9D – 1.4W 
U28 = 0.9D + 0.5L – 1.4W 
U29 = 0.9D – 1.4W + 0.5S 
U30 = 1.0D + 1.0E 
U31 = 1.0D + 0.5L + 1.0E + 0.25S 
U32 = 1.0D – 1.0E 
U33 = 1.0D + 0.5L – 1.0E + 0.25S 
For the CSA A23.3-94 code, the default combinations of the Dead (D), Live (L), 
Wind (W), Earthquake (E), and Snow (S) loads considered by the program are47:  
                                                           
46 CSA A23.3-04, 8.3.2; CSA A23.3-04, Annex C, Table C1; NBCC 2005 (Ref. [6]), Table 4.1.3.2 
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U1 = 1.25D + 1.5L 
U2 = 1.25D + 1.5L + 1.5S 
U3 = 1.25D + 0.7(1.5L + 1.5W) 
U4 = 1.25D + 0.7(1.5L – 1.5W) 
U5 = 1.25D + 0.7(1.5L + 1.5W+ 1.5S) 
U6 = 1.25D + 0.7(1.5L – 1.5W+ 1.5S) 
U7 = 1.25D + 1.5W 
U8 = 1.25D – 1.5W 
U9 = 0.85D + 1.5W 
U10 = 0.85D – 1.5W 
U11 = 1.0D + 0.5L + 1.0E 
U12 = 1.0D + 0.5L – 1.0E 
U13 = 1.0D + 0.5L + 1.0E + 0.5S 
U14 = 1.0D + 0.5L – 1.0E + 0.5S 
U15 = 1.0D + 1.0E 
U16 = 1.0D – 1.0E 

Column and Middle Strip Widths  
The code48 defines the width of the column strip on each side of the column 
centerline as being one-fourth of the smaller of either the transverse or the 
longitudinal span. These widths are printed as part of the echo of input data. 

The strip widths at a support are computed by (see Figure 2-13) 

• column strip 
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, Eq. 2-24 

• middle strip 

 { }ms 2,i 2,i 1 csw min , w+= −l l . Eq. 2-25 

                                                                                                                                      
47 CSA A23.3-94, 8.3.2 (assuming occupancies other than storage and assembly) 
48 ACI 318-08, 13.2.1; ACI 318-05, 13.2.1; ACI 318-02, 13.2.1; ACI 318-99, 13.2.1; CSA A23.3-04, 
2.2; CSA A23.3-94, 13.1 
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 Figure 2-13 Strips widths at support 

The strip widths in the span are defined as (see Figure 2-14): 

• column strip 

 2,l 2,r1 1
csw min , min ,

2 4 2 4
⎧ ⎫ ⎧ ⎫

= +⎨ ⎬ ⎨ ⎬
⎩ ⎭ ⎩ ⎭

l ll l , Eq. 2-26 

• middle strip 

 ms 2 csw w= −l , Eq. 2-27 
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where: 

l1 = span length in the direction of analysis, 
l2 = the total input transverse strip width, 
l2,l = the input transverse strip widths on the left of column centerline, 
l2,r = the input transverse strip widths on the right of column 

centerline. 

 
Figure 2-14 Strip widths in span 

If a longitudinal slab band is defined (CSA A23.3-04 standard only) then the 
column strip width is automatically adjusted to be equal to the band width: 

 cs bandw w= . Eq. 2-28 

If a longitudinal beam exists then the adjusted column strip width, csw , is 
calculated by subtracting the beam width, beamw , from the width of the column 
strip: 



 

Method of Solution  2-31 

 cs cs beamw w w= − . Eq. 2-29 

If the user selects the BEAM T-SECTION DESIGN option in Solve Options, the beam 
width, wbeam, used by the program will include portion of the slab on each side of 
the beam equal to projection of the beam below the slab, but not greater than slab 
thickness49. Otherwise, only web width is used. If the beam width, wbeam, is greater 
than the column strip width, wcs, then the adjusted column strip width is set to zero 
and moment distribution factors are adjusted to apply all column strip moment to 
the beam. This may occur when modeling a slab band with a wide longitudinal 
beam for codes other than CSA A23.3-04. In case of CSA A23.3-04 standard, the 
dedicated LONGITUDINAL SLAB BAND option in General Information dialog 
window is available to model slab band systems explicitly. 

By selecting USER SLAB STRIP WIDTH and USER DISTRIBUTION FACTORS options in 
Solve Options dialog window, the user has the ability to manually override strip 
widths and moment distribution factors calculated automatically by the program. 

Note: For exterior frames, the edge width should be specified to the edge of the 
slab from the column centerline. 

Strip Design Moments  
For design purposes, spSlab considers negative moments as those producing 
tension at the top of the slab and positive moments as those producing tension at 
the bottom of the slab. The negative design moment is taken at a section located at 
the face of the column, or column capital, but in no case is it considered at a 
location greater than 0.175 of the longitudinal span length, l1, away from the 
center of the column.50 This imposes a limit on long narrow supports, in order to 
prevent undue reduction in the design moment. For slab systems with transverse 
beams, the face of a beam is not considered as the face of support. For end 
columns with capitals, the moments are taken at the midpoint of the capital 
extension.51 The column and middle strip moments correspond to the moments 
assigned to the slab element only. spSlab computes the amount of reinforcement 
for the moments on the left and the right side of the support. The negative design 
moment is the moment which requires the most area of reinforcement to be 
resisted. The location, left or right of the support, of the maximum moment may 
                                                           
49 ACI 318-08, 13.2.4; ACI 318-05, 13.2.4; ACI 318-02, 13.2.4; ACI 318-99, 13.2.4; CSA A23.3-04 
Figure N13.1.2.(a) in Ref. [8], CSA A23.3-94, 13.1 
50 ACI 318-08, 13.7.7.1; ACI 318-05, 13.7.7.1; ACI 318-02, 13.7.7.1; ACI 318-99, 13.7.7.1; CSA 
A23.3-04, 13.8.5.1; CSA A23.3-94, 13.9.5.1 
51 ACI 318-08, 13.7.7.2; ACI 318-05, 13.7.7.2; ACI 318-02, 13.7.7.2; ACI 318-99, 13.7.7.2; CSA 
A23.3-04, 13.8.5.2; CSA A23.3-94, 13.9.5.2 
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vary when systems differ on each side of the support (for example, a system with 
beams on one side only). 

spSlab automatically calculates the values of strip moment distribution factors for 
column strips and longitudinal beams (if present). Portion of the total factor 
moment not assigned to a column strip or a beam is then proportionally assigned to 
the remaining middle strip. 

Note: By checking USER DISTRIBUTION FACTORS option in Solve Options dialog 
window, the user has the ability to manually adjust strip moment distribution 
factors calculated automatically by the program. 

ACI 318 and CSA A23.3-9452 
The column strips are proportioned to resist the portions in percent of interior 
negative factored moments according to Table 2-2.53 

l2/l1 0.5 1.0 2.0 

(αf1 l2/l1) = 0 75 75 75 

(αf1 l2/l1) ≥ 1.0 90 75 45 

Table 2-2 Column Strip Percent of Interior Negative Factored Moments at 
Supports 

The column strips are proportioned to resist the portions in percent of exterior 
negative factored moments according to Table 2-3.54 

l2/l1 0.5 1.0 2.0 
βt = 0 100 100 100 (αf1 l2/l1) = 0 βt ≥ 2.5 75 75 75 
βt = 0 100 100 100 (αf1 l2/l1) ≥ 1.0 βt ≥ 2.5 90 75 45 

Table 2-3 Column Strip Percent of Exterior Negative Factored Moments at 
Supports 

The values α1 in Table 2-2 and Table 2-3 and βt in Table 2-3 are defined as: 

                                                           
52 For CSA A23.3-94 standard, the program assumes by default values given by ACI code which fall 
within the ranges specified in CSA A23.3-94, 13.12.2 
53 ACI 318-08, 13.6.4.1; ACI 318-05, 13.6.4.1; ACI 318-02, 13.6.4.1; ACI 318-99, 13.6.4.1; CSA 
A23.3-94, 13.9.5.1; CSA A23.3-94, 13.8.5.1 
54 ACI 318-08, 13.6.4.2; ACI 318-05, 13.6.4.2; ACI 318-02, 13.6.4.2; ACI 318-99, 13.6.4.2; 
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αf1 = ratio of flexural stiffness of the beam section to flexural stiffness 
of a width of slab bounded by centerlines of adjacent panels (if 
any) on each side of the beam in the direction of analysis. For 
flat plates, flat slabs, and waffle αf1l2/l1 = 0 

βt = ratio of torsional stiffness of an edge beam section to flexural 
stiffness of a width of slab equal to the span length of the beam, 
center-to-center of supports.55 When no transverse beams are 
present, βt = 0, otherwise 

 
scs

cb
t IE2

CE
=β , Eq. 2-30 

where: 
Ecb = modulus of elasticity of beam concrete, 
Ecs = modulus of elasticity of slab concrete, 
C = cross-sectional constant, see Eq. 2-21, 
Is = moment of inertia of the gross section of the slab about its 

centroidal axis. 

For intermediate values of (l2/l1), (αf1l2/l1) and βt the values in Table 2-2 and Table 
2-3 are interpolated using equations Eq. 2-31 and Eq. 2-32. 

Percentage of negative factored moment at interior support to be resisted by 
column strip: 

 f1 2 2

1 1
75 30 1

⎛ ⎞ ⎛ ⎞α
+ −⎜ ⎟ ⎜ ⎟

⎝ ⎠ ⎝ ⎠

l l
l l

. Eq. 2-31 

Percentage of negative factored moment at exterior support to be resisted by 
column strip: 

 f1 2 2
t t

1 1
100 10 12 1

⎛ ⎞ ⎛ ⎞α
− β + −⎜ ⎟ ⎜ ⎟

⎝ ⎠ ⎝ ⎠
β

l l
l l

. Eq. 2-32 

When a column width, c2, is equal to or greater than 75 percent of the tributary 
strip width l2, the distribution factor for negative column strip moment is linearly 
interpolated between the factor for regular support, and the factor equal 0.50 
(moment uniformly distributed across l2). This extends the requirement of the 

                                                           
55 ACI 318-08, 13.6.4.2; ACI 318-05, 13.6.4.2; ACI 318-02, 13.0; ACI 318-99, 13.0; CSA A23.3-94, 
13.0 
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design code56, by providing continuous linear transition between standard and 
uniform moment distributions, depending on the relative dimension of the support 
with respect to strip width. User may override software assumptions by selecting 
user defined distribution factors. 

When designing by the CSA A23.3-94 code, a portion of the total positive or 
interior negative moment equivalent to57: 

 f1
2

2

1
1

α

⎛ ⎞
+ ⎜ ⎟

⎝ ⎠

l
l

, Eq. 2-33 

is resisted by the beam. For exterior supports, the beam is proportioned to resist 
100% of the negative moment. 

That portion of the moment not resisted by the beam is resisted by the slab. The 
reinforcement required to resist this moment is distributed evenly across the slab. 

For ACI designs the longitudinal beams are proportioned to resist 85 percent of the 
column strip moments if αf1l2/l1 is equal to or greater than 1.0. For values of 
αf1l2/l1 between 0 and 1.0, the beam is designed to resist a proportionate 
percentage of the column strip moment between 0 and 85.58 

The middle strips are proportioned to resist the portion of the total factored 
moments that is not resisted by the column strips. 

The column strips are proportioned to resist the portions in percent of positive 
factored moments according to Table 2-4.59 

l2/l1 0.5 1.0 2.0 
(αf1l2/l1) = 0 60 60 60 

(αf1l2/l1) ≥ 1.0 90 75 45 

Table 2-4 Column Strip Percent of Positive Factored Moments 

For intermediate values of (l2/l1) and (αf1l2/l1) the values in Table 2-4 are 
interpolated using Eq. 2-34 as follows: 

                                                           
56 ACI 318-08, 13.6.4.3; ACI 318-05, 13.6.4.3; ACI 318-02, 13.6.4.3; ACI 318-99, 13.6.4.3 
57 CSA A23.3-94, 13.13.2.1 
58 ACI 318-08, 13.6.5; ACI 318-05, 13.6.5; ACI 318-02, 13.6.5; ACI 318-99, 13.6.5 
59 ACI 318-08, 13.6.4.4; ACI 318-05, 13.6.4.4; ACI 318-02, 13.6.4.4; ACI 318-99, 13.6.4.4 
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 f1 2 2

1 1
60 30 1.5

⎛ ⎞ ⎛ ⎞α
+ −⎜ ⎟ ⎜ ⎟
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l l
l l

. Eq. 2-34 

Note: For flat plates, flat slabs, and waffle slabs, αf1l2/l1 = 0. 

CSA A23.3-04  
For slabs without drop panels (with or without transverse beams) the following 
moment factors are used60: 

• Negative moment at interior column, factor = 0.80 

• Negative moment at exterior column, factor = 1.00 

• Positive moment at all spans, factor = 0.60 

For slabs with drop panels (with or without transverse beams) the following 
moment factors are used61: 

• Negative moment at interior column, factor = 0.825 

• Negative moment at exterior column, factor = 1.00 

• Positive moment at all spans, factor = 0.60 

For slabs with longitudinal slab bands62: 

• Negative moment at interior column, factor = 0.90 

• Negative moment at exterior column, factor = 1.00 

• Positive moment at all spans, factor = 0.90 

For slabs with transverse slab bands63: 

• Negative moment at interior column in width bb, factor from 0.05 to 0.15 
range is selected so that the remaining moment is distributed evenly over the 
entire frame width (including bb width) and at least one-third of the total 
factored moment64 is applied to the band width bb. 

• Negative moment at exterior column, factor = 1.00 

                                                           
60 CSA A23.3-04, 13.11.2.2 
61 CSA A23.3-04, 13.11.2.3 
62 CSA A23.3-04, 13.11.2.4 
63 CSA A23.3-04, 13.11.2.5 
64 CSA A23.3-04, 13.11.2.7 



 

2-36  Method of Solution 

• Positive moment at all spans where (l1/l2) ≥ 1.0, factor = 0.55 

• Positive moment at all spans where (l1/l2) < 1.0, factor = 0.55 (l1/l2) 

For slabs with beams between all the supports65, the positive and interior negative 
factored moments are distributed as follows: 

 1 2

1 1
1

0.3 3
⎛ ⎞α

−⎜ ⎟+ α ⎝ ⎠

l
l

, Eq. 2-35 

Factored negative moments at exterior supports are assigned in 100% proportion to 
beams. 

CSA A23.3-04 does not stipulate requirement for distributing moments in slab 
systems with beams between some (but not all) supports. For estimation of the 
moment resisted by the beams in this case, the program applies the ACI approach 
described in the previous section where longitudinal beams are proportioned to 
resist 85 percent of the column strip moments if αf1l2/l1 is equal to or greater than 
1.0. For values of αf1l2/l1 between 0 and 1.0, the beam is designed to resist a 
proportionate percentage of the column strip moment between 0 and 85%.  

Moment Redistribution  
Redistribution of negative moments applies to one-way and beam systems only. It 
can be engaged using the Input Redistribution option on the Solve Options tab 
in the General Information dialog box. 

The program allows for redistribution of negative moments at supports. Only 
reduction in negative moments is considered. Increase of negative moments at the 
support is not taken into account even though it is allowed by the code66. Static 
equilibrium is maintained meaning that bending moments and shear forces along 
the span are adjusted in accordance with the reduction of moments applied at the 
supports. The following procedure is followed to obtain moment redistribution 
factors at the supports. 

From elastic static analysis, the largest moments from all load combinations and 
load patterns are determined at support faces on both ends of each span except 
cantilevers. These moments are used to calculate the maximum percentage 
adjustment of moments, δ , allowed by the codes. 

                                                           
65 CSA A23.3-04, 13.12.2 
66 ACI 318-08, 8.4.1; ACI 318-05, 8.4.1; ACI 318-02, 8.4.1; ACI 318-99, 8.4.1; CSA A23.3-04, 9.2.4; 
CSA A23.3-94, 9.2.4 
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For ACI 318-08, ACI 318-05 and ACI 318-0267: 

 
⎩
⎨
⎧
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t  Eq. 2-36 

where tε  is net tensile strain in extreme tension steel at nominal strength. 

For ACI 318-9968: 
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⎪
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 Eq. 2-37 

where: 
ρ  = tension reinforcement ratio, 

'ρ  = compression reinforcement ratio, 

bρ  = balanced reinforcement ratio. 

For CSA A23.369: 

 
d
c5030 −=δ , Eq. 2-38 

where: 
c = distance from extreme compression fiber to neutral axis, 
d = distance from extreme compression fiber to centroid of tension 

reinforcement. 

In the investigation mode, program uses the area of provided reinforcement to 
obtain redistribution factors. In the design mode the required reinforcement area is 
used. Additionally, δ  is limited to 20% and not to exceed the maximum values 
specified by the user. Negative moments at span ends are reduced by the amount 
of redistribution factors and new moment values are iteratively used to obtain new 
redistribution factors. This iterative procedure is repeated until the change in 
distribution factor is negligible (does not exceed 0.01%), but no more than 10 
times. 

                                                           
67 ACI 318-08, 8.4.1 and 8.4.3; ACI 318-05, 8.4.1 and 8.4.3 ; ACI 318-02, 8.4.1 and 8.4.3 
68 ACI 318-99, 8.4.1 and 8.4.3 
69 CSA A23.3-04, 9.2.4; CSA A23.3-94, 9.2.4 
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Shear Analysis of Slabs  
Shear analysis in spSlab takes into account one way shear and two-way shear. For 
two-way shear, the program considers contributions of factored shear force70, Vu, 
and fraction of unbalanced moment transferred by shear71, γvMunbal. spSlab does 
not consider torsional stresses in the slab. If in the engineer’s judgment this may 
control, it must be computed manually. 

spSlab checks one-way shear at a critical section located at a distance not less than 
the effective depth away from the face of the support72. If a concentrated load is 
applied closer than the effective depth away from the face of the support then 
critical section is located at the face of the support. Factored shear force at the 
critical section is obtained from the analysis of the equivalent frame73. 

 
Figure 2-15 Critical section for two-way shear 

                                                           
70 ACI 318-08, 11.11.7.2; ACI 318-05, 11.12.6.2; ACI 318-02, 11.12.6.2; ACI 318-99, 11.12.6.2; CSA 
A23.3-04, 13.3.5.2; CSA A23.3-94, 13.4.5.2 
71 ACI 318-08, 11.11.7.1; ACI 318-05, 11.12.6.1; ACI 318-02, 11.12.6.1; ACI 318-99, 11.12.6.1; CSA 
A23.3-04, 13.4.5.3; CSA A23.3-94, 13.4.5.3 
72 ACI 318-08, 13.5.4, 11.1.3; ACI 318-05, 13.5.4, 11.1.3; ACI 318-02, 13.5.4, 11.1.3; ACI 318-99, 
13.5.4, 11.1.3; CSA A23.3-94, 13.4.6.1; CSA A23.3-04, 13.3.6.1, 11.3.2; CSA A23.3-94, 13.4.6.1; 
11.3.2 
73 ACI 318-08, 13.7.1; ACI 318-05, 13.7.1; ACI 318-02, 13.7.1; ACI 318-99, 13.7.1; CSA A23.3-04, 
13.8.1.1; CSA A23.3-94, 13.9.1.1 
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Figure 2-15 shows the general two-way shear area74 used by spSlab. Note that the 
shaded area represents the general case and is modified for special considerations 
as explained below. 

Beams are considered in the two-way shear as indicated in Figure 2-15 by areas 
B1, B2, B3, B4, B5, and B6. Ordinarily, transverse beams transfer unbalanced 
moment to the column through torsion along the beam and not through shear 
between the slab and column. However, the code leaves the transfer method to the 
engineer’s judgment concerning the point at which punching shear is no longer 
applicable and beam shear becomes the dominate element in shear transfer to the 
column. spSlab makes no such distinction and computes unbalanced moment 
transfer stress without regard to any beams framing into the column. When a beam 
is present, the depth of the beam increases the depth of the critical section where it 
intersects with the beam. The distances from the face of the support to the critical 
section will also be increased, i.e. effective depth of the beam will be used to 
calculate the distance instead of effective depth of the slab, if it results in a critical 
section that is still within the beam. Otherwise, distances to the critical section are 
not increased. 

For a circular column or column capital, a square shape with an equivalent area is 
assumed as shown in Figure 2-16. Critical section area for punching, Ac, is then 
multiplied by )d4D2/()dD( +π+π  to account for the difference between 
circular and square critical sections, where D is the diameter of a column or 
a column capital and d is the effective depth of the slab. 

The critical section is considered closed if the concrete slab around a column 
extends to a distance greater than or equal to the specified threshold value. In 
spSlab, the user may define the distance extended beyond the column face in order 
to consider the section closed. If the critical section does not meet the distance 
requirement, it is considered open. 

ACI 318-08 code introduced the definition of the shear cap75 which, alternatively 
to column capital, can be used to increase the critical section around the column. 
spSlab users can use the capital geometry to model a shear cap and calculate the 
punching shear through the thickness of the slab itself (shear cap acting as capital). 
Other failure modes, such as punching within the perimeter of the shear cap, need 
to be verified by the user manually. The dimensions of the substitute capital have 
to be selected such that the resulting critical section is equivalent to critical section 

                                                           
74 ACI 318-08, 11.11.1.2; ACI 318-05, 11.12.1.2; ACI 318-02, 11.12.1.2; ACI 318-99, 11.12.1.2; CSA 
A23.3-04, 13.3.3; CSA A23.3-94, 13.4.3 
75 ACI 318-08, 2.2 
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for a column with a shear cap. ACI code76 requires shear caps to extend beyond 
the face of the column by at least the distance equal to cap depth, and so 
depth/extension ratio should not exceed 1.0. For column capitals depth/extension 
ratio should not be less than 1.0. Therefore to model shear cap acting as capital, 
the substituted capital should have depth/extension ratio equal to 1.0. 

 

 
Figure 2-16 Critical section area for circular column 

Critical Section for Interior Supports of Interior Frames  
The critical section (Figure 2-17) consists of four vertical surfaces through the 
slab, located at distances of d/2 beyond the support faces. 

 

                                                           
76 ACI 318-08, 13.2.6 
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Figure 2-17 Interior supports of interior frames 

The critical section for interior supports of interior frames is always closed. 
A closed section will have all its faces defined in Figure 2-15 resisting shear as 
indicated by Eq. 2-39: 

 ∑
=

=
8

1i
iC AA . Eq. 2-39 

If beams frame77 into the column, then the critical section includes the dimensions 
of the beams (B1 through B6 in Figure 2-15). 

Critical Section for Exterior Supports of Interior Frames  
The critical section for exterior supports of interior frames (Figure 2-18) will be 
either closed (full A7 and A6 for the first column or A1 and A2 for the last column 
in Figure 2-15) or open, depending upon the length of the cantilever in relation to 
slab thickness. The critical section will be considered closed when the clear 
cantilever span, lc, is greater than or equal to the distance defined by the user 
beyond the column face. The default value of the distance is 4 h when an ACI code 
is selected78 and 5 d for the CSA standard.79 The user can modify the default value 
to accommodate scenarios when larger distances are required, e.g. 10 h for slabs 
with openings80. If beams frame into the column then the critical section includes 
the contributions from the beam dimensions (B1 through B6 in Figure 2-16). 

                                                           
77 A beam is considered as framing into the column if the beam is within a face of the column. 
78 Critical Sections near Holes and at Edges in Ref. [11], pp.649, paragraph (c)  
79 CSA A23.3-04 Figure N13.3.3.4 (b) in Ref. [8]; CSA A23.3-94 Figure N13.4.3.4 (b) in Ref. [10] 
80 ACI 318-08, 11.11.6; ACI 318-05, 11.12.5; ACI 318-05, 11.12.5; ACI 318-05, 11.12.5; CSA A23.3-
04, 13.3.3.4; CSA A23.3-94, 13.4.3.4 
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Figure 2-18 Exterior supports of interior frames 

Critical Section for Interior Supports of Exterior Frames  
Figure 2-19 shows the critical section for shear for an interior support of an 
exterior frame. Note that the section is considered as U-shaped (A5 = 0, A8 = 0, 
B3 = 0, B4 = 0 in Figure 2-15) and it extends up to the edge of the exterior face of 
the support. If beams frame into the column, then the critical section includes the 
contribution from the beam dimensions (B1 through B6 in Figure 2-15). If the 
exterior cantilever span, lc, is greater than or equal to the distance defined by the 
user beyond the column face (the default value is 4 h when an ACI code is 
selected78 and 5 d for the CSA standard79), the section is treated as closed, that is, 
the support is treated as an interior support of an interior frame. 

Critical Section for Exterior Supports of Exterior Frames  
The critical section for an exterior support of an exterior frame will typically be L-
shaped (A5 = 0, A6 = 0, A7 = 0, A8 = 0, B1 = 0, B3 = 0, and B4 = 0 in Figure 2-15). 

If the cantilever span, lc, (in the direction of analysis) is greater than or equal to the 
distance defined by the user beyond the column face (the default value is 4 h when 
an ACI code is selected78 and 5 d for the CSA standard79), then the section is 
treated as a U-shaped interior support. If, in addition, the cantilever span in 
transverse direction is greater than or equal to the distance defined by the user 
beyond the column face, the section is treated as closed. If beams frame into the 
column, then the critical section includes the contributions from the beam 
dimensions. 
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Figure 2-19 Interior supports of exterior frames 

Computation of Allowable Shear Stress at Critical Section  

One-way shear strength of slabs is limited81 to '
c2 fλ . Two-way shear strength of 

slabs is affected by concrete strength, relationship between size of loaded area and 
slab thickness, loaded area aspect ratio, and shear-to-moment ratio at slab-column 
connections. 

These variables are taken into account in the allowable shear stress, vc, computed 
at distances of d/2 around the columns and drops (if applicable). For the ACI 318 
code, vc is taken as the smallest of the 3 quantities:82 

 '
c c

c

4v 2 f
⎛ ⎞

= + λ⎜ ⎟⎜ ⎟
⎝ ⎠β

, Eq. 2-40 

 's
c c

0

dv 2 f
b

⎛ ⎞α
= + λ⎜ ⎟

⎝ ⎠
, Eq. 2-41 

 '
c cv 4 f= λ , Eq. 2-42 

where: 

βc = the ratio of the long to the short side of the column. 

                                                           
81 ACI 318-08, 11.2.1.1; ACI 318-05, 11.3.1.1; ACI 318-02, 11.3.1.1; ACI 318-99, 11.3.1.1 
82 ACI 318-08, 11.11.2.1; ACI 318-05, 11.12.2.1; ACI 318-02, 11.12.2.1; ACI 318-99, 11.12.2.1 
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αs = a constant dependent on the column location, (40 for an interior 
4-sided effective critical area, 30 for an exterior 3-sided critical 
area, 20 for a corner 2-sided effective critical area.) 

d = distance from the slab bottom to centroid of the slab tension 
reinforcement at support 

b0 = the perimeter of the critical section 
λ = factor83 reflecting the reduced mechanical properties of 

lightweight concrete equal to 0.75 for all-lightweight concrete, 
0.85 for sand-lightweight concrete and 1.0 for normal weight 
concrete. Refer to Table 2-1 for determination of concrete type. 

For the CSA A23.384, the allowable shear stresses are calculated as the minimum 
of the following metric equations: 

 '
c c c

c

2v 1 f
⎛ ⎞

= + ηλφ⎜ ⎟⎜ ⎟
⎝ ⎠β

, Eq. 2-43 

 's
c c c

o

dv f
b

⎛ ⎞α
= + η λφ⎜ ⎟

⎝ ⎠
, Eq. 2-44 

 '
c c cv 2 f= ηλφ , Eq. 2-45 

where 

η = 0.19 for CSA A23.3-04 and 0.20 for CSA A23.3-94 
αs = a constant dependent on the column location, (4 for an interior 4-

sided effective critical area, 3 for an edge column, 2 for a corner 
column) 

cφ  = resistance factor for concrete85 equal to 0.60 for CSA A23.3-94 
and for CSA A23.3-04 it is equal to 0.65 for regular and 0.70 for 
precast concrete 

λ = factor86 reflecting the reduced mechanical properties of 
lightweight concrete equal to 0.75 for structural low-density 
concrete, 0.85 structural semi-low-density concrete and 1.0 for 
normal density concrete. Refer to Table 2-1 for determination of 
concrete type. 

                                                           
83 ACI 318-08, 11.11.2.1; ACI 318-05, 11.2.1.2; ACI 318-02, 11.2.1.2; ACI 318-99, 11.2.1.2 
84 CSA A23.3-04, 13.3.4; CSA A23.3-94, 13.4.4 
85 CSA A23.3-04 8.4.2, 16.1.3; CSA A23.3-94 8.4.2  
86 CSA A23.3-04, 8.6.5; CSA A23.3-94, 8.6.5 
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'
cf  ≤ 8 MPa. 

When the value of the effective depth d is greater than 300mm, allowable stress vc 
obtained from the above three equations shall be multiplied by 1300/(1000+d) as 
required by CSA A23.3-04 code87. 

The allowable shear stress around drops when waffle slabs are used is computed 
as: 

 

'
c

'
c c c

'
c c

2 f for ACI,

v 0.20 f for CSA A23.3-94,

0.19 f for CSA A23.3-04.

⎧ λ⎪
⎪= φ λ⎨
⎪
⎪ φ λ⎩

 Eq. 2-46 

For waffle slab systems with valid ribs defined earlier in this chapter, the 
allowable shear stress is increased by 10% for ACI designs.88  

Computation of Factored Shear Force at Critical Section  
The factored shear force Vu in the critical section, is computed as the reaction at 
the centroid of the critical section (e.g., column centerline for interior columns) 
minus the self-weight and any superimposed surface dead and live load acting 
within the critical section. If the section is considered open, two 45 degree lines 
are drawn from the column corners to the nearest slab edge (lines AF and DE in 
Figure 2-19) and the self-weight and superimposed surface dead and live loads 
acting on the area ADEF are omitted from Vu. 

Computation of Unbalanced Moment at Critical Section  
The factored unbalanced moment used for shear transfer, Munbal, is computed as 
the sum of the joint moments to the left and right. Moment of the vertical reaction 
with respect to the centroid of the critical section is also taken into account by 

 unbal u,left u,right u gM (M M ) V c= − − , Eq. 2-47 

where: 

Mu,left = factored bending moment at the joint on the left hand side of the 
joint, 

                                                           
87 CSA A23.3-04, 13.3.4.3 
88 ACI 318-08, 8.13.8; ACI 318-05, 8.11.8; ACI 318-02, 8.11.8; ACI 318-99, 8.11.8 



 

2-46  Method of Solution 

Mu,right = factored bending moment at the joint on the right hand side of 
the joint, 

Vu = factored shear force in the critical section described above, 
cg = location of the centroid of the critical section with respect to the 

column centerline (positive if the centroid is to the right in 
longitudinal direction with respect to the column centerline).  

Computation of Shear Stresses at Critical Section  
The punching shear stress computed by the program is based on the following:89 

 
c

u
u A

Vv = , Eq. 2-48 

where: 

Vu = factored shear force in the critical section described above, 
Ac = area of concrete, including beam if any, resisting shear transfer.  

Under conditions of combined shear, Vu, and unbalanced moment, Munbal, γvMunbal 
is assumed to be transferred by eccentricity of shear about the centroidal axis of 
the critical section. The shear stresses computed by the program for this condition 
correspond to:90 

 
c

ABunbalv

c

u
AB J

cM
A
Vv γ

+= , Eq. 2-49 

 
c

CDunbalv

c

u
CD J

cM
A
Vv

γ
−= , Eq. 2-50 

where: 

Munbal = factored unbalanced moment transferred directly from slab to 
column, as described above, 

γv = )1( fγ− , Eq. 2-51 

                                                           
89 ACI 318-05, 11.12.6.2; ACI 318-02, 11.12.6.2; ACI 318-99, 11.12.6.2; CSA A23.3-04, 13.3.5; CSA 
A23.3-94, 13.4.5 
90 ACI 318-08, R11.11.7.2; ACI 318-05, R11.12.6.2; ACI 318-02, R11.12.6.2; ACI 318-99, R11.12.6.2; 
CSA A23.3-04, 13.3.5.5; CSA A23.3-94, 13.4.5.5; Ref. [20] 
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  is a fraction of unbalanced moment considered transferred by the 
eccentricity of shear about the centroid of the assumed critical 
section,91  

c = distance from centroid of critical section to the face of section 
where stress is being computed, 

Jc = property of the assumed critical section analogous to polar 
moment of inertia. 

Factor fγ  in Eq. 2-51 is calculated as92 

 
21

f b/b)3/2(1
1

+
=γ , Eq. 2-52 

where: 

b1 = width of critical section in the direction of analysis, 
b2 = width of the critical section in the transverse direction. 

If an ACI 318 standard is selected then the program provides an option to use an 
increased value93 of γf . For edge and corner columns with unbalanced moment 
about an axis parallel to the edge, the value can be increased to 1.0 if the factored 
shear force at the support doesn’t exceed 0.75φVc for edge columns and 0.5φVc for 
corner columns. For ACI 318-99, ACI 318-02, and ACI 318-05, condition that 
reinforcement ratio in the effective slab width doesn’t exceed 0.375ρb must also be 
satisfied to apply the increase. For interior columns and for edge columns with 
unbalanced moment perpendicular to the edge, γf can be increased 25% but the 
final value of γf cannot exceed 1.0. The increase can be applied if the shear doesn’t 
exceed 0.4φVc. Also, the net tensile strain in the effective slab has to exceed 0.010 
for the ACI 318-08. For earlier ACI 318 editions, the condition that reinforcement 
ratio does not exceed 0.375ρb applies. 

spSlab calculates vu as the absolute maximum of vAB and vCD. Local effects of 
concentrated loads are not computed by spSlab and must be calculated manually. 

                                                           
91 ACI 318-08, 11.11.7.1; ACI 318-05, 11.12.6.1; ACI 318-02, 11.12.6.1; ACI 318-99, 11.12.6.1; CSA 
A23.3-04, Eq. 13-8; CSA A23.3-94, Eq. 13-8 
92 ACI 318-08, 13.5.3.2; ACI 318-05, 13.5.3.2; ACI 318-02, 13.5.3.2; ACI 318-99, 13.5.3.2; CSA 
A23.3-04, Eq. 13-8; CSA A23.3-94, Eq. 13-7 
93 ACI 318-08, 13.5.3.3; ACI 318-05, 13.5.3.3; ACI 318-02, 13.5.3.3; ACI 318-99, 13.5.3.3; 
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Shear Resistance at Corner Columns  
For the CSA A23.3 code, the program performs one-way shear resistance check in 
the vicinity of corner columns. For slabs with edge beams or drop panels 
a supplementary check including the contribution of these components should be 
preformed manually. 

For the CSA A23.3-94 edition, a critical shear section is located d/2 from the 
column corner. The minimum length section is selected using an optimization 
algorithm which analyzes sections at different angles. The extension to the 
cantilevered portion is considered by a length not to exceed effective slab 
thickness d.  

For the CSA A23.3-04 edition, a critical shear section is located not further than 
d/2 from the edge of the column or column capital. The extension to the 
cantilevered portion is considered by a length not to exceed effective slab 
thickness d. The factored shear resistance is calculated as follows94: 

 '
ccc fv βλφ= , Eq. 2-53 

where: 

β = factor accounting for shear resistance of cracked concrete95 

Shear Resistance in Slab Bands  
When performing two-way shear analysis for models with non-continuous 
longitudinal slab bands, calculations are performed as follows. Punching shear 
around the column is checked using effective depth of the slab band on one side of 
the column and the depth of the extension drop panel on the other side of the 
column. On each four sides of the column the critical section is located ½ of the 
respective depth from the face of the column. Punching shear calculation around 
the drop panel/slab band assumes that the plane of critical section, which cuts 
perpendicularly through slab band, is located ½d of the slab band from the face of 
column. For three remaining column faces critical section is located ½d of the slab 
measured from the respective edges of drop panel or slab band. 

One-Way Shear Analysis of Longitudinal Beams And Slabs  
When longitudinal beams are present in a span, the program computes the shear 
reinforcement requirements for the beams. Table “Longitudinal Beam Shear 
                                                           
94 CSA A23.3-04, 13.3.6.2 
95 CSA A23.3-04, 11.3.6.2 and 11.3.6.3 
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Reinforcement Required” in the program output provides values of Vu, Vc, and 
Av/s for selected segment locations of each span. Segment lengths are chosen not 
to exceed the beam section depth. The beginning of first segment and the end of 
last segment correspond to the locations of critical sections on the left and right 
support respectively. The critical sections are located at a distance d, the effective 
beam depth, away from the column face at both the left and the right ends of the 
beam. However, if concentrated loads are present within distance d from the 
column face, critical section is selected at the column face.  

Vu is computed from the load acting over the entire width of the design strip. The 
program makes no distinction between shallow beams (αf1l2/l1 < 1) and deeper 
beams (αf1l2/l1 > 1). 

Shear Calculations for ACI 318 and CSA A23.3-94 
Shear strength provided by concrete, Vc, is computed by:96 

 

'
c w

'
c w

c '
c w

'
c c w

2 f b d for ACI 318,

0.17 f b d for ACI 318M-08/05,
V

f b d 6 for ACI 318M-02/99,

0.20 f b d for CSA A23.3-94.

⎧ λ⎪
⎪ λ⎪= ⎨
⎪λ
⎪
⎪ φ λ⎩

 Eq. 2-54 

In CSA A23.3-94 design, for beams without minimum stirrup reinforcement and 
greater than 300 mm deep, Vc is calculated from the following equation97: 

 dbf10.0dbf
d1000

260V w
'
ccw

'
ccc φλ≥φλ⎟

⎠
⎞

⎜
⎝
⎛

+
= . Eq. 2-55 

When 2/VV cu φ> , the beam must be provided with at least a minimum shear 
reinforcement of:98 

                                                           
96 ACI 318-08, 11.2.1.1; ACI 318-05, 11.3.1.1; ACI 318-02, 11.3.1.1; ACI 318-99, 11.3.1.1; ACI 
318M-08, 11.2.1.1; ACI 318M-05, 11.3.1.1; ACI 318M-02, 11.3.1.1; ACI 318M-99, 11.3.1.1; CSA 
A23.3-94, 11.3.5.1 
97 CSA A23.3-94, 11.3.5.2 
98 ACI 318-08, 11.4.6.3; ACI 318-05, 11.5.6.3; ACI 318-02, 11.5.5.2; ACI 318-99, 11.5.5.2; ACI 
318M-08, 11.4.6.3; ACI 318M-05, 11.5.6.3; ACI 318M-02, 11.5.5.2; ACI 318M-99, 11.5.5.2; CSA 
A23.3-94, 11.2.8.4 
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( )

( )
( )

'
c

'
cw

v,min
yt '

c

'
c

max 0.75 f ,50 for ACI 318-08/05/02,

50 for ACI 318-99,

max 0.062 f ,0.35 for ACI 318M-08/05,b sA
f

max f 16,0.33 for ACI 318M-02,

0.33 for ACI 318M-99,

0.06 f for CSA A23.3-94,

⎧
⎪
⎪
⎪
⎪
⎪⎪= × ⎨
⎪
⎪
⎪
⎪
⎪
⎪⎩

 Eq. 2-56 

where 

Av = area of two legs of stirrups, 
s = stirrups spacing, 
bw = longitudinal beam width, 
fyt = yield strength of the shear reinforcement. 

When cu VV φ> , shear reinforcement must be provided so that: 

 
df
VV

s
A

yt

cuv

φ
φ−

= , Eq. 2-57 

where: 

Vu = factored shear force at the section being considered 
d = effective depth of the beam at the same location 

For the ACI 318-99 code the strength reduction factor for shear calculations is 
specified as 85.0=φ . For the ACI 318-08, ACI 318-05 and ACI 318-02 codes the 
strength reduction factor for shear calculations is equal 75.0=φ .  

The capacity of shear reinforcement Vs is limited to dbf8V w
'
cmax,s = . When Vu 

exceeds φVc+ φVs,max, the beam section dimensions must be increased or a higher 
concrete strength must be provided.99  

When dbf10V w
'
cu φ≤ , the spacing is computed as: 

                                                           
99 ACI 318-08, 11.4.7.9; ACI 318-05, 11.5.7.9; ACI 318-02, 11.5.6.9; ACI 318-99, 11.5.6.9; CSA 
A23.3-94, 11.3.4 
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 sb
v

A

s
A
1s = , Eq. 2-58 

where 

Asb =  total bar area of the two legged stirrup. 

The maximum stirrup spacing for ACI codes100 must not exceed d/2 or 24 in when 
'

u c wV 6 f b d≤ φ . When '
u c wV 6 f b d> φ , the maximum stirrup spacing must be 

reduced by half, to d/4 or 12 in. When dbf10V w
'
cu φ> , the beam section 

dimensions must be increased or a higher concrete strength must be provided. 

For the CSA A23.3-94 standard101, maximum spacing must not exceed the smaller 
of 0.7 d and 600 mm when '

u c c wV 0.1 f b d< λφ  or the smaller of 0.35 d and 

300 mm when '
u c c wV 0.1 f b d≥ λφ . 

For ACI designs the requirement for minimum shear reinforcement is waived 
for102: 

• Joist construction 

• Beams having depth not exceeding 10 in. 

• Beams monolithic with slab, with beam depth not exceeding 24 in. and 
not greater than the larger of 2.5 times flange thickness and 0.5 times web 
width. 

Shear Calculations for CSA A23.3-04 
For CSA A23.3-04 code, the program calculates shear strength Vc provided by 
concrete from the following equation103: 

 vw
'
ccc dbfV λβφ= , Eq. 2-59 

where 

                                                           
100 ACI 318-08, 11.4.5; ACI 318-05, 11.5.5; ACI 318-02, 11.5.4; ACI 318-99, 11.5.4; CSA A23.3-94, 
11.2.11 
101 CSA A23-3-94, 11.2.11 
102 ACI 318-08, 11.4.6.1; ACI 318-05, 11.5.6.1; ACI 318-02, 11.5.5.1 
103 CSA A23.3-04, 11.3.4 
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φc = resistance factor for concrete equal to 0.65 for regular and 0.70 
for precast concrete 

λ = factor to account for low-density concrete 
b w = beam web width 
d v = effective shear depth equal to greater of 0.9d or 0.72h 
β = factor accounting for shear resistance of cracked concrete 

'
cf  ≤  8 MPa. 

When cu VV > , the beam must be provided with at least minimum shear 
reinforcement104. Additionally minimum shear reinforcement is required for beam 
sections with overall thickness exceeding 750mm. Minimum area of shear 
reinforcement is calculated from the following formula105: 

 ' w
v c

y

b sA 0.06 f
f

= , Eq. 2-60 

Shear strength provided by shear reinforcement, Vs, is calculated from the 
following equation106: 

 
s

)cot(dfA
V vyvs

s
θφ

= , Eq. 2-61 

where 

φs = resistance factor for reinforcement steel107 equal to 0.85 
Av = area of shear reinforcement within distance s 
f y = yield strength of reinforcement 
d v = effective shear depth equal greater of 0.9d or 0.72h 
s = spacing of transverse reinforcement 
θ = the angle of inclination of diagonal compressive stresses. 

Spacing of transverse reinforcement, s, must not exceed the smaller108 of 0.7 d and 
600 mm when '

u c c wV 0.125 f b d≤ λφ  or the smaller109 of 0.35 d and 300 mm when 
'

u c c wV 0.125 f b d> λφ . 

                                                           
104 CSA A23.3-04, 11.2.8.1 
105 CSA A23.3-04, 11.2.8.2 
106 CSA A23.3-04, 11.3.5.1 
107 CSA A23.3-04, 8.4.3(a) 
108 CSA A23.3-04, 11.3.8.1 
109 CSA A23.3-04, 11.3.8.3 
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The program recognizes special member types and assumes values of β = 0.21 and 
θ = 42deg in the following cases110: 

• Slabs having thickness not exceeding 350 mm. 

• Beams having thickness not exceeding 250 mm. 

• Concrete joist construction. 

• Beams cast monolithically with the slab and having the depth below the slab 
not exceeding one-half of the width or 350mm. 

For other general cases the program utilizes the so called simplified method. The 
value of θ is assumed as 35deg. For sections having or requiring at least minimum 
transverse reinforcement β = 0.18 is assumed. For sections with no transverse 
reinforcement the value of β is calculated as follows111: 

 
vd1000

230
+

=β  Eq. 2-62 

Shear Distribution 
When no ribs are present, one way shear is proportioned to the slab and beam 
according to the following ratios: 

 f1 2 1 f1 2 1/ , 1 /α − αl l l l  Eq. 2-63 

When ribs are present (joist systems), one way shear is proportioned to the slab 
and beam according to the following ratios of cross-section areas: 

 
beamribs

beam

beamribs

ribs
AA

A,
AA

A
++

. Eq. 2-64 

Per requirement112 of CSA A23.3-04, the program allows distributing one-way 
shear in the slab between column and middle strips using the distribution factors 
which are proportional to the factors used for negative moment distribution. The 
fraction of the shear transferred to the beam remains unchanged irrespective of the 
use of this feature. This functionality is also provided for other design codes, to be 
selected at engineer’s discretion. 

                                                           
110 CSA A23.3-04, 11.3.6.2 
111 CSA A23.3-04, 11.3.6.3(b) 
112 CSA A23.3-04, 13.3.6.1 
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One-Way Shear in Slab Bands 
One-way shear calculations in slab bands are done similar to shear in two-way 
slabs, except the column strip is substituted by the band strip. Shear forces are 
distributed between the band and the middle strip proportionally to negative 
moment distribution factors. Transverse reinforcement is not considered. 

Shear in Drop Panels 
When calculating one-way shear capacity for two-way solid and waffle slabs, the 
contribution of the drop panel cross-section can be optionally selected. For such 
slabs, the shear capacity is calculated in three regions, with increased Vc values in 
support (drop panel) locations. In case shear is distributed into column and middle 
strips, drop panel contribution is divided according to the share of drop panel 
cross-section area in each strip. 

Torsion and Shear  
Torsion analysis can be engaged for beam and one way systems using the Torsion 
Analysis and Design check box located on the Solve Options tab in the Input | 
General Information dialog box. 

As far as torsional analysis is concerned, it is assumed that columns provide 
perfectly rigid supports so there is no transfer of torsional moments between spans. 
Within a span, torsional moments are considered only if a longitudinal beam is 
present. Torsion can be induced by concentrated and redistributed torsional loads 
and also, in the case of a beam with unsymmetrical cross sections, by self weight 
and area loads. A T-section with different flange widths is an example of a cross 
section which is not symmetrical. It can be obtained if a beam and a slab with 
different left and right widths are combined in the same span. However, in order 
for a flange to be considered in the torsional analysis its thickness has to be greater 
than twice the cover. If a flange is wider than the effective width then only the 
effective width is taken into account. 

The design for torsion is based on a thin-walled tube, space truss analogy. For the 
Canadian code the simplified method is used. The program allows both 
equilibrium and compatibility torsion conditions. In the equilibrium mode, which 
is assumed by default, unreduced total value of the torsional design moment is 
used in the design. In the compatibility mode113, factored torsional moments that 
exceed cracking moment crT  (0.67 crT for CSA) are reduced to the value of crT  

                                                           
113 ACI 318-08, 11.6.2.2; ACI 318-05, 11.6.2.2; ACI 318-02, 11.6.2.2; ACI 318-99, 11.6.2.2; CSA 
A23.3-04, 11.2.9.2; CSA A23.3-94, 11.2.9.2 
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(0.67 crT  for CSA). However, it is user’s responsibility to determine which mode 
is appropriate and the program does not perform any redistribution of internal 
forces if compatibility torsion is selected.  

If torsion analysis is engaged then both torsion and shear actions contribute to the 
amount of required transverse (stirrup) reinforcement. However, additional 
longitudinal bars distributed along the perimeter of a cross-section are also 
required to provide torsional capacity. 

For torsion design a span is divided into segments in the same way as for shear 
design. Governing values within a segment are used to design the whole segment. 
For stirrups, the governing values of torsional moment and shear force (acting 
simultaneously) will be these that produce the highest intensity of required stirrup 
area. On the other hand, the required area of longitudinal bars depends only on the 
torsional moment so the highest absolute value of torsional moment will govern. 
Since stirrup area depends both on shear and torsion whereas longitudinal bar area 
depends only on torsion, the governing values for stirrups and longitudinal bars 
can occur at different locations within a segment and for different load 
combinations. Governing values along with their location and associated load 
combination are provided in the design results report. 

Effect of torsion within a segment will be neglected if the factored torsional 
moment, uT , at every segment location is less than one fourth of the torsion 
cracking moment, crT , which equals: 

for ACI code114 
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for CSA A23.3-94 code115  
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for CSA A23.3-04 code116 

                                                           
114 ACI 318-08, R11.5.1; ACI 318-05, R11.6.1; ACI 318-02, R11.6.1; ACI 318-99, R11.6.1; 
115 CSA A23.3-94, 11.2.9.1 
116 CSA A23.3-04, 11.2.9.1 
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Acp denotes the area enclosed by outside perimeter of concrete section and pcp is 
equal to the outside perimeter of concrete section. 

To be adequate for torsion design, a section has to be proportioned in such a way 
that combined shear stress due to shear and torsion does not exceed the limit value 
specified by the code. In ACI code this condition reads as117: 
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The simplified method of CSA A23.3-94 standard defines this relation as118: 
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Similar requirement for CSA A23.3-04 reads as follows119: 
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In above relations, ohA  is the area enclosed by centerline of the outermost closed 
transverse reinforcement and hp  is the perimeter of that area. By default, flanges 
do not contribute to ohA  and hp . For sections with flanges, flanges will only be 
taken into account for ohA  and hp  if the option to include stirrups in flanges is 
engaged in the torsion design. In the program output, the combined stress (left 
hand side of the above inequalities) is denoted as fv and the limit value as vtsφ . 

The required intensity of stirrup area to provide required torsional capacity is 
calculated from the following formula120: 

                                                           
117 ACI 318-08, 11.5.3.1; ACI 318-05, 11.6.3.1; ACI 318-02, 11.6.3.1; ACI 318-99, 11.6.3.1; 
118 CSA A23.3-94, 11.3.9.8 
119 CSA A23.3-04, 11.3.10.4(b) 
120 ACI 318-08, 11.5.3.6; ACI 318-05, 11.6.3.6; ACI 318-02, 11.6.3.6; ACI 318-99, 11.6.3.6; CSA 
A23.3-04, 11.3.10.3; CSA A23.3-94, 11.3.9.4 
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where the gross area enclosed by the shear path121, oA , is taken as ohA85.0 . 
s/A t  is the quantity per stirrup leg. Concrete shear and torsion strength reduction 

factor122, φ, for ACI-318 codes is equal to 0.75 for the 99 edition and 0.75 for later 
editions.  

The total requirement for stirrup intensity combining shear and torsion equals123 
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This value cannot be taken less than minimum stirrup area required by the codes. 
The minimum code requirements can be written in the following form124: 
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 Eq. 2-73 

In addition to stirrup spacing requirement defined for shear, program imposes one 
more torsion specific requirement for all ACI codes125 which limits the spacing to 
                                                           
121 CSA A23.3-04, 11.3.10.3; CSA A23.3-94, 11.3.9.7 
122 ACI 318-08, 9.3.2.3; ACI 318-05, 9.3.2.3; ACI 318-02, 9.3.2.3; ACI 318-99, 9.3.2.3 
123 ACI 318-08, R11.5.3.8; ACI 318-05, R11.6.3.8; ACI 318-02, R11.6.3.8; ACI 318-99, R11.6.3.8 
124 ACI 318-08, 11.5.5.2; ACI 318-05, 11.6.5.2; ACI 318-02, 11.6.5.2; ACI 318-99, 11.6.5.2; ACI 
318M-08, 11.5.5.2; ACI 318M-05, 11.6.5.2; ACI 318M-02, 11.6.5.2; ACI 318M-99, 11.6.5.2; CSA 
A23.3-04, 11.2.8.2; CSA A23.3-94, 11.2.8.4 
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the smallest of 8/ph , and 12 in [300 mm]. Based on the total required stirrup area 
intensity and spacing requirements, the program attempts to select stirrups taking 
also into account that if stirrups with more than two legs have to be used then the 
area of an outer leg must not be less than tA . 

Additional Longitudinal Reinforcement for ACI 318 and CSA A23.3-94 
The area of additional longitudinal reinforcement, lA , is calculated from126 

 u h

o y

T p
A

2 A f
=

φl . Eq. 2-74 

For ACI code it is also checked against the following minimum value127: 
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l , Eq. 2-75 

where s/A t  is calculated from Eq. 2-56 but is not taken less than w yt25b / f . 
Longitudinal bars are selected in such a way that their area is not less than 

min,AA ll ≥  and that number of longitudinal bars in a section is enough to provide 
a bar in every corner of a stirrup and preserve spacing between bars not higher 
than 12 in [300 mm]. Also, bar sizes are selected not to have diameter less than 
No. 3 bar and not less than 1/24 of stirrup spacing for ACI codes128 and 1/16 for 
CSA standard129. 

Additional Longitudinal Reinforcement for CSA A23.3-04 
The additional longitudinal reinforcement, Al , will only be calculated for CSA 
A23.3-04 if option COMBINED M-V-T REINF. DESIGN is unchecked in the Solve 
Options dialog window. If this option is checked (default setting) then no 
additional longitudinal reinforcement is calculated because the regular top and 
bottom reinforcement will automatically be proportioned to resist combined action 
of flexure, shear and torsion. 

Proportioning of longitudinal reinforcement for sections subjected to combined 
shear and torsion in flexural regions is based on the requirement that the resistance 
                                                                                                                                      
125 ACI 318-08, 11.5.6.1; ACI 318-05, 11.6.6.1; ACI 318-02, 11.6.6.1; ACI 318-99, 11.6.6.1 
126 ACI 318-08, 11.5.3.7; ACI 318-05, 11.6.3.7; ACI 318-02, 11.6.3.7; ACI 318-99, 11.6.3.7; CSA 
A23.3-94, 11.3.9.5 
127 ACI 318-08, 11.5.5.3; ACI 318-05, 11.6.5.3; ACI 318-02, 11.6.5.3; ACI 318-99, 11.6.5.3 
128 ACI 318-08, 11.5.6.2; ACI 318-05, 11.6.6.2; ACI 318-02, 11.6.6.2; ACI 318-99, 11.6.6.2 
129 CSA A23.3-04, 11.2.7; CSA A23.3-94, 11.2.7 
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of the longitudinal reinforcement has to be greater or equal to the axial force that 
can be developed in this reinforcement. In sections with no axial action ( fN 0=  
and 0Vp = ) that force is equal to130: 

• flexural tension side  
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• flexural compression side 
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These forces can be decomposed131 into flexure and shear components. The 
flexure components, flexure,ltF and flexure,lcF , account for the action of the bending 
moment, fM , whereas the shear components, shear,ltF and shear,lcF , account for the 
action of the shear force, fV , and the torsional moment, fT . The amounts of 
reinforcement needed to resist the flexure components are calculated separately in 
the flexure design procedure. The total amount of the additional longitudinal 
reinforcement, Al , needed to resist shear and torsion will be determined as 
follows: 
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130 CSA A23.3-04, 11.3.9.2, 11.3.9.3, 11.3.10.6 
131 See Eq. 7-42, pp 294 in Ref. [12] 
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If only torsion is present ( 0Vf =  and 0Vs = ), then (assuming132 o35=θ ) Al  
would reduce to 
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which is comparable (and conservative) to the additional amount of longitudinal 
reinforcement due to torsion required in accordance with the previous edition of 
the CSA A23.3 standard133.  

Investigation mode  
In the investigation mode when transverse and longitudinal reinforcement is input 
by the user, the program checks the combined shear and torsional capacity of the 
system in terms of required and provided reinforcement area. In other words, the 
provided area of reinforcement is compared to the area of reinforcement required 
to resist applied loads. This is a different approach than for flexure and shear 
actions without coupling where design forces are directly compared to capacity. In 
the case where torsion and shear stirrup requirements are combined, the approach 
of comparing total reinforcement area is more convenient since it does not require 
dividing stirrup area into a part that resists torsion only and a part that resists shear 
only. For consistency, additional longitudinal reinforcement required for torsion 
and shear is also checked in terms of provided and required area. Other 
requirements, e.g. bar or stirrup spacing, number of longitudinal bars, area of 
stirrup outer leg, and combined stresses in concrete due to shear and torsion are 
checked also. Exceeded capacity and other conditions are flagged in the Design 
Results section of the report. 

Area of Reinforcement  
The program calculates the required area of reinforcement (top and bottom) based 
on the values of bending moment envelope within the clear span. For rectangular 
sections with no compression reinforcement, the design flexural strength of the 
column strip, middle strip and beam must equal the factored design moment: 
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132 CSA A23.3-04, 11.3.6.3 
133 CSA A23.3-94, 11.3.9.5 



 

Method of Solution  2-61 

The reinforcement can therefore be computed from: 
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For CSA A23.3 

 ⎟
⎟
⎠

⎞
⎜
⎜
⎝

⎛

φα

φ
−φ=

bf2
fA

dAfM '
cc1

yss
sysr . Eq. 2-82 

The effective depth of the section is taken as the overall section depth minus the 
distance from the extreme tension fiber to the tension reinforcement centroid. The 
column strip depth may include all or part of the drop panel depth. The drop depth 
will not be included in the effective depth of the column strip when the drop does 
not extend at least one-sixth the center-to-center span length in all directions, or 
when the drop depth below the slab is less than one-quarter the slab depth. If the 
drop extends at least one-sixth the center-to-center span length and the drop depth 
is greater than one-quarter the distance from the edge of the drop panel to the face 
of the column or column capital, the excess depth will not be included in the 
column strip effective depth. If the drop width is less than the column strip width, 
the drop width will be used in the computation of the required reinforcement. 

When computing negative slab reinforcement and additional reinforcement for 
negative unbalanced moments over the supports, the contribution of the depth of 
transverse beam can be optionally selected. The contribution of transverse beam 
will be considered, if it extends beyond the critical section and if its depth exceeds 
the depth of the drop panel. The increase of the slab thickness is limited to ¼ of the 
extent of the transverse beam beyond the face of support, identical to design depth 
limitations for drop panels. If transverse beam depth exceeds the limit, excess 
depth is disregarded in the reinforcement calculations. 

For two-way slabs with beams, an option exists when designing reinforcement for 
positive bending moments, to include a portion of slab as beam flanges134 (T-
Section). The width of the column strip is then decreased accordingly. The extent 
of the flanges on each side is limited to four times slab thickness and not more that 
the projection of the beam under the slab. When this option is not selected, beam 
geometry is treated as rectangular. When calculating required reinforcement for 
negative bending moments the geometry of the beam is treated as rectangular, 
having beam width equal to web width. However, when a T-Section is selected, 

                                                           
134 See footnote 49 
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reinforcing bar design is performed assuming that they are distributed across the 
beam width including the flanges. 

For the ACI 318-99 code the strength reduction factor for flexure calculations is 
specified as φ=0.90.135 For the ACI 318-08, ACI 318-05 and ACI 318-02 codes the 
strength reduction factor for tension-controlled sections ( 005.0t ≥ε ) is equal 
φ=0.90. For transition sections ( y s tf / E 0.005≤ ε ≤ ) the strength reduction factor 
can be linearly interpolated by the formula136: 

 t y s
y s

0.90 0.650.65 ( f / E )
0.005 f / E

−
φ = + ε −

−
. Eq. 2-83 

ACI 318-08, ACI 318-05 and ACI 318-02 codes specify the strength reduction 
factor for compression controlled sections (εt < fy Es) as equal φ=0.65. The 
reduction factors for transition or compression controlled sections have application 
primarily in investigation mode of the program. In design mode the program 
performs the calculations assuming a tension controlled section (εt ≥ 0.005) or 
a section with compressive reinforcement (if enabled). 

The ACI 318-99 code137 requires keeping the steel ratio below the maximum 
value, ρmax, equal to 75% of steel ratio producing balanced strain condition, ρb, 
where:138 
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For CSA code the value of ρmax equals ρb and is calculated as follows139: 

                                                           
135 ACI 318-99, 9.3.2 
136 ACI 318-08, 9.3.2; ACI 318-05, 9.3.2; ACI 318-02, 9.3.2 
137 ACI 318-99, 10.3.3 
138 ACI 318-99, 8.4.3 
139 CSA A23.3-04, 10.5.2; CSA A23.3-94, 10.5.2; Eq. 4-24, pp 110 in Ref. [12] 
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where  

α1 = 67.0f 0015.085.0 '
c ≥− , 

β1 = 67.0f 0025.097.0 '
c ≥− . 

The ACI 318-08, ACI 318-05 and ACI 318-02 codes control the amount of 
reinforcement by limiting the value of net tensile strain (εt ≥ 0.004)140. The 
program satisfies this condition by assuming a tensioned controlled section with 
εt ≥ 0.005. From this assumption the equivalent maximum reinforcement ratio for 
rectangular section can be written as: 
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'
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f85.0

005.0003.0
003.0 β
+

=ρ  Eq. 2-86 

If the calculated reinforcement exceeds the maximum allowed, a message will 
appear in the output. In such cases, it is recommended that the engineer review the 
slab thickness to ensure a more satisfactory design. If compression reinforcement 
calculations are enabled, the program will attempt to add compression 
reinforcement to the section. The program is capable to design compressive 
reinforcement for any design strip (column, middle, and beam) including also 
unbalanced moment strip141. 

The amount of reinforcement provided will not be less than the code prescribed 
minimum. For the ACI 318 code, the minimum ratio of reinforcement area to the 
gross sectional area of the slab strip using Grade 60 reinforcement is taken as 
0.0018. When reinforcement yield strength exceeds 60 ksi, the minimum ratio is 
set to 0.0015×60 / fy. For reinforcement with yield strength less than 60 ksi, the 
minimum ratio is set to 0.0020. In no case will this ratio be less than 0.0014 (See 
Table 2-5)142. The CSA Standard requires a minimum ratio of slab reinforcement 
area to gross sectional area of the slab strip equal to 0.002 for all grades of 
reinforcement143. 

                                                           
140 ACI 318-08, 10.3.5; ACI 318-05, 10.3.5; ACI 318-02, 10.3.5 
141 ACI 318-08, 13.5.3.2; ACI 318-05, 13.5.3.2; ACI 318-02, 13.5.3.2; ACI 318-99, 13.5.3.2; CSA 
A23.3-04, 13.3.5.3; CSA A23.3-94, 13.11.2 
142 ACI 318-08, 7.12.2.1; ACI 318-05, 7.12.2.1; ACI 318-02, 7.12.2.1; ACI 318-99, 7.12.2.1 
143 CSA A23.3-04, 7.8.1; CSA A23.3-94, 7.8.1 
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fy (ksi) As/Ag 

< 60 0.0020 

≥ 60 0014.0
f

600018.0

y
≥

×  

Table 2-5. Minimum Ratios of Reinforcement to Gross Concrete Area 

According to ACI code for beams and positive moment regions of joist slabs, 
minimum reinforcement provided will not be less than:144 

 db
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f3
A w

y
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c

min,s =  Eq. 2-87 

and not less than 200bwd/fy where bw is the web width of the section. For statically 
determinate sections with flange in tension, bw is replaced by the smaller of 2bw 
and the width of the flange. 

Similar equation prescribed by CSA A23.3 code has the form145: 
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'
c

min,s =  Eq. 2-88 

where bt is the width of the tension zone of the section. Additionally, for T-
sections having flange in tension the CSA code limits value of bt to 1.5bw for 
single sided flanges and to 2.5bw for double sided flanges. 

When designing reinforcement for longitudinal slab bands according to CSA code, 
program assumes identical minimum steel requirements as for beams. 

Design for Combined Flexure, Shear, and Torsion  
CSA A23.3-04 requires, in proportioning of longitudinal reinforcement, to include 
additional tension forces caused by shear and torsion146. To achieve this, the 
program calculates forces developed in the longitudinal reinforcement due to 
flexure, shear, and torsion.  

                                                           
144 ACI 318-08, 10.5.1; ACI 318-05, 10.5.1; ACI 318-02, 10.5.1; ACI 318-99, 10.5.1 
145 CSA A23.3-04, 10.5.1.2(b); CSA A23.3-94, 10.5.1.2(b) 
146 CSA A23.3-04, 11.3.9 
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On the flexural tension side the force in longitudinal reinforcement is equal to147 
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On the flexural compression side the force in longitudinal reinforcement is equal 
to148 
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but not less than zero. 

For these forces, longitudinal reinforcement area is calculated from the following 
equations149 
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 Eq. 2-92 

Taking into account both positive and negative bending moments (resulting from 
all load combinations and load patterns) and checking against area of steel 
required for flexure only, the final areas of top and bottom reinforcement can be 
calculated from: 
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147 CSA A23.3-04, 11.3.9.2 and 11.3.10.6 
148 CSA A23.3-04, 11.3.9.3 and 11.3.10.6 
149 CSA A23.3-04, 11.3.9.1 
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Reinforcement Selection  
According to ACI-318 code150, the default minimum clear spacing of 
reinforcement for both slabs and beams is taken as the larger of the two prescribed 
minima of one bar diameter, db, or 1 in. According to CSA code151, the default 
minimum clear spacing of reinforcement for both slabs and beams is taken as the 
larger of the two prescribed minima of 1.4 times the bar diameter, db, or 1.2 in 
(30mm). The user may select a clear spacing greater than the default value to take 
into account tolerances for reinforcement placement152 and other project specific 
considerations.  
For two-way systems, the maximum spacing of reinforcement is kept at two times 
the slab thickness for the ACI code153 and three times the slab thickness for the 
CSA code154, but no more than 18 in. or 500 mm respectively. For joist systems 
the limit is increased to 5 times the slab thickness155. When calculating negative 
support reinforcement for the CSA code156, the program assumes that banded 
reinforcement over supports is spaced at a maximum of 1.5 hs and no more than 
250 mm. 

For one-way slabs, the maximum spacing is limited to157 the smaller of three times 
the slab thickness and 18 in. [500 mm]. Additionally, the maximum spacing of 
reinforcement, s, in beams and one-way slabs is selected so that the following 
crack control requirements of the ACI and the CSA codes158 are met: 

                                                           
150 ACI 318-08, 7.6.1; ACI 318-05, 7.6.1; ACI 318-02, 7.6.1; ACI 318-99, 7.6.1 
151 CSA A23.3-04, Annex A, 6.6.5.2; CSA A23.3-94, Annex A, A12.5.2 
152 See ACI 317-06 (Ref. [5]) 
153 ACI 318-08, 13.3.2; ACI 318-05, 13.3.2; ACI 318-02, 13.3.2; ACI 318-99, 13.3.2 
154 CSA A23.3-04, 13.10.4; CSA A23.3-94, 13.11.3(b) 
155 ACI 318-08, 7.12.2.2; ACI 318-05, 7.12.2.2; ACI 318-02, 7.12.2.2; ACI 318-99, 7.12.2.2; CSA 
A23.3-04, 7.8.3; CSA A23.3-94, 7.8.3 
156 CSA A23.3-04, 13.10.4; CSA A23.3-94, 13.11.3(a) 
157 ACI 318-08, 7.6.5; ACI 318-05, 7.6.5; ACI 318-02, 7.6.5, ACI 318-99, 7.6.5; CSA A23.3-04, 
7.4.1.2; CSA A23.3-94, 7.4.1.2 
158 ACI 318-08, 10.6.4; ACI 318-05, 10.6.4; ACI 318-02, 10.6.4; ACI 318-99, 10.6.4; CSA A23.3-04, 
10.6.1; CSA A23.3-94, 10.6.1 
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 Eq. 2-95 

where: 

cc = least distance from the surface of bar to the tension face, 
dc = distance from extreme tension fiber to center of the closest 

longitudinal bar 
A = effective tension area of concrete surrounding the flexural 

tension reinforcement and extending from the extreme tension 
fiber to the centroid of the flexural tension reinforcement and an 
equal distance past that centroid, divided by the number of bars 
or wires 

zmax = 30 000 N/mm for interior exposure or 25 000 N/mm for exterior 
exposure, multiplied by a factor of 1.2 for epoxy-coated 
reinforcement 

An iterative process is performed to determine the number of bars and bar size. 
The initial number of bars is determined by dividing the total reinforcement area 
required, As, by the area of one bar, Asb, of the input minimum bar size. Next, the 
spacing is determined. If the minimum spacing limitations are violated, the bar 
size is increased and the iterative process is repeated until all bars sizes have been 
checked. If the maximum spacing limitations are not met, the number of bars 
required to satisfy these limitations is computed and the iteration process 
terminates. 

For beams, layered reinforcement is provided if sufficient beam width is not 
available. The clear distance between layers is assumed 1.0 in [30 mm] but the 
user can change this value. By default, the program assumes a 1.5 in [40 mm] side 
cover to stirrup for width calculations and this value can also be changed by the 
user. The program also assumes that the longitudinal bar makes contact at the 
middle of the stirrup bend where the minimum inside diameter of the bend is four 
times stirrup diameter159. Therefore, an additional width is added to the cover for 

                                                           
159 ACI 318-08, 7.2.2; ACI 318-05, 7.2.2; ACI 318-02, 7.2.2; ACI 318-99, 7.2.2; CSA A23.3-04, 7.1.1 
and Table 16 in Annex A; CSA A23.3-94, 7.1.1 and Table 16 in Annex A 
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longitudinal bars less than size #14 (#45 for CAN/CSA-G30.18) (Figure 2-20 – 
Figure 2-21). This additional width due to the bend, bendw , is equal to: 

 b
bend

d2w 1  r
2 2

⎛ ⎞ ⎛ ⎞= − −⎜ ⎟ ⎜ ⎟⎜ ⎟ ⎝ ⎠⎝ ⎠
, Eq. 2-96 

where 

db = diameter of the longitudinal bar 
r = inside radius of bend for stirrup 

 

Side Cover

Stirrup  
Figure 2-20 Width due to stirrup bend 
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Figure 2-21 Detail reinforcement in longitudinal beams 

Bar-length computations are performed for two-way slabs and longitudinal beams. 
For top reinforcement at the supports, the length for long bars is given by: 
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 Eq. 2-97 

and the length for short bars is given by: 

 
( ) { }

{ }
50% b

short
fos d,short cr,short

max max d,12d ,
max

max , ,

⎧ +⎪= ⎨
+⎪⎩

l
l

l l l
 Eq. 2-98 

where: 

max(l50%) = maximum distance to the points of 50% demand, 
max(lpi) = maximum distance to the points of inflection (P.I.), 
ld = bar development length160, 
d = effective depth, 

                                                           
160 Chapter 12 in ACI 318-08, ACI 318-05, ACI 318-02, and ACI 318-99; CSA A23.3-04, Clause 12.2; 
CSA A23.3-94, Clause 12.2 
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db = bar diameter, 
ln = clear span length, 
lfos = distance to the face of support (column), 
lcr = minimum code prescribed extension. 

These bar lengths are then compared and adjusted if necessary to the minimum 
requirements specified by the code.161 Additionally the program may select 
continuous top bars in those spans where steel is required by calculation in mid-
span at top. 

If the computed bar lengths overlap, it is recommended that such reinforcement be 
run continuously. The printed bar lengths do not include hooks or portions of bars 
bent down into spandrel beams or other bar-bend configurations. If a bar starts (or 
ends) at a column support the length of the bar is measured from (or to) the center 
line of the column. The selection of bar lengths for positive reinforcement for flat 
plates, flat slabs, and beam-supported slabs, is based strictly on the minimum 
values of the code. 

The development length depends on the following factors: concrete cover, 
minimum transverse reinforcement, special transverse reinforcement, layer 
location bar size and bar clear spacing. The development length is calculated from 
the general expression162 below, but not less 163 than 12 in [300 mm]: 

 y t e s
d b '

d trc

b

3 for ACI 318-08,
40

1 for ACI 318M-08,
1.1

f 3d for ACI 318-05/02/99,
40c Kf

d for ACI 318M-05/02/99,
1.1
1.15 for CSA A23.3-04/94,

4

⎧
⎪ λ⎪
⎪
⎪ λ
⎪ψ ψ ψ ⎪ λ= × ⎨

⎛ ⎞+ ⎪⎜ ⎟ ⎪ λ⎝ ⎠ ⎪
⎪

πλ⎪
⎪⎩

l  Eq. 2-99 

                                                           
161 Figure 13.3.8 in ACI 318-08, ACI 318-05, ACI 318-02, and ACI 318-99; CSA A23.3-04, Figure 
13.1; CSA A23.3-94, Figure 13.1 
162 ACI 318-08, 12.2.3; ACI 318-05, 12.2.3; ACI 318-02, 12.2.3; ACI 318-99, 12.2.3; ACI 318M-08, 
12.2.3; ACI 318M-05, 12.2.3; ACI 318M-02, 12.2.3; ACI 318M-99, 12.2.3;CSA A23.3-04, 12.2.2; 
CSA A23.3-94, 12.2.2 
163 ACI 318-08, 12.2.1; ACI 318-05, 12.2.1; ACI 318-02, 12.2.1; ACI 318-99, 12.2.1; CSA A23.3-04, 
12.2.1; CSA A23.3-94, 12.2.1 
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where: 

ψt = reinforcement location factor (1 or 1.3), 
ψe = coating factor (1.2 or 1.5), 
ψs = reinforcement size factor (1 or 0.8), 
λ = lightweight aggregate concrete factor equal to 1.0 for normal 

concrete and: 
  0.75 for lightweight concrete per ACI 318-08 
  1.3 for lightweight concrete per ACI 318-05/02/99 
  1.3 for low density concrete per CSA A23.3-04/94 
  1.2 for semi low density concrete per CSA A23.3-04/94 
Ktr = transverse reinforcement index conservatively assumed zero, 
cb = smaller of the distance form bar surface to the closest concrete 

surface and one-half (two thirds for CSA164) center-to-center bar 
spacing.165 

Concentration and Additional Reinforcement at Support  
spSlab computes the fraction of the unbalanced moment, γf Mu, that must be 
transferred by flexure within an effective slab width (a band) equal to the column 
width plus one and one-half the slab or drop panel depth (1.5h) on either side of 
the column where:166 

 f

1 2

1
21 b / b
3

γ =
+

 Eq. 2-100 

The amount of reinforcement required to resist this moment is computed. The 
amount of reinforcement already provided for flexure is then computed from the 
bar schedule (i.e. the number of bars that fall within the effective slab width 
multiplied by the area of each bar). Depending on load conditions, additional 
negative or positive reinforcement may be required. If the reinforcement area 
provided for flexure is greater than or equal to the reinforcement requirements to 
resist moment transfer by flexure, no additional reinforcement is provided, and the 
number of additional bars will be set to 0. If the amount of reinforcement provided 
for flexure is less than that required for moment transfer by flexure, additional 
reinforcement is required. The additional reinforcement is the difference between 
                                                           
164 Denoted as dcs in CSA A23.3-04, 2.3 and CSA A23.3-94, 12.0 
165 ACI 318-05, 2.1; ACI 318-02, 12.2.4; ACI 318-99, 12.2.4 
166 ACI 318-08, 13.5.3.2; ACI 318-05, 13.5.3.2; ACI 318-02, 13.5.3.2; ACI 318-99, 13.5.3.2; CSA 
A23.3-04, 13.3.5.3; CSA A23.3-94, 13.11.2 and 13.4.5.3 
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that required for unbalanced moment transfer by flexure and that provided for 
design bending moment in the slab, and it is selected based on the bar size already 
provided at the support. 

For ACI codes the value of γf on selected supports can be automatically adjusted to 
the maximum permitted value. The corresponding value of γv = 1 – γf  is adjusted 
accordingly. This option allows relaxing stress levels for two-way shear around the 
columns by transferring increased part of the unbalanced moment through flexure. 
The adjustment is performed independently for each load case and pattern. If for 
given load case the corresponding two-way shear Vu exceeds the appropriate limits 
0.75φVc at an edge support, 0.5φVc at a corner support, or 0.4φVc at an interior 
support, adjustment of both factors is not performed. When the adjustment of γf 
and γv factors is selected, the reinforcement calculated within the transfer width 
should be  limited according to the code to reinforcement ratio ρ < 0 .375ρb, as 
stipulated in ACI 318-99/02/05167, or limitation of net tensile strain εt  > 0.010, as 
required by ACI 318-08168. Violation of this requirement is reported by the 
software as exceeding maximum allowable reinforcement indicating that the 
option to adjust the factor γf should be turned off by the user at the support where 
the violation occurs. 

It should be noted that the ACI code169 requires either concentration of 
reinforcement over the column by closer spacing, or additional reinforcement, to 
resist the transfer moment within the effective slab width. spSlab satisfies this 
requirement by providing additional reinforcement without concentrating existing 
reinforcement. 

The CSA A23.3 code requires concentrating one-third of the negative 
reinforcement at interior supports in the band region extending 1.5 hs from the 
sides of the columns170. The remaining portion of the negative reinforcement needs 
to be placed in the distributed strip. At exterior supports the total negative 
reinforcement is placed in the band region171. The reinforcement in banded and 
distributed strip is also checked for compliance with the minimum reinforcement 
requirement. 

When computing additional reinforcement for negative and positive unbalanced 
moments over the supports, the contribution of the longitudinal beam cross-section 
can be optionally selected. If selected, this contribution will be considered, only if 
                                                           
167 ACI 318-05, 13.5.3.3; ACI 318-02, 13.5.3.3; ACI 318-99, 13.5.3.3 
168 ACI 318-08, 13.5.3.3 
169 ACI 318-08, 13.5.3.4; ACI 318-05, 13.5.3.4; ACI 318-02, 13.5.3.4; ACI 318-99, 13.5.3.4 
170 CSA A23.3-04, 13.11.2.7; CSA A23.3-94, 13.12.2.1  
171 CSA A23.3-04, 13.10.3; CSA A23.3-94, 13.12.2.2, 13.13.4.2 
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the beam width is at least equal to the width of the effective transfer strip (band). 
For CSA designs this functionality extends also to design of banded reinforcement 
in bb strip. 

Structural Integrity Reinforcement  
Enhancing redundancy and ductility is necessary in the event of damage to a major 
supporting element resulting from an abnormal shock or blast loading event. 

Minor changes in reinforcement detailing typically result in substantial 
enhancement in the overall integrity of a structure by confining the resulting 
damage to a small area and improving the resistance to progressive collapse. 

The ACI code requires all bottom bars in the column strip to extend continuously 
(or with splices) in the entire span and at least two of these bars to pass within the 
column core and to be anchored at exterior supports172. In continuous beams, 
including longitudinal beams in two-way slab systems, spSlab and spBeam design 
reinforcement that satisfies ACI requirements for structural integrity. In perimeter 
(exterior) beams, at least one sixth of the negative tension reinforcement and not 
less that two bars are continuous173. Also, at least one fourth of the positive tension 
reinforcement and not less than two bars are continuous in all beams174. 

For the CSA code, the program performs calculation of the amount of integrity 
reinforcement at slab column connections. The integrity reinforcement is required 
for slabs without beams. Integrity reinforcement is not required if there are beams 
containing shear reinforcement in all spans framing into the column. Otherwise, 
the sum of all bottom reinforcement connecting the slab to the column on all faces 
of the periphery should consist of at least two bars and meet the condition175: 

 
y

se
sb f

V2A ≥∑  Eq. 2-101 

where Vse is the larger of shear force transmitted to column or column capital due 
to specified (unfactored) loads and shear force corresponding to twice the self-
weight of the slab. 

                                                           
172 ACI 318-08, 13.3.8.5; ACI 318-05, 13.3.8.5; ACI 318-02, 13.3.8.5; ACI 318-99, 13.3.8.5 
173 ACI 318-08, 7.13.2.2(a); ACI 318-05, 7.13.2.2(a); ACI 318-02, 7.13.2.2(a); ACI 318-99, 7.13.2.2 
174 ACI 318-08, 7.13.2.2(b) and 7.13.2.4; ACI 318-05, 7.13.2.2(b) and 7.13.2.4; ACI 318-02, 
7.13.2.2(b) and 7.13.2.4; ACI 318-99, 7.13.2.2 and 7.13.2.3 
175 CSA A23.3-04, 13.10.6.1 and 13.10.6.2; CSA A23.3-94, 13.11.5.1 and 13.11.5.2; 
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Corner Reinforcement  
The program performs calculation of the amount of reinforcement in exterior 
corners of slabs with stiff edge beams (α greater than 1.0)176. This reinforcement is 
required within a region equal to 1/5 of the shorter span. The amount of corner 
reinforcement is calculated from the moment per unit width intensity 
corresponding to the maximum positive moment in span. The code allows the 
corner reinforcement to be placed at top and bottom of the slab in bands parallel to 
the sides of the slab edges. 

Deflections  

Instantaneous Deflections  
Instantaneous deflections are obtained directly by the program from elastic 
analysis of the defined system for two load levels. The first corresponds to dead 
load only, while the second corresponds to dead load plus live load on all spans. 
The live load deflection is computed afterwards as the total load deflection minus 
the dead load defection. Depending on the option selected by the user, the program 
will calculate flexural stiffness of the members based on either gross moment of 
inertia or the effective moment of inertia which allows taking cracking into 
account. 

Cracking  
When calculating the deflections for effective (cracked) section properties, the 
frame solution is obtained for two load levels: dead load only and dead load plus 
live load combined. Flexural stiffness is assumed corresponding to the load level. 

A reduction in the flexural stiffness caused by cracking leads to an increase in 
deflections. Several methods of deflection analyses taking cracking into account 
are reviewed in Ref. [18]. The program uses the approach based on the effective 
moment of inertia as permitted by the code.177 

The effective moment of inertia, Ie, developed by Branson (Ref. [13]) and 
incorporated into the code equals: 

                                                           
176 ACI 318-08, 13.3.6; ACI 318-05, 13.3.6; ACI 318-02, 13.3.6; ACI 318-99, 13.3.6; CSA A23.3-04, 
13.12.5; CSA A23.3-94, 13.13.5 
177 ACI 318-08, 9.5.2.3; ACI 318-05, 9.5.2.3; ACI 318-02, 9.5.2.3; ACI 318-99, 9.5.2.3; CSA A23.3-
04, 9.8.2.3; CSA A23.3-94, 9.8.2.3 
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where: 

Ig = moment of inertia of the gross uncracked concrete section, 
Icr = moment of inertia of the cracked transformed concrete 

section178, 
Mcr = cracking moment, 
Mmax = maximum bending moment at the load level for which the 

deflection is computed. 

To calculate Ie for two-way slabs, the values of all terms for the full width of the 
equivalent frame are used in Eq. 2-102. This approach averages the effects of 
cracking in the column and middle strips. 

The value of Ie at midspan for a simple span and at support for a cantilever is 
taken179 to calculate flexural stiffness of a member. For other conditions, an 
averaged effective moment of inertia, Ie,avg is used. For spans with both ends 
continuous, Iframe is given by180 

 ( )e,avg e e,l e,rI 0.70I 0.15 I I+ − −= + + , Eq. 2-103 

where: 

+
eI  = effective moment of inertia for the positive moment region, 
−

1,eI  = effective moment of inertia for the negative moment region at 
the left support, 

−
r,eI  = effective moment of inertia for the negative moment region at 

the right support. 

For spans with one end continuous the value of Iframe is given by181: 

 frame e eI 0.85 I 0.15 I+ −= + , Eq. 2-104 

                                                           
178 See formulas for various cross sections in Table 10-2 in Ref. [14] 
179 ACI 318-08, 9.5.2.4; ACI 318-05, 9.5.2.4; ACI 318-02, 9.5.2.4; ACI 318-99, 9.5.2.4 
180 ACI 435R-95 (Ref. [15]), 2.5.1, Eq. (2.15a); CSA A23.3-04, 9.8.2.4(a); CSA A23.3-94, 9.8.2.4, Eq. 
9.3 
181 ACI 435R-95 (Ref. [15]), 2.5.1, Eq. (2.15b); CSA A23.3-04, 9.8.2.4(b); CSA A23.3-94, 9.8.2.4, Eq. 
9.4 
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where: 

eI
+  = effective moment of inertia for the positive moment region, 

eI
−  = effective moment of inertia for the negative moment region at 

the continuous end. 

Long-Term Deflections  
The program estimates additional long-term deflection resulting from creep and 
shrinkage, Δcs, by multiplying the immediate deflection due to sustained load, Δsust, 
by the factor, λΔ, equal to182 

 
1 50 'Δ

ξ
λ =

+ ρ
, Eq. 2-105 

where: 

ξ  = time dependant factor with the maximum value of 2.0 (the actual 
value is interpolated from the values and the chart given in the 
code183 based on the load duration specified by the user in the 
input) 

ρ’ = ratio of compressive reinforcement at midspan for simple and 
continuous spans and at support for cantilevers. 

Deflection due to the sustained load, Δsust, consists of the deflection induced by the 
dead load (including self weight), Δdead, and the deflection Δls which is induced by 
that portion of the live load which is declared as sustained in the input by the user. 
Thus 

 sust dead lsΔ = Δ + Δ , Eq. 2-106 

and 

 cs sust ΔΔ = Δ λ . Eq. 2-107 

The program calculates incremental deflection which occurs after partitions are 
installed in two ways. In the first approach, it is assumed that the live load has 

                                                           
182 ACI 318-08, 9.5.2.5; ACI 318-05, 9.5.2.5; ACI 318-02, 9.5.2.5; ACI 318-99, 9.5.2.5; CSA A23.3-
04, 9.8.2.5; CSA A23.3-94, 9.8.2.5A23.3 
183 Fig. R9.5.2.5 in ACI 318-08; ACI 318-05; ACI 318-02, and ACI 318-99; Fig. N9.8.2.6 in CSA 
A23.3-04 and CSA A23.3-94 
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been applied before installing the partitions and the incremental deflection 
equals184 

 cs lu cs live ls( )+Δ = Δ + Δ − Δ , Eq. 2-108 

In the second approach, the assumption is that the full live load, including the 
sustained portion of the live load, has been applied after the partitions are installed 
which results in the incremental deflection equal to185 

 cs l cs live+Δ = Δ + Δ , Eq. 2-109 

The total long-term deflection Δtotal is also calculated as186 

 total sust l ls(1 ) ( )ΔΔ = Δ + λ + Δ − Δ , Eq. 2-110 

Deflections of two-ways systems  
Calculation of deflections of reinforced concrete two-way slabs is complicated by 
a large number of significant parameters such as: the aspect ratio of the panels, the 
vertical and torsional deflection of supporting beams, the stiffening effect of drop 
panels and column capitals, cracking, and the time-dependent nature of the 
material response. Based on studies (Ref. [16]–[18]), an approximate method 
consistent with the equivalent frame method was developed (Ref. [19]) to estimate 
the column and middle strip deflections. 

Calculation of the midspan deflection of the column strip or the middle strip is 
based on the M/EI ratio of the strip to that of the full-width panel: 

 strip c g,frame
strip frame

frame c g,strip

M E I
M E I

Δ = Δ , Eq. 2-111 

where frameΔ  is taken from the equivalent frame analysis assuming gross section 
(un-cracked) or effective (cracked) section properties. 

The ratio (Mstrip/Mframe) can be considered as a lateral distribution factor, LDF. For 
ACI and CSA A23.3-94 codes the lateral distribution factor, LDF, at an exterior 
negative moment region is:  

                                                           
184 CSA A23.3-04 N9.8.2.5, CSA A23.3-94 N9.8.2.5 
185 See Example 10.1 in Ref. [14]  
186 CSA A23.3-04 N9.8.2.5; CSA A23.3-94 N9.8.2.5 
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The LDF at an interior negative moment region is: 

 2 2
neg,int f1

1 1
LDF 75 30 l

⎛ ⎞ ⎛ ⎞
= − α −⎜ ⎟ ⎜ ⎟

⎝ ⎠ ⎝ ⎠

l l
l l

. Eq. 2-113 

The LDF at a positive moment region is: 

 2 2
pos f1

1 1
LDF 60 30 1.5

⎛ ⎞⎛ ⎞
= + α −⎜ ⎟⎜ ⎟

⎝ ⎠⎝ ⎠

l l
l l

, Eq. 2-114 

where: 

αf1 = the ratio of flexure stiffness of a beam section to the flexural 
stiffness of a width of slab bounded laterally by centerlines of 
adjacent panels on either side of the beam, 

βt = ratio of torsional stiffness of an edge beam section to the flexural 
stiffness of a width of slab equal to the span length of the beam, 
center-to-center of the supports (see Eq. 2-30). 

For CSA A23.3-04 code lateral distribution factors are based on tabulated values 
presented earlier in the chapter. 

When αf1l2/l1 is greater than 1.0, αf1l2/l1 will be set equal to 1.0. 

The column and middle strip LDF’s can be computed by: 

 
2

2
LDFLDF

LDF
LDF

r.negl,neg
pos

c

+
+

= , Eq. 2-115 

 cm LDF100LDF −= , Eq. 2-116 

where: 

LDFneg,l = LDF for the negative moment region at the left end of the span 
LDFneg,r = LDF for the negative moment region at the right end of the span 

The deflections should be used in conjunction with the deflections obtained from 
an analysis in the transverse direction. For square panels (l1 = l2), the midpanel 
deflection is obtained from the following equation as shown in Figure 2-22: 
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 cy mx cx myΔ = Δ + Δ = Δ + Δ . Eq. 2-117 

For rectangular panels, (l1 ≠ l2), the mid panel deflection is obtained from: 

 
( ) ( )cy mx my cx

2

Δ + Δ + Δ + Δ
Δ = . Eq. 2-118 
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Figure 2-22 Deflection computation for a square panel 

Material Quantities  
The program computes concrete and reinforcing steel quantities. The quantity of 
concrete is based on an average of the slab, drop, and beam sizes. The total 
quantity of reinforcing steel computed by the program corresponds to the actual 
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bar sizes and lengths required by design. No allowance is made for bar hooks, 
anchorage embedment, and so forth. It should be noted that the quantity of 
reinforcement printed by the program pertains to bending in one direction only. In 
practice, the total amount of reinforcement for the structure should also include the 
quantities obtained for the appropriate transverse equivalent frames.  
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Chapter 3 – spSlab/spBeam Interface 
spSlab/spBeam Interface 

Main Window  

 
The main screen will appear after the spSlab is started as shown above. The main 
screen consists of a title bar, menu line, tool bar, five view windows and status bar. 
The program name and current data file name is shown in the title bar. All the 
menu commands can be accessed from the menu line and some frequently used 
commands also can be accessed from the buttons in the tool bar. The four view 
windows show the geometry of a floor system and the loads on it. Plan view, side 
view, elevated view and isometric view are available. The status bar shows the 
current state of the program. 
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Title Bar  

 
The title bar displays the program name, and following the hyphen, displays the 
name of the current data file you are using. If the data you are currently working 
on has not been saved into a file, the word spSlab1 (spBeam1 for spBeam) is 
displayed in the title bar. If you start a new data file by clicking the NEW button on 
the most left of the tool bar, the next data file is named as spSlab2 (spBeam2 for 
spBeam), and so on. 

Menu Bar  

 
Located directly below the title bar is the menu line. spSlab commands are listed in 
the pop-up menus located in the menu line. These menu commands allow you to 
perform functions that create, view, and ultimately design the floor system. 

In the spSlab program there are seven main pull-down menus: File, Input, Solve, 
View, Options, Windows, and Help. To access a menu item using the mouse, 
place the arrow cursor on the menu item you want and click the left mouse button. 
Each menu item can also be selected with the keyboard keys by simultaneously 
pressing the ALT key and the underlined letter of the menu you want to open. For 
example, to open the File menu, press ALT + F. To close a menu without selecting 
a command, move the cursor to any blank area on the screen and click the left 
mouse button. Press ESC key to close a menu using the keyboard keys. 

To select a command from a menu with the mouse, place the arrow on the item 
you want, and click the left mouse button. In some cases, you will be told to 
double click on a selection, that is, press the mouse button twice, quickly. Anytime 
you have to wait, for example, when loading the program or designing the system, 
the mouse cursor becomes an hourglass cursor. It will return to its original state 
when the task is completed. 

To select a command from a menu using the keyboard, use the down arrow key to 
highlight your choice and press ENTER key or press the keyboard key of the 
command’s underlined letter. The space bar is also equivalent to pressing the left 
mouse button. 

Special instructions for inputting with the keyboard keys are given wherever 
necessary. 
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Tool Bar  

 
Located directly below the menu line is the tool bar. Some frequently used buttons 
can be found in the tool bar. A description of the corresponding button is shown in 
the status bar (on the bottom of the window) when the mouse cursor is moving 
over this button. In addition to the description in the status bar, a brief tip is shown 
in a light yellow colored pop-up window close to the corresponding button when a 
mouse cursor is hanging over the button for a short period of time. Exactly the 
same functions or features can be accessed from either the menu items or tool bar 
buttons.  

The tool bar can be changed from docking status to floating status by single 
clicking the left mouse button on the tool bar and dragging it away from the 
docking position to any other positions on the screen. A floating tool bar can be 
resized by clicking and dragging its borders.  

To restore the tool bar to the docking status, single click the left mouse button on 
the tool bar and drag it to the location that is directly below the menu line and 
release the mouse button. 

View Windows  
A total of 10 view windows can be used to show Plan, Elevated, Side and 
Isometric views of the geometry, as well as Loads, Shear and Moment, Moment 
Capacity, Shear Capacity, Deflection, and Reinforcement. 

Status Bar  
Status bar is always on the bottom of the main window. The status bar shows the 
current status of the data file and the coordinate values of the mouse cursor 
position. Depending on the active view window, different information of the 
mouse cursor will appear in the status bar. 

File Menu  
The File menu is used for saving or 
retrieving data, printing, and exiting. The 
File menu contains the following commands: 
New, Open, Close, Save, Save As, Print 
Preview, Print Results, Print Setup, 
Recent Files and Exit.  
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New  
The New command clears any data 
input and returns to the default values. 
Thus, you are able to create a new data 
file. However, before you can begin a 
new data file, spSlab will ask whether 
you want to save the current data. Answering YES will save the old data and begin 
a new data file. Answering NO will discard any changes to the data and begin a 
new data file. Answering CANCEL will return you to spSlab so that you can 
continue to work with the current data.  

Open  
The Open command allows you to load an existing spSlab data file. The dialog 
box that appears shows you a listing of all the files with the extension contained in 
the default data directory or in the current directory (if a default data directory was 
not specified). This box also enables you to change the current drive and directory. 
If you are currently working on a data file and select the Open command, spSlab 
will ask whether you want to save the current data. Answering YES will save the 
old data and display the Open dialog box. Answering NO will discard any changes 
to the data and display the Open dialog box. Answering CANCEL will return you to 
spSlab so that you can continue to work with the current data.  

Close  
The Close command allows you to close the current spSlab data file. If you are 
currently working on a data file and select the Open command, spSlab will ask 
whether you want to save the current data. Answering YES will save the old data 
and display the Open dialog box. Answering NO will discard any changes to the 
data and display the Open dialog box. Answering CANCEL will return you to 
spSlab so that you can continue to work with the current data.  

Save  
The Save command saves the changes you’ve made to the current data under that 
same filename. The new data overwrites the old data, and you cannot retrieve the 
old data. It is a good practice to periodically save while inputting data. If a data file 
is untitled, the Save As dialog box will appear. 
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Save As  
The Save As command allows you to 
name or rename a data file. Use Save As 
when you want to save both the original 
data and any changes you’ve currently 
made to the data. The original data 
remains under the old filename. If a file 
of the same name exists, the program 
will ask if you would like to overwrite 
the file. 

Print Preview  
The Print Preview command allows you 
to preview and print the current view 
window (floor system geometry in the 
plan, elevated, and isometric views, 
prints the shear and moment diagrams, 
and prints the deflected shapes). To 
obtain a view window you must first 
perform the design, then select what you 
want to view from the View menu. You 
may have more than one view windows 
opened. The current view window is the 
one activated and on top of the others on 
your screen. Selecting this command 
closes the spSlab main window and 
opens the print preview window as 
shown below. On the print preview 
window, press the ZOOM IN or ZOOM 
OUT buttons or simply click the left 
mouse button on the preview window to 
magnify or reduce the size of the 
preview paper. Press the NEXT PAGE button if more than one page needs to be 
printed. Press the PRINT button to print the view. The printer could be a local 
printer, which is connected to your computer directly, or a network printer. Press 
the CLOSE button to close the preview window and go back to spSlab.  
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Print Results  
The Print Results command allows you to send the analysis and/or design results 
to the printer. Selecting this command will show the Results Report Setup dialog 
box. By selecting items in the Selection group prior to performing the print, you 
can print selected sections of the data instead of the entire analysis. Option 
Include Non-redistributed Internal Forces is available only for beams/one-way 
slab systems if moment redistribution is engaged. It allows including in the report 
non-redistributed internal forces in addition to redistributed values which are 
printed by default. 

   

Printer Setup  
The Printer Setup command brings up the Windows printer setup box which 
allows the user to select the printer to send the output to and to change the settings 
of the printer. 

Recent Files  
This list contains the data files that are used recently and can be accessed quickly 
from the menu by a single click. The most recently used one is on the top of the 
list. Up to four files can be listed.  

Exit  
The Exit command ends the spSlab session and returns you to Windows. If you 
have made any changes to your data and have not saved them, spSlab will first ask 
whether you want to save or abandon any changes you’ve made before you exit.  

Input Menu  
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The Input menu allows you to enter and modify data for the 
floor system. The Input menu contains the following 
commands: Data Input Wizard, General Information, 
Material Properties, Spans, Supports, Reinforcement 
Criteria, Reinforcing Bars, Load Cases, Load 
Combinations, Span Loads, Support Loads and 
Displacements, and Lateral Effects.  

Data Input Wizard   
The Data Input Wizard command is designed to make the inputting process 
easier. By selecting Data Input Wizard, a logical sequence of dialog boxes will 
automatically be displayed allowing you to enter data for your floor system.  

General Information  
The General Information consists of three tabs: General Information, Solve 
Options, and Span Control.  

The General Information tab will allow 
you to enter the project name, frame name, 
engineer name, design code, reinforcement 
database, run mode, and number of supports. 
You must always use the General 
Information tab before doing any further 
inputting since it affects the availability of 
other commands in this menu. 

The Solve Options command allows you to 
specify design options and deflection 
calculations options. Please note that design 
options for two-way systems are different 
from beams/one-way slab systems. To take 
effect, this command must be used prior to 
Execute. 
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The Span Control tab provides commands for span manipulation such as inserting 
new spans, copying spans, moving spans, and deleting spans. 

Material Properties  
The Material Properties command enables you to input material property 
requirements for concrete and reinforcement. Concrete density, compressive 
strength, Young’s modulus, rapture modulus, as well as the longitudinal and shear 
reinforcement yield levels, are required. 
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Spans  
The Spans menu allows you to input geometric dimensions for slabs, longitudinal 
beams, and ribs. 

 

Supports  
The Supports menu allows you to input geometric dimensions for columns, drop 
panels, column capitals, and transverse beams. The percentage of the actual 
column joint stiffness to be used in the analysis to determine the joint moments 
and shears can be modified on the Columns tab. The Drop Panels tab is available 
if two-way system is selected and the Moment Redistribution tab is available 
only for beams/one-way slab systems if moment redistribution is engaged in the 
General Information window. 
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Reinforcement Criteria  
The Reinforcement Criteria menu allows you to specify the distance to 
reinforcement, reinforcement bar sizes, bar spacing, and reinforcing ratio for both 
slabs and beams. For beams it also allows you to specify criteria for stirrups, side 
cover and distance between layers of reinforcement if more than one layer is 
needed. 
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Reinforcement Bars  
For two-way floor systems, the Reinforcement Bars menu allows you to specify 
the longitudinal reinforcement arrangement information for column strip, middle 
strip, and beam, as well as shear reinforcing information for beams.  

 
For beams/one-way slab systems, flexural bars, stirrups, and torsional longitudinal 
reinforcement can be specified. The Reinforcement Bars menu is disabled if Run 
Mode of Design is selected from the General Information dialog box. Select the 
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Run Mode of Investigation from the General Information dialog box to enable 
it. 

 

Load Cases  
The Load Cases menu allows you to specify load cases. Up to six load cases can 
be added and only one live load case is allowed. 

 

Load Combinations  
The Load Combinations menu allows you to specify load combinations as shown 
in Figure 3-34. Up to twenty load combinations can be added. 
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Span Loads  
The Span Loads menu allows you to enter superimposed area loads, line loads, 
point loads, and moments.  

 

Support Loads and Displacements  
The Support Loads and Displacements menu allows you to enter prescribed 
displacements and rotations of supports as well as concentrated loads applied 
directly at support locations. 
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Lateral Effects  
The Lateral Effects menu allows you to enter the lateral loads as moments acting 
on the two ends of each span.  

 

Solve Menu  
The Solve menu contains commands that enable you to perform the 
analysis and/or design of the floor system and view the results. The 
Solve menu contains the following commands: Execute and Report.  
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Execute  
The Execute command executes the solver 
portion of spSlab. If some data is still required 
when this command is executed, spSlab will 
respond with an "Invalid Model!" error 
message. The missing data must be completed 
before execution. A status window pops up 
and shows the status during 
the execution. If the execution 
is not successful, an error 
message will be shown and 
the execution is terminated.  

Results Report  
The Results Report command brings up a window with text results of the analysis 
and/or design as shown below. From this window, results can be copied to 
clipboard or printed using Copy and Print command buttons. 

 
To change the content of report, select items [1] through [8] from the combo box. 
Item Customize brings up the Results Report Setup window described earlier 
(Print Results, page 3-6). It will allow you to generate a report with multiple item 
selected. 
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View Menu  
The View menu commands enable you to modify 
the floor system’s appearance on the screen to suit 
your viewing needs and enable you to view the 
result diagrams. The View menu contains the 
following commands: Zoom, Pan, Restore, Plan 
View, Elevated View, Side View, Isometric 
View, Change View Angles, View Options, 
Loads, Internal Forces, Moment Capacity, 
Shear Capacity, Reinforcement, Deflection and 
Duplicate Active View.  

Zoom  
The Zoom menu contains a cascade sub-menu, which enables you to zoom in and 
out on any portion of your floor system. Select Window from the sub-menu and 
use the mouse to specify a zooming region; the program will enlarge the portion 
you select. Select the In(2x) or Out(0.5x) to enlarge or reduce the model by two 
times, respectively. 

Pan  
The Pan command allows you to move your model on the plane of the screen. 
You may move the model in any direction. The mouse cursor is changed to a palm 
shape once the Pan command is selected. Press and hold the left mouse button on 
the view window and drag to the new location. After the mouse button is released, 
the model is moved in the same distance and direction as the mouse cursor from 
the original position. 

Restore  
The Restore command will redraw the floor system in full size. If you have altered 
your screen view using the Zoom command, select Restore to restore the figure’s 
original proportions. 

Plan View  
Select Plan View command to show the plan view window. 

Elevated View  
Select Elevated View command to show the elevated view window. 
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Side View  
Select Side View command to show the side view window. 

Isometric View  
Select Isometric View command to show the isometric view window. 

Change View Angles  
The Change View Angle command allows you to modify the angle at which the 
floor system is displayed in the Isometric View. The default angles are set at -45 
about the X axis and 45 about the Z axis. A more convenient way to change the 
view angle is to use the keyboard short cut CTRL + ARROW KEYS. To rotate 
around Z axis, press CTRL +  or CTRL + . To rotate around X axis, press 
CTRL +  or CTRL + .  

View Options  
The View Options command allows you to view selected 
members of the floor system in the view windows. Clicking the 
left mouse button on the check boxes next to the items in the 
dialog box, or tabbing to the member type and pressing the space 
bar will toggle the selection. spSlab will draw any members that 
contain a  in the box.  

Loads  
Select Loads command to show the load view window. 

Internal Forces  
Select Internal Forces command to show the shear, 
moment, and torsion (for beams/one-way slab systems 
only) diagram view window. The analysis and/or design 
must be performed before selecting this command. 
Otherwise “Problem Not Solved” message will be 
shown instead.  

Moment Capacity  
Select Moment Capacity command to show the moment capacity diagram view 
window. The analysis and/or design must be performed before selecting this 
command. Otherwise “Problem Not Solved” will be shown instead. 
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Shear Capacity  
Select Shear Capacity command to show the shear capacity diagram view 
window. The analysis and/or design must be performed before selecting this 
command. Otherwise “Problem Not Solved” will be shown instead. 

Reinforcement  
Select Reinforcement command to show the reinforcement view window. The 
analysis and/or design must be performed before selecting this command. 
Otherwise “Problem Not Solved” will be shown instead. 

Deflection  
Select Deflection command to show the deflection diagram view window. The 
analysis and/or design must be performed before selecting this command. 
Otherwise “Problem Not Solved” will be shown instead. 

Duplicate Active View  
Select Duplicate Active View to make a copy of the current active view window. 

Options Menu  
The Options menu allows you to change the startup 
options of the spSlab program to suit your needs. The 
Options menu contains the following commands: Colors, 
Startup Defaults, Rebar Database, Toolbar, and Status 
Bar.  

Colors  
The Colors command allows you to 
change the background color, 
member color, load color, text 
color, diagram color, etc. You may 
save the new colors as default 
setting, which will be used when 
spSlab is executed in the future.  

Fonts  
The Fonts command allows you to 
select properties of the font that will 
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be used in the graphical output window and printout, Graphical Output, as well 
as in the text result window and output, Text Output. Please note that for the Text 
Output only nonproportional (fixed width) fonts can be used. 
 

  

Startup Defaults  
 The Startup Defaults command allows you 
to enter engineer name, change the default 
design code, reinforcement database, and the 
data directory which is where the program 
looks for data when it is executed.  

Note: Default values of various design 
parameters (e.g. minimum and maximum bar 
spacing and reinforcement ratio, Young modulus, rupture modulus, etc.) assumed 
by the program depend on the design code selected in this dialog box. Subsequent 
change of the design code in the General 
Information dialog box does not reset values of 
these parameters to the default values 
corresponding to the newly selected code. It may, 
however, convert these values to different units if 
the code change is accompanied by a change of 
units.  

Reinforcement Database  
The Rebar Database command allows you to 
view the pre-defined reinforcement information 
and define your own database. The user-defined 



 

3-20  spSlab/spBeam Interface 

database can be selected from the General Information dialog box.  

Toolbar  
Check the Toolbar command with a  sign to show the tool bar. Select the 
command again to clear the  sign to hide the tool bar. The tool bar is shown by 
default. 

Status Bar  
Check the Status Bar command with a  sign to show the status bar. Select the 
command again to clear the  sign to hide the status bar. The status bar is shown 
by default. 

Window Menu  
This menu enables you to arrange view windows shown on screen. The Window 
menu contains the following commands: Cascade, Tile Horizontal and Tile 
Vertical.  

Cascade  
The Cascade command displays all the open windows in the same size, arranging 
them on top of each other so that the title bar of each is visible. The current active 
view widow will be on the top after the execution of the Cascade command. 

 

Tile Horizontal  
The Tile Horizontal command arranges all open windows horizontally so that no 
window overlaps another. The current active view widow will be on the most left 
or on the upper-left corner of the screen after the execution of the Tile Horizontal 
command. 

Tile Vertical  
The Tile Vertical command arranges all open windows vertically so that no 
window overlaps another. The current active view widow will be on the most left 
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or on the upper-left corner of the screen after the execution of the Tile Vertical 
command. 

Window List  
The remaining menu items are in a list of the windows that are available for 
viewing. Selecting any window from this menu will bring up or restore the 
window to its previous size and position if it was minimized. 

Help Menu  
The Help menu includes commands that enable you to obtain 
online help for the program and show the copyright and registration 
information about your software. The Help menu contains three 
commands: Help Topics, Context Help and About spSlab.  

Help Topics  
The Help Topics command shows the Windows Help window with a table of 
contents. Select a topic of your interest to display information about that item. 
More information on the help system can be obtained from the Microsoft 
Windows manual. 

Context Help  
The Context Help command enters the program into the context-sensitive help 
mode which is indicated by a question mark  attached to the mouse cursor. In 
this mode, the user can click the element for which information is needed and the 
program will display the help topic associated with this element. More information 
on the help system can be obtained from the Microsoft Windows manual. 

spSlab/spBeam Manual  
The spSlab/spBeam Manual command opens spSlab/spBeam Manual in the 
default PDF viewer. 

Check for Updates  
The Check for Updates command checks if a newer version of the program is 
available. Internet connection is required. 
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About spSlab/spBeam  
The About spSlab command shows the version number of the program, the 
licensing information, and the copyright information. In the case of a trial license, 
the expiration date is given as well as the locking code which is needed to obtain 
a standalone license. 
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Control Menu  
All the view windows have one pull-down menu 
located in the upper left hand corner of the open 
window. This is the Control menu. To access the 
Control menu, press CTRL + F6 to cycle through 
the windows and press ALT + – (hyphen), to 
open the Control menu of the desired window. 
The following is a list and a brief description of 
the commands in this menu. 

Restore  
The Restore command will restore a window or an icon to its previous size and 
position. This menu item is available when the window is iconized or maximized. 

Move  
The Move command moves the window to a new location. Select Move and use 
the ARROW KEYS to move the window in the desired direction and select 
ENTER to accept the new location. 

Size  
The Size command resizes a window. Select Size and use the ARROW KEYS to 
move the border of the window in the desired direction and select ENTER to 
accept the new size. 

Minimize  
The Minimize command reduces a window to an icon and positions it at the 
bottom of the screen. 

Maximize  
The Maximize command enlarges a window to fit your entire screen. 

Close  
The Close command is used to close a window and return it to an icon and the 
bottom of the screen. 

Next  
The Next command switches among open windows and icons. 
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Program Toolbar  

 
  Close the current data file if there is one and start a new data 

file. The equivalent menu command is File/New. 
  Open an existing data file on hard disk. The equivalent menu 

command is File/Open. 
  Save the current data file to hard disk. The equivalent menu 

command is File/Save. If you have not changed the default file 
name (spSlab1, spSlab2, etc.), the equivalent menu command is 
File/Save As. 

  Print view window. The equivalent menu command is File/Print 
View. 

  Print results. The equivalent menu command is File/Print 
Results. 

  Copy Bitmap to clipboard. The bitmap then can be pasted to a 
word processing or presentation software such as Microsoft 
Word or Microsoft PowerPoint. 

  Copy Metafile to clipboard. The metafile then can be pasted to a 
word processing or presentation software such as Microsoft 
Word or Microsoft PowerPoint. 

  Open the Data Input Wizard. The Data Input Wizard will guide 
you to enter the necessary input to your project. The equivalent 
menu command is Input/Data Input Wizard.  

  Enter general information. The equivalent menu command is 
Input/ General Information.  

  Enter material properties. The equivalent menu command is 
Input/Material Properties.  

  Enter span geometry information for slabs, longitudinal beams, 
and ribs. The equivalent menu command is Input/Spans.  

  Enter support information for columns, drop panels, column 
capitals, and transverse beams. The equivalent menu command 
is Input/Support.  

  Enter reinforcement criteria for slab and ribs, and beams. The 
equivalent menu command is Input/Reinforcement Criteria. 

  Enter reinforcing bar information for column strips, middle 
strips, beams, and beam stirrups. This button is disabled if 
Design run mode is selected from the General Information 
dialog box. The equivalent menu command is Input/
Reinforcing Bars. 
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  Enter load cases. The equivalent menu command is Input/Load 
Cases. 

  Enter load combinations. The equivalent menu command is 
Input/Load Combinations.  

  Enter span loads. The equivalent menu command is Input/Span 
Loads. 

  Enter support loads and displacements. The equivalent menu 
command is Input/Support Loads and Displacements. 

  Enter lateral effects. The equivalent menu command is 
Input/Lateral Effects. 

  View plan geometry. The equivalent menu command is 
View/Plan View. 

  View elevated geometry. The equivalent menu command is 
View/Elevated View.  

  View side geometry. The equivalent menu command is 
View/Side View.  

  View isometric geometry. The equivalent menu command is 
View/Isometric View.  

  Execute the analysis and/or design. The equivalent menu 
command is Solve/Execute.  

  View results. The equivalent menu command is Solve/Report.  
  View loads. The equivalent menu command is View/Loads.  
  View internal forces within the whole system or a single span. 

The equivalent menu command is View/Internal Forces.  
  View moment capacity of the whole geometry or a single span. 

The equivalent menu command is View/Moment Capacity.  
  View shear capacity of the whole geometry or a single span. The 

equivalent menu command is View/Shear Capacity. 
  View deflection of the whole geometry or a single span. The 

equivalent menu command is View/Deflection. 
  View flexure reinforcement for beam strip, middle strips, and 

column strips. View shear reinforcement for beam strips. The 
equivalent menu command is View/Reinforcement.  

  Zoom in view window to magnify the system. The equivalent 
menu command is View/Zoom/In(2x).  

  Zoom out view window to reduce the system. The equivalent 
menu command is View/Zoom/Out(0.5x).  

  Zoom any part of a view window. The equivalent menu 
command is View/Zoom/Window.  
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  Move the model in the screen plane. The equivalent menu 
command is View/Pan.  

  Restore a view window. The equivalent menu command is 
View/Redraw.  

 



 

Chapter 4 – Operating spSlab/spBeam 
Operating spSlab/spBeam 

Working with Data Files (menu File)   

Creating a New Data File  
When you first load spSlab you will have a new file ready for input. The data will 
not have a filename associated with it, therefore, "spSlab1" will appear in the title 
bar. If a new data file is created after the "spSlab1", the new data file will be 
named as "spSlab2", and so on. 

To start a new data file: 

1. If you are already in the program and in an existing file, select NEW button  
or New menu command to clear your screen and return you to the default 
settings. If existing data has been changed prior to executing the New 
command, spSlab will ask if you would like to save the data. 

2. After New is selected, Auto Input command in the Input menu may be used. 
This command guides you through the inputting process by automatically 
displaying all the dialog boxes necessary to design your floor system. You 
may cancel the auto input mode by selecting CANCEL button from any dialog 
box. 

3. After you enter data through the Input menu, use the Save As command to 
give the file a name. 

Opening Existing Data File  
spSlab allows you to open data files that were saved at an earlier time including 
files from pcaSlab v1.5x/2.0x/2.5x or pcaBeam v1.5x/2.0x/2.5x. For ADOSS data 
files, see the next section. 

To open an existing data file: 

1. Select Open command from the File menu or click the OPEN button  to 
bring in an existing spSlab data file. The dialog box of Figure 4-1 will be 
displayed. All the files with an .slb extension contained in the current drive 
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and directory will be displayed in the list box. This dialog box also enables 
you to change the current drive and directory. 

 
Figure 4-1 Open dialog box 

2. Type in the name of the file you want to open. You may also select a file from 
the provided list with the mouse or using the keyboard by tabbing to the list 
and using the up and down arrow keys. 

3. Press OPEN to exit the dialog box and allow spSlab to read the data. You may 
combine steps 2 and 3 of this procedure by double clicking the left mouse 
button over the desired file from the provided list. 

Importing ADOSS and PCA-Beam Data File   
spSlab and spBeam allow you to open ADOSS v6.0x/7.0x and PCA-Beam v1.0x 
data files that were saved at an earlier time. 

To open an existing ADOSS or PCA-Beam data file: 

1. Select Open command from the File menu or click the OPEN button . The 
dialog box of Figure 4-2 will be displayed. Select the type of the file you want 
to open and all files of the selected type contained in the current drive and 
directory will be displayed in the list box. This dialog box also enables you to 
change the current drive and directory. 
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 Figure 4-2 Importing ADOSS or PCA-Beam data file dialog box 

2. Type in the name of the file you want to open. You may also select a file from 
the provided list with the mouse or using the keyboard by tabbing to the list 
and using the up and down arrow keys. 

3. Press OPEN to exit the dialog box and allow spSlab to read the data. You may 
combine steps 2 and 3 of this procedure by double clicking the left mouse 
button over the desired file from the provided list. 

Note: The extension name of an ADOSS v6.0x/7.0x file is .ADS and the extension 
name of a PCA-Beam v1.01 file is .BMS. Both pcaSlab and pcaBeam v1.5x use 
files with the .SLB extension. 

Saving Data File  
To save your data with the same filename: 

1. Select the Save command from the File menu or simply click the SAVE button 
. If the data has not been modified since the last save or Save As command 

was executed, this option will not be available. The file will be updated and 
the Save command and button will be shaded gray. 

To give your data a new filename: 

1. If you have not saved your data yet, select the Save or Save As command 
from the File menu. Either command will have the same effect. If you would 
like to save a data file that currently has a filename with a new filename, 
select the Save As command. The dialog box of Figure 4-3 will appear. When 
no filename has been given to the current data, the default filename is 
"spSlab1.slb", and it is highlighted in the edit box. 
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Figure 4-3 Save As dialog box 

2. Type a new name to overwrite the current name. 
3. Press SAVE to exit the dialog box and save the data into the filename 

specified. 

Most Recently Used Files (MRU)   

 
 Figure 4-4 Most Recently Used File List (MRU) 

The Most Recently Used Files (MRU) list shows the four data files that were 
opened most recently. Selecting a data file from this list makes it easier and faster 
to open the file. The list is empty when the program is executed for the first time. 

Specifying Model Data (menu Input)   

Data Input Wizard  
The Data Input Wizard is designed to make the inputting process easier. By 
selecting the Data Input Wizard from Input menu or selecting  from the tool 
bar, a logical sequence of dialog boxes will automatically be displayed allowing 
you to enter data for your floor system. 

MRU{
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Defining General Information  
The General Information command allows you to enter labels, design code, 
reinforcement database, run mode, and the frame information needed by spSlab to 
proceed with the input process. You must choose this command before doing any 
further inputting since this command affects the availability of the commands in 
the Input menu. 

To enter general information: 

1. Select the General Information command from the Input menu or click the 
 button from the tool bar. The dialog box of Figure 4-5 will appear. 

2. Enter the project name, frame name, and engineer name in the Label frame 
box. 

3. Select the building standard you want your floor system to be designed to 
(ACI 318-08, ACI 318M-08, ACI 318-05, ACI 318M-05, ACI 318-02, 
ACI 318M-02, ACI 318-99, ACI 318M-99, CSA A23.3-04, CSA A23.3-04E, 
CSA A23.3-94, CSA A23.3-94E) from the Option frame box. 

a)  b)  

Figure 4-5 General Information dialog box (a) two-way system (b) beam 
and one-way system 

4. Select the DESIGN or INVESTIGATION from the RUN MODE frame box. 
5. In the FRAME box, enter the Number of supports of the frame. The default 

number of supports is 2. The minimum and maximum number of spans is 1 
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and 20 spans, respectively. Therefore the minimum number of supports is 2 
and the maximum number of supports is 21. 

6. Check the LEFT CANTILEVER and/or RIGHT CANTILEVER check boxes if left 
cantilever and/or right cantilever exist in the frame respectively. 

7. In the FLOOR SYSTEM frame box, select TWO-WAY or BEAMS/ONE-WAY slab 
option. 

8. Select NONE, LONGITUDINAL, or TRANSVERSE in SLAB BAND box if a two-
way floor system is selected for the CSA A23.3-94 design code. 

9. Check the DISTANCE LOCATION AS RATIO OF SPAN if the locations of loads 
need to be entered as a ratio of the length of a span. 

10. Press OK button to exit the dialog box and allow spSlab to use the new data. If 
using the Auto Input, click the NEXT button to the next dialog box. 

Defining Solve Option  
The Solve Options command allows you to select options and specify parameters 
that affect the analysis and design results. Please be advised that changing these 
settings involves engineering judgment and it has to be done cautiously. To take 
effect, this command must be used prior to the Execute command. The set of 
parameters is different for two-way and one-way systems. 

Two-way systems  
To specify solve options for two-way systems: 

1. Enter the live load pattern ratio. 
2. Check COMPRESSION REINFORCEMENT checkbox if it is to be considered 

when needed. 
3. Check USER SLAB STRIP WIDTH to enable manual input of column strip width. 
4. Check USER DISTRIBUTION FACTORS to enable manual input of moment 

distribution factors. 
5. Check DECREMENTAL REINFORCEMENT DESIGN to use alternative 

reinforcement design algorithm. 
6. Check COMBINED M-V-T REINF. DESIGN to proportion longitudinal 

reinforcement for combined action of flexure, shear, and torsion. This option 
is available only when CSA A23.3-04 is selected. 

7. Check ONE-WAY SHEAR IN DROP PANELS to include drop panel cross-section 
in slab one-way shear capacity calculations in support locations. 
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8. Check DISTRIBUTE SHEAR TO SLAB STRIPS to distribute slab one-way shear 
between column and middle strips in proportion to moment distribution 
factors. 

9. Check BEAM T-SECTION DESIGN to include portions of slab as flanges in 
beam cross-section for reinforcement design. 

10. Check LONG. BM. SUPT. DESIGN to include cross-section of longitudinal beam 
in reinforcement design for unbalanced moments over supports. This feature 
can be useful for slabs having wide longitudinal beams. When used together 
with USER DISTRIBUTION FACTORS, it can produce solutions consistent with 
the solutions for models with longitudinal slab bands for CSA A23.3-04 code. 

11. Check TRANS. BM. SUPT. DESIGN to include cross-section of transverse beam 
in reinforcement design for negative moments and unbalanced moments over 
supports. This feature is useful for slabs having wide transverse beams. When 
used together with USER DISTRIBUTION FACTORS, it can produce solutions 
consistent with the solutions for systems with transverse slab bands for CSA 
A23.3-04 code. 

12. Enter the multiplier that defines the distance between a column face and a free 
edge of a slab, within which a segment of punching shear critical section is to 
be ignored. 

13. Choose if GROSS (UNCRACKED) or EFFECTIVE (CRACKED) sections are to be 
considered in the deflection calculations. 

14. Choose if in the case of a section with flanges in the negative moment region, 
only the web (RECTANGULAR SECTION) or the whole section (T-SECTION) is 
to be used to calculate the gross moment of inertia (Ig) and the cracking 
moment. 

15. Check CALCULATE LONG-TERM DEFLECTIONS checkbox if you want the 
program to calculate long-term deflections. Provide the duration of load in 
months and the percentage of the live load which is considered as sustained 
load. 
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a)

 

b)

  
Figure 4-6 Solve Options (a) two-way system (b) beam and one-way 

system 

One way/beam systems  
To specify solve options for beams/one-way slab systems: 

1. Enter the live load pattern ratio. The default value for beams/one-way slab 
systems is 100%. 

2. Check COMPRESSION REINFORCEMENT checkbox if it is to be considered 
when needed. 

3. Check DECREMENTAL REINFORCEMENT DESIGN to use alternative 
reinforcement design algorithm. 

4. Check COMBINED M-V-T REINF. DESIGN to proportion longitudinal 
reinforcement for combined action of flexure, shear, and torsion. This option 
is available only when CSA A23.3-04 is selected. 

5. Check EFFECTIVE FLANGE WIDTH if instead of the full flange width only the 
effective flange width is to be considered in the flexural design. 

6. Check RIGID BEAM-COLUMN JOINT to consider beam-column joint as rigid. 
7. Check TORSION ANALYSIS AND DESIGN if they are to be included in the 

solution. This option has to be checked for the TORSION TYPE and STIRRUPS IN 
FLANGES options to be enabled. Also torsional loads will only be available in 
the TYPE combo box of the SPAN LOADS dialog box if this option is checked. 
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8. Check MOMENT REDISTRIBUTION checkbox if it is to be considered in the 
analysis. This option has to be checked for the MOMENT REDISTRIBUTION tab 
to be available in the SUPPORT DATA dialog box. 

9. If TORSION ANALYSIS AND DESIGN is checked then select if EQUILIBRIUM or 
COMPATIBILITY torsion is to be considered and if for sections with flanges 
STIRRUPS IN FLANGES can be considered. 

10. Choose if GROSS (UNCRACKED) or EFFECTIVE (CRACKED) sections are to be 
considered in the deflection calculations. 

11. Choose if in the case of a section with flanges in the negative moment region, 
only the web (RECTANGULAR SECTION) or the whole section (T-SECTION) is 
to be used to calculate the gross moment of inertia (Ig) and the cracking 
moment. 

12. Check CALCULATE LONG-TERM DEFLECTIONS checkbox if you want the 
program to calculate long-term deflections. Provide the duration of load in 
months and the percentage of the live load which is considered as sustained 
load. 

Using Span Control  
The Span Control tab allows you to perform different operations on the spans that 
your system consists of. These operations include inserting new spans with default 
parameters, creating new spans by copying existing spans, moving spans to change 
span sequence, and deleting spans. The result of an operation depends on the span 
selected as well an on the selected support. Spans can be selected using the Span 
Control List and columns using the Support Selection radio buttons. 
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Figure 4-7 Span control tab 

Additionally before the Span Control window is closed all changes made to the 
spans can be revoked using the RESET ALL button. The RESTORE button can be 
used to bring back a span removed using the DELETE button. 

To insert a new span with default dimensions: 

1. In the SPAN CONTROL LIST select the span next to which you want to insert 
a new span. 

2. Select whether the LEFT SUPPORT or the RIGHT SUPPORT of the newly created 
span will be inserted. 

3. Press INSERT BEFORE button to insert the new span left to the selected span or 
INSERT AFTER button to insert the new span on the right side of the currently 
selected span. 
Examples of the insert operations are presented in Figure 4-8. Assuming that 
Span 2 is always selected the resulting systems will depend on whether 
INSERT AFTER or INSERT BEFORE was used and whether LEFT COLUMN or 
RIGHT COLUMN was selected. Newly inserted span and column are denoted 
with an “x”. 
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Figure 4-8 Inserting a new span using Span Control 

To copy a span: 

1. In the SPAN CONTROL LIST select the span you want to copy. 
2. Select whether the LEFT SUPPORT or the RIGHT SUPPORT of the copied span 

will be copied with the span. 
3. Press INSERT BEFORE button to place the copied span left to the selected span 

or INSERT AFTER button to place the copied span on the right side of the 
currently selected span. 
Examples of the insert operations are presented in Figure 4-9. Assuming that 
Span 2 is always selected the resulting systems will depend on whether COPY 
AFTER or COPY BEFORE was used and whether LEFT COLUMN or RIGHT 
COLUMN was selected. Newly created span and column are denoted with the 
prime sign. 
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Figure 4-9 Copying a span using Span Control 

To move a span: 

1. In the SPAN CONTROL LIST select the span you want to move. 
2. Select whether the LEFT SUPPORT or the RIGHT SUPPORT of the moved span 

will be moved with the span. 
3. Press MOVE BEFORE button to move the span to the left or MOVE AFTER 

button to move the span to the right side. 
Examples of the move operations are presented in Figure 4-10. Assuming that 
Span 2 is always selected the resulting systems will depend on whether MOVE 
AFTER or MOVE BEFORE was used and whether LEFT COLUMN or RIGHT 
COLUMN was selected. 
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Figure 4-10 Moving a span using Span Control 

To delete a span: 

1. In the SPAN CONTROL LIST select the span you want to delete. 
2. Select whether the LEFT SUPPORT or the RIGHT SUPPORT of the deleted span 

will be removed with the span. 
3. Press the DELETE button to delete the selected span. 
Examples of the delete operations are presented in Figure 4-11. Assuming that 
Span 2 is always selected the resulting systems will depend on whether LEFT 
COLUMN or RIGHT COLUMN was selected. 
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Figure 4-11 Deleting a span using Span Control 

Defining Material Properties  
The Material Properties command from the Input menu allows you to input 
material properties of the concrete and the reinforcement. There are two tabs in 
this dialog box. One is for concrete and the other is for reinforcing steel. This 
command must be executed in order to perform a design of the floor system. Use 
the tab key to get to each edit box then type in your values, or use your mouse and 
click directly on the desired tab and box, then type in your values. Refer to 
"Material Properties" for a detailed explanation of the default values. 

To define material properties: 

1. Select the Material Properties command from the Input menu or click the 
 button on the tool bar. The dialog box of Figure 4-12 will appear. 

 
Figure 4-12 Concrete Properties dialog box 
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2. Click the Concrete tab and enter the concrete density for the following 
members: Slabs, Beams, and Columns.  

3. Enter the concrete compressive strength. By entering a value for the 
compressive strength, values for Young’s modulus and rupture modulus will 
automatically be computed for the slabs, beams, and columns. Young’s 
modulus and rupture modulus will automatically be shown in the 
corresponding text boxes. 

4. If you have values for the rupture modulus, enter the values in the text boxes 
for the slabs, beams, and columns. Default values are computed based on 
average split tensile strength of concrete, which is calculated internally by the 
program. These values will be used for deflection analysis. A large value for 
the rupture modulus will produce a deflection analysis based on gross, non-
cracked, sections. The CSA A23.3 Standard requires187 that for the calculation 

of slab deflections a rupture modulus value equal to 2/f6.0 '
c  be used. 

spSlab defaults to this value of the rupture modulus for the slab concrete in 
CSA design runs. However, for beams and one-way slabs rapture modulus of 

'
cf6.0  has to be used and this value needs to entered directly by the user 

overwriting the default value. 
5. If precast concrete is used, check PRECAST CONCRETE checkbox. 
6. Click the Reinforcing Steel tab as shown in Figure 4-13. 

 
Figure 4-13 Reinforcing Steel Properties dialog box 

7. Enter the yield stress of flexure steel.  
8. Enter the yield stress of stirrups. 
                                                           
187 CSA A23.3-04, 13.2.7; CSA A23.3-94, 13.3.6 
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9. Enter the Young’s modulus for flexural steel and stirrups. 
10. Select whether the main reinforcement is epoxy-coated by clicking the left 

mouse button on the box or tabbing to the box and pressing the SPACE BAR. 
This selection affects development lengths. 

11. Press OK button to exit the dialog box so that spSlab will use these material 
properties. If using the Auto Input, click the NEXT button to the next dialog 
box. 

Defining Slabs/Flanges  
The Spans command from the Input menu is available for all floor systems. Span 
numbers, which are determined from the number of supports entered in the 
General Information box, are automatically filled into the Span drop-down list in 
the Span Data dialog box.  

To input slab geometry: 

1. Select the Spans command from the Input menu or click the  button on the 
tool bar. Click the left mouse button on the Slabs tab. The dialog box of 
Figure 4-14 will appear. 

2. Select the number of the span, for which dimensions will be entered, from the 
Span drop-down list. 

 
Figure 4-14 Defining the Slabs dialog box 

3. Select the span location from the Location drop-down list. Three types of 
locations are available: Interior, Exterior Left, and Exterior Right. The "left" 
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and "right" are defined as you look along the direction of analysis. If a span 
has design strips on both sides it should be an "Interior" span. If a span has 
only a left design strip, it should be an "Exterior Right" span. If a span has 
only a right design strip, it should be an "Exterior Left" span. 

4. Enter the slab thickness of the span.  
5. Enter the span length from column centerline to column centerline or edge to 

column centerline for the two cantilever spans in the Length edit box. If the 
program detects a cantilever span length less than one-half the column 
dimension in the direction of analysis, an error message will pop up when the 
frame is analyzed. If a partial load is affected by the span length, a message 
warns the user of this condition. 

6. Enter the span design width in the transverse direction of analysis on the left 
and right side of the column (see Figure 4-15). These distances are usually 
one-half the distance to the next transverse column or edge of the slab for 
exterior spans. The left and right designations are arbitrary. Both interior and 
exterior spans may be used in a design strip. An exterior width will 
automatically be designated by spSlab by entering a width value less than or 
equal to the transverse column dimension. Exterior sides do not contribute to 
the attached torsional stiffness, although they do contribute to loading. spSlab 
will use the total width entered for weight and superimposed loading but will 
use code allowed dimensions for flange width and stiffness computations. 

 
Figure 4-15 Required Slab Dimensions 

7. Press the MODIFY button to update the slab geometry. 
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8. Repeat steps 2 through 7 until all the spans have been updated. You can use 
the COPY button as a shortcut. 

9. Press OK button to exit the dialog box and allow spSlab to use the updated 
slab geometry. 

Defining Longitudinal Beams  
Longitudinal beam dimensions are required for the beam-supported slab. Span 
numbers, which are determined from the number of supports entered in the 
General Information box, are automatically filled into the Span drop-down list.  

To input geometry for beam-supported slab system: 

1. Select the Spans command from the Input menu or click the  button on the 
tool bar. Click the left mouse button on the Longitudinal Beams tab. The 
dialog box of Figure 4-16 will appear. 

2. Select the span number from the Span drop-down list. 
3. Enter the width of the beam (Figure 4-17). 
4. Enter the depth of the beam from the top of the slab (Figure 4-17). 
5. Press the MODIFY button to update the longitudinal beam geometry. 

 
Figure 4-16 Longitudinal Beam Geometry dialog box 

6. Repeat steps 2 through 6 until all the beams have been updated. You can use 
the COPY button as a shortcut. 
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7. Press OK button to exit the dialog box so that spSlab will use the new beam 
geometry. 

 
Figure 4-17 Required Longitudinal Beam Dimensions 

Defining Ribs  
For joist systems, you must define the rib geometry. The ribs are assumed to be the 
same throughout the strip. 

To enter rib geometry: 

1. Select the Spans command from the Input menu or click the  button on the 
tool bar. Click the left mouse button on the Ribs tab. The dialog box of Figure 
4-18 will appear. 

 
Figure 4-18 Ribs Geometry dialog box 
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2. Select the span number from the Span drop-down list. 
3. Enter the spacing between ribs at the bottom for clear rib spacing (see Figure 

4-19). 

 
Figure 4-19 Required Rib Dimensions 

4. Enter the width at the bottom for rib width (see Figure 4-19). 
5. Enter the depth of the rib below the slab for Rib depth (see Figure 4-19). 
6. Press OK button to exit the dialog box so that spSlab can use the rib geometry. 

Defining Longitudinal Bands  
The Longitudinal Bands property page (Figure 4-20) allows inputting the width 
and depth of longitudinal bands in each span. The procedure is identical to the 
described earlier input of dimensions of longitudinal beams. It is not required to 
input bands for every span. Spans where slab bands are not defined are modeled 
similar to regular two-way systems. Longitudinal slab bands can also be extended 
to adjacent spans using drop panels. 

To input geometry for longitudinal slab band: 

1. Select the Spans command from the Input menu or click the  button on the 
tool bar. Click the left mouse button on the Longitudinal Bands tab. The 
dialog box of Figure 4-20 will appear. 

2. Select the span number from the Span drop-down list. 
3. Enter the width of the band. 
4. Enter the depth of the band from the top of the slab. 
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5. Press the MODIFY button to update the longitudinal beam geometry. 
6. Repeat steps 2 through 6 until all the slab bands have been updated. You can 

use the COPY button as a shortcut. 
7. Press OK button to exit the dialog box so that spSlab will use the slab band 

geometry. 

 
Figure 4-20 Longitudinal Bands Geometry dialog box 

User Defined Column Strip Widths  
User has the ability to manually adjust column strip widths if the two-way floor 
system option is selected in Solve Options. In this case the Slab/Flanges property 
page (Figure 4-21) will contain additional field for inputting column strip width. 
The values of middle and beam strip widths are recalculated internally. 

To manually adjust column strip widths: 

1. Enable check box User Slab Strip Width under Solve Options dialog 
window. 

2. Follow the procedure described in section Defining Slabs/Flanges. 
3. Enter additional values of column strip width for each span. 
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Figure 4-21 User Defined Column Strip Widths 

User Defined Moment Distribution Factors  
User has the ability to manually adjust moment distribution factors if the two-way 
floor system option is selected in Solve Options. In such case the Moment 
Distribution property page (Figure 4-22) will become available under Span Data 
dialog window. This dialog contains fields for inputting distribution factors in 
column and beam strips. The distribution factors for middle strip are recalculated 
internally. 

To input Moment Distribution Factors: 

1. Enable check box User Distribution Factors under Solve Options dialog 
window. 

2. Select the Spans command from the Input menu or click the  button on the 
tool bar. Click the left mouse button on the Moment Distribution tab. The 
dialog box of Figure 4-22 will appear. 

3. Select the number of the span, for which values will be entered, from the 
Span drop-down list. 

4. Enter moment distribution values in edit boxes. 
5. Press the MODIFY button to update the slab geometry. 
6. Repeat steps 2 through 5 until all the spans have been updated. You can use 

the COPY button as a shortcut. 
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7. Press OK button to exit the dialog box and allow spSlab to use the updated 
information. 

 
Figure 4-22 User Defined Moment Distribution Factors 

Defining Columns  
Column data is optional. If no column is specified at the joints the joint is assumed 
hinged. You will be allowed to enter column dimensions above and below. 

To input column/capital geometry: 

1. Select the Supports command from the Input menu or click the  button on 
the tool bar. The dialog box of Figure 4-23 will appear. Click on the Columns 
tab. 

2. Enter stiffness share of the column which determines the percentage of the 
column stiffness used in the analysis. When the percentage lies between zero 
and 100%, the joint stiffness contribution by the column is multiplied by that 
percentage. Zero stiffness share indicates a pin support. Value of 999 indicates 
a support with fully fixed rotation. The default value is 100%, i.e. the actual 
column stiffness. 

3. Enter the column height above, which is the distance from the top of the 
design floor to the top of the floor above (see Figure 4-23). spSlab obtains the 
clear column height above by subtracting the average slab depth from the 
height given. Only the slab is considered for the floor system above. A zero 
dimension for the column heights above and below will create a pin condition. 
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Figure 4-23 Column Geometry dialog box 

4. Enter the column height below, which is the distance from the design floor to 
the top of the floor below (see Figure 4-24). To obtain a clear column height 
below, the slab/drop/beam depth is subtracted from the height given. A zero 
dimension for the column heights above and below will create a pin condition. 

 
Figure 4-24 Required Column Dimensions 
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5. Enter a value for c1, the column dimension in the direction of analysis (see 
Figure 4-24). 

6. Enter a value for c2, the column dimension perpendicular to the direction of 
analysis (see Figure 4-24). Round columns are specified with a zero input for 
c2; c1 is then taken as the diameter. Zero value for Stiffness Share will create 
a pin condition. 

7. Select whether spSlab should compute punching shear around column. 
8. Select whether spSlab should compute increased value of γf factor and 

corresponding decreased γv factor (for ACI code only). 
9. Press the MODIFY button to update the column geometry. 
10. Repeat steps 2 through 9 until all the columns and capitals have been updated. 

You can use the COPY button as a shortcut. 
11. Press OK button to exit the dialog box so that spSlab will use the new data. 

Defining Drop Panels  
Drops are available for the flat slab or waffle slab systems and can be defined at all 
the support locations. The drop length and width dimensions are computed by 
spSlab, based on slab span dimensions, when the "Standard" is selected in the 
Type drop-down list. 

To input drop geometry 

1. Select the Supports command from the Input menu or click the  button 
then click on the Drop Panels tab. The dialog box of Figure 4-25 will appear. 

2. Select whether spSlab should compute the drop dimensions or the dimensions 
will be user specified. If spSlab is to compute the dimensions, the "Standard" 
option should be selected from the Type drop-down list and then only the 
drop depth will be available. When the "Standard drop" option is selected 
spSlab will calculate drop panel dimensions in accordance with ACI 318 
Clause 13.3.7. Similar requirements contained in previous editions of the CSA 
A23.3 Standard have been removed from the 1994 edition. As a result, the 
ACI minimum specifications for drop panels are also used in CSA A23.3 runs 
when the "Standard Drops" option is selected. If you would like to specify 
drop dimensions other than those computed by spSlab, you must select "User-
defined" from the Type drop-down list.  
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Figure 4-25 Drop Geometry dialog box 

3. Enter the dimension in the direction of analysis from the column centerline to 
the edge of the drop left of the column (see Figure 4-26). If this is a standard 
drop, this dimension will not be available and the length left is set equal to the 
slab span length left/6 for interior columns or the left cantilever length for the 
first column. 

4. Enter the width dimension in the transverse direction (see Figure 4-26). If this 
is a standard drop, this dimension will not be available and the width is set 
equal to slab width/3. 

5. In order for spSlab to recognize drops, drop depths are required for the flat 
slab systems even if Standard Drop is selected. Enter the depth of the drop 
from the span with the smaller slab depth (see Figure 4-26). For waffle slab 
systems, the depth is automatically assumed to be equal to the rib depth below 
the slab and is not displayed. A value entered will be considered to exist 
below the rib depth during calculations. 

6. Select whether spSlab should compute punching shear around drop panel. 
7. Press the MODIFY button to update the drop geometry. 
8. Repeat steps 2 through 6 until all the drop dimensions have been updated. 

You can use the COPY button as a shortcut. 
9. Press OK button to exit the dialog box so that spSlab will use the new drop 

geometry. 
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Figure 4-26 Required Drop Dimensions 

Defining Column Capitals  
To input column capital geometry: 

1. Select the Supports command from the Input menu or click the  button on 
the tool bar. Click left mouse button on the Column Capitals tab to activate 
it. The dialog box of Figure 4-27 will appear. 

2. Select the support number from the Support drop-down list. 
3. Enter the capital depth which is the distance from the bottom of the soffit 

(slab, drop, or beam), to the bottom of the capital.  

w.r.t. 



 

4-28  Operating spSlab/spBeam 

 
Figure 4-27 Capital Dimensions 

4. The Side slope is the rate of depth to extension of the capital and it must be 
greater than 1 and smaller than 50 (see Figure 4-28). 

5. Enter the capital extension which is the distance from the edge of the column 
to the end of the capital (see Figure 4-28). 

 
Figure 4-28 Required Capital Dimensions 

Defining Transverse Beams  
The Transverse Beam command allows you to input the width, depth, and offset 
(eccentricity) of transverse beams at each column. This command is optional. 
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To input transverse beam geometry: 

1. Select the Support command from the Input menu. Select Transverse 
Beams tab from the Support Data dialog box. The dialog box of Figure 4-29 
will appear. 

2. Enter the width of the transverse beam (see Figure 4-30) 
3. Enter the depth of the transverse beam which is taken from the top of the slab 

to the bottom of the beam (see Figure 4-30) 
4. Enter the eccentricity, which is measured from the joint centerline, positive to 

the right, and negative to the left of the joint (See Figure 4-30). 
5. Press the MODIFY button to update the transverse beam dimensions. 
6. Repeat steps 2 through 5 until all the beams have been updated. You can use 

the COPY button as a shortcut (see "Entering the Structure Geometry" earlier 
in this chapter for help on the COPY button). 

 
Figure 4-29 Transverse Beam Geometry dialog box 

7. Press OK button to exit the dialog box so that spSlab will use the new beam 
geometry. 
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Figure 4-30 Required Transverse Beam Dimensions 

Defining Transverse Bands  
The Transverse Bands property page (Figure 4-31) allows inputting the width, 
depth, and offset (eccentricity) of transverse bands at each column. It is not 
required to input bands for every support. Supports where slab bands are not 
defined are modeled similar to regular two-way systems. 

 
Figure 4-31 Transverse Band Geometry dialog box 

To input transverse band geometry: 
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1. Select the Support command from the Input menu. Select Transverse 
Bands tab from the Support Data dialog box. The dialog box of Figure 4-31 
will appear. 

2. Enter the width of the transverse band (see Figure 4-31) 
3. Enter the depth of the transverse band which is taken from the top of the slab 

to the bottom of the band (see Figure 4-31) 
4. Enter the eccentricity, which is measured from the joint centerline, positive to 

the right, and negative to the left of the joint (See Figure 4-31). 
5. Press the MODIFY button to update the transverse band dimensions. 
6. Repeat steps 2 through 5 until all the beams have been updated. You can use 

the COPY button as a shortcut (see "Entering the Structure Geometry" earlier 
in this chapter for help on the COPY button). 

7. Press OK button to exit the dialog box so that spSlab will use the new band 
geometry. 

Defining Boundary Conditions  
By default spSlab assumes that column-slab/beam joints can only rotate and that 
they do not undergo any translational displacements. Rotation of a joint is affected 
by the stiffness of elements it connects i.e. slabs/beams, transverse beams, and 
columns. Columns are assumed by default to be fixed at their far ends as shown in 
Figure 2-6. These default assumptions can be altered using the Boundary 
Conditions command. 
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Figure 4-32 Boundary Conditions dialog box 

By specifying vertical spring support constant with Kz value other than 0, you can 
allow the joint to displace vertically. This movement is then controlled by the 
stiffness of the spring Kz in addition to the stiffness of the column below. The 
column above is assumed not to constrain the vertical movement of the joint. 
Additional rotational spring support can be applied to the joint by specifying the 
value of Kry. Also the far end column conditions can be selected as either fixed or 
pinned as shown in Figure 4-33 (b). All elements controlling the displacements of 
a joint are shown in Figure 4-33 (a). 

a)

EI
EA

Kz

Kry

Kt

EI

EIEI

Kt

  

b) Pinned Fixed

Fixed Pinned  
Figure 4-33 (a) Elements controlling joint displacement (b) Far End Column 

Boundary Conditions 

To input boundary conditions: 
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1. Select the Support command from the Input menu. Select Boundary 
Conditions tab from the Support Data dialog box. The dialog box of Figure 
4-32 will appear. 

2. Select support number 
3. Enter value of Kz to allow vertical displacement of the support and to add 

translational spring support (see Figure 4-33 (a)) 
4. Enter value of Kry to add rotational spring support (see Figure 4-33 (a)) 
5. Select far end support conditions for the column above and below the joint 

(see Figure 4-33 (b)) 
6. Press the MODIFY button to update the boundary conditions. 
7. Repeat steps 2 through 5 until all the joints have been updated. You can use 

the COPY button as a shortcut (see "Entering the Structure Geometry" earlier 
in this chapter for help on the COPY button). 

8. Press OK button to exit the dialog box so that spSlab will use the new 
boundary conditions. 

Defining Moment Redistribution Factors  
This command is only available for beams/one-way slab systems when MOMENT 
REDISTRIBUTION option is checked in the General Information dialog box. 
To input boundary conditions: 

1. Select the Support command from the Input menu. Select Moment 
Redistribution tab from the Support Data dialog box. The dialog box of 
Figure 4-34 will appear. 

2. Select support number 
3. Enter the maximum value of the redistribution factors you want to allow on 

the left and the right side of the support. Please note that actual value used is 
determined by the program when the problem is being solved and that the 
check against the code specified limit is also performed. 

4. Press the MODIFY button to update the redistribution factor limits. 
5. Repeat steps 2 through 5 until all the supports have been updated. Please note 

that supports connecting to cantilevers will not be available since moment 
redistribution is not allowed there. You can use the COPY button as a shortcut 
(see "Entering the Structure Geometry" earlier in this chapter for help on the 
COPY button). 

6. Press OK button to exit the dialog box so that spSlab will use the new moment 
redistribution limits. 
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Figure 4-34 Moment Redistribution dialog box 

Defining Reinforcement Criteria for Slabs and Ribs  
In order for spSlab to select the reinforcement, you must define the slab and rib 
reinforcement, bar sizes, location, and minimum spacing dimensions. See "Area of 
Reinforcement" and "Reinforcement Selection" in Method of Solution for 
a discussion of the reinforcement computations.  

To define reinforcement Criteria for Slabs and Ribs: 

1. Select the Reinforcement Criteria command from the Input menu or click 
the  button on the tool bar. Select Slabs and Ribs tab by clicking the left 
mouse button on the tab title. The dialog boxes of Figure 4-35 will appear. 
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Figure 4-35 Slab and Rib Reinforcement dialog boxes 

2. For slabs and ribs, enter the clear covers for top and bottom reinforcing bars. 
For the top reinforcement, this distance is from the top of the slab to the top of 
the top bars. For the bottom reinforcement, this distance is from the bottom of 
the slab to the bottom of the bottom bars (see Figure 4-36). The default value 
is 1.5 in. [40mm] for both input items. 

3. Enter the minimum bar size to start the iteration for determining flexural 
reinforcement. 

4. Enter the maximum bar size. This number will be used as a stop in the 
iteration for determining flexural bars in beams. 

5. Enter minimum bar spacing for slab and rib flexural reinforcement. This 
number should be based on aggregate size or detailing considerations. Default 
spacing is 6 in. [150mm] for slabs and ribs. 

6. Enter maximum bar spacing for slab and rib flexural reinforcement. Default 
spacing is 18 in. [500 mm] for slabs and ribs. 

7. Enter minimum Reinforcement Ratio for slab and rib flexural reinforcement. 
Default ratio is 0.14% [0.20%] for slabs and ribs. If the user specified value is 
smaller than 0.14%, 0.14% is used by spSlab. If the user specified value is 
greater than 0.14%, the specified value is used by spSlab. 



 

4-36  Operating spSlab/spBeam 

 
Figure 4-36 Distance to Reinforcement Edges 

8. Enter maximum Reinforcement Ratio for slab and rib flexural reinforcement. 
Default ratio is 5% for slabs and ribs. 

9. If the top bars have more than 12 in. [300 mm] of concrete below them, check 
the corresponding check box. 

10. Press OK button to exit the dialog box and allow spSlab to use the new data. 

Defining Reinforcement Criteria for Beams  
In order for spSlab to select the reinforcement, you must define the beam 
reinforcement, bar sizes, location, and minimum spacing dimensions. See "Area of 
Reinforcement" and "Reinforcement Selection" in the Method of Solution for a 
discussion of the reinforcement computations.  

To define reinforcement criteria for beams: 

1. Select the Reinforcement Criteria command from the Input menu or click 
the  button on the tool bar. Select Beams tab by clicking the left mouse 
button on the tab title. The dialog boxes of Figure 4-37 will appear. 

2. Enter the covers for top and bottom reinforcing bars for beams. For the top 
reinforcement, this distance is from the top of the beam to the top of the top 
bars; and for the bottom reinforcement, this distance is from the bottom of the 
slab to the bottom of the bottom bars (see Figure 4-38). The default value is 
1.5 in. [40mm] for both input items. 

3. Enter the side cover which is measured from the side face of a beam to the 
face of the stirrup (see Figure 2-20). The default value is 1.5 in [40 mm]. 

4. Enter the minimum bar size for top and bottom bars and stirrups to start the 
iteration for determining flexural reinforcement. 

5. Enter the maximum bar size for top and bottom bars and stirrups. This number 
will be used as a stop in the iteration for determining flexural bars in beams. 
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6. Enter the minimum bar spacing for beam flexural reinforcement and stirrups. 
This number should be based on aggregate size or detailing considerations. 
The default minimum reinforcement bar spacing is 1 in. [25 mm] and the 
default stirrup spacing is 6 in. [150 mm] 

 
Figure 4-37 Beam reinforcement dialog boxes 

7. Enter the maximum bar spacing for beam flexural reinforcement and stirrups. 
The default maximum reinforcement spacing is 18 in. [500 mm] and the 
default maximum stirrup spacing is 18 in. [450 mm] 

8. Enter the minimum Reinforcement Ratio for beam flexural reinforcement. 
Default ratio is 0.14% [0.20%] for beams. If the user specified value is 
smaller than 0.14%, 0.14% is used by spSlab. If the user specified value is 
greater than 0.14%, the specified value is used by spSlab. 

 
Figure 4-38. Distance to Reinforcement 
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9. Enter the maximum Reinforcement Ratio for beam flexural reinforcement. 
Default ratio is 5% for beams. 

10. Enter the clear distance between bar layers to use if the program needs to 
distribute flexural bars in multiple layers. Default distance is 1 in. [30 mm] for 
beams. 

11. Enter the distance from face of support (FOS) to first stirrup. The default 
value is 3.0 in [75 mm]. 

12. If the top bars have more than 12 in. [300 mm] of concrete below them, check 
the corresponding check box. 

13. Press OK button to exit the dialog box and allow spSlab to use the new data. 

Defining Column Strip Bars for Two-Way Slab Systems  
The reinforcing bar size, number of bars, bar length, etc. can be defined by users if 
the Run Mode of Investigation and two-way floor system are selected in the 
General Information dialog box. This menu item is not available if Run Mode of 
Design is selected in the General Information dialog box. 

To define column strip bars: 

1. Select Reinforcing Bars from the Input menu or click the  button on the 
tool bar. Select the Column Strip Bars tab by clicking the tab title or use the 
tab key on the keyboard to toggle to the tab title then select the Column Strip 
Bars tab using the arrow keys. The dialog boxes of Figure 4-39 will appear. 

 
Figure 4-39 Defining Column Strip Bars 



 

Operating spSlab/spBeam  4-39 

2. Select the span for which reinforcing bars will be defined from the Span list 
box on the upper left corner. The length of the selected span will be shown 
right above the ADD button. 

3. Select bar size from the Bar Size drop-down list.  
4. Define the number of reinforcing bars in the selected span by entering the 

number in the Number of Bars input box. 
5. Define the length of the reinforcing bars by entering the length in the Length 

input box. The unit of the length is foot [m]. 
6. Define the types of the reinforcing bars in the selected span by selecting from 

the Type drop-down list, which is right below the Bar Size drop-down list. 
Five types are available: Top Left, Top Right, Top Continuous, Bottom 
Continuous and Bottom Discontinuous.  

7. Define the cover by entering the number in the Cover input box. The unit of 
cover is inch [mm]. 

8. Press ADD button to add the new data into the list box below the buttons. 
9. Repeat steps 2 to 8 to define reinforcing bars for all the spans. You may use 

the SPAN COPY button below the Span list to simply copy the data of one span 
to other spans. 

10. If the reinforcing data of a span needs to be modified, select the data from the 
data list box on the lower part of the dialog box then modify the data as 
mentioned above. Press MODIFY button when finished to update the 
corresponding data in the data list box. 

11. To delete the reinforcing data for a span, select the data of the span from the 
data list box then press the DELETE button. 

12. Press OK button to exit the dialog box so that spSlab will use these reinforcing 
bar properties. 

Defining Middle Strip Bars for Two-Way Slab Systems  
The reinforcing bar size, number of bars, bar length, etc., can be defined by users 
if the Run Mode of Investigation and two-way floor system are selected in the 
General Information dialog box. This menu item is not available if Run Mode of 
Design is selected in the General Information dialog box. 

To define middle strip bars: 

1. Select Reinforcing Bars from the Input menu or click the  button on the 
tool bar. Select the Middle Strip Bars tab by clicking the tab title or use the 
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tab key on the keyboard to toggle to the tab title then select the Middle Strip 
Bars tab using the arrow keys. The dialog boxes of Figure 4-40 will appear. 

 
Figure 4-40 Defining Middle Strip Bars 

2. Select the span for which reinforcing bars will be defined from the Span list 
box on the upper left corner. The length of the selected span will be shown 
right above the ADD button. 

3. Select bar size from the Bar Size drop-down list. 
4. Define the number of reinforcing bars in the selected span by entering the 

number in the Number of Bars input box. 
5. Define the length of the reinforcing bars by entering the length in the Length 

input box. The unit of the length is foot [m]. 
6. Define the Types of the reinforcing bars in the selected span by selecting from 

the drop-down list, which is right below the Bar Size drop-down list. Five 
types are available: Top Left, Top Right, Top Continuous, Bottom Continuous 
and Bottom Discontinuous.  

7. Define the cover by entering the number in the Cover input box. The unit of 
cover is inch [mm]. 

8. Press ADD button to add the new data into the list box below the buttons. 
9. Repeat steps 2 to 8 to define reinforcing bars for all the spans. You may use 

the SPAN COPY button below the Span list to simply copy the data of one span 
to other spans. 
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10. If the reinforcing data of a span needs to be modified, select the data from the 
data list box on the lower part of the dialog box then modify the data as 
mentioned above. Press MODIFY button when finished to update the 
corresponding data in the data list. 

11. To delete the reinforcing data for a span, select the data of the span from the 
data list box then press the DELETE button. 

12. Press OK button to exit the dialog box so that spSlab will use these reinforcing 
bar properties.  

Defining Beam Bars for Two-Way Slab Systems  
The reinforcing bar size, number of bars, bar length, etc. can be defined by users if 
the Run Mode of Investigation and two-way floor system are selected in the 
General Information dialog box. This menu item is not available if Run Mode of 
Design is selected in the General Information dialog box. 

To define beam bars: 

1. Select Reinforcing Bars from the Input menu or click the  button from the 
tool bar. Select the Beam Bars tab by clicking the tab title or use the tab key 
on the keyboard to toggle to the tab title then select the Beam Bars tab using 
the arrow keys. The dialog boxes of Figure 4-41 will appear. 

 
Figure 4-41 Defining Beam Bars 
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2. Select the span for which reinforcing bars will be defined from the Span list 
box on the upper left corner. The length of the selected span will be shown 
right above the ADD button. 

3. Select bar size from the Bar Size drop-down list.  
4. Define the number of reinforcing bars in the selected span by entering the 

number in the Number of Bars input box. 
5. Define the length of the reinforcing bars by entering the length in the Length 

input box. The unit of the length is foot [m]. 
6. Define the types of the reinforcing bars in the selected span by selecting from 

the Type drop-down list, which is right below the Bar Size drop-down list. 
Five types are available: Top Left, Top Right, Top Continuous, Bottom 
Continuous and Bottom Discontinuous.  

7. Define the cover by entering the number in the Cover input box. The unit of 
cover is inch [mm]. 

8. Press ADD button to add the new data into the list box below the buttons. 
9. Repeat steps 2 to 8 to define reinforcing bars for all the spans. You may use 

the SPAN COPY button below the Span list to simply copy the data of one span 
to other spans. 

10. If the reinforcing data of a span needs to be modified, select the data from the 
data list box on the lower part of the dialog box then modify the data as 
mentioned above. Press MODIFY button when finished to update the 
corresponding data in the data list. 

11. To delete the reinforcing data for a span, select the data of the span from the 
data list box then press the DELETE button. 

12. Press OK button to exit the dialog box so that spSlab will use these reinforcing 
bar properties. 

Defining Beam Stirrups for Two-Way Slab Systems  
The stirrup size, number of stirrups, etc. can be defined by users if the Run Mode 
of Investigation and two-way floor system are selected in the General 
Information dialog box. This menu item is not available if Run Mode of Design 
is selected in the General Information dialog box. 

To define beam stirrups: 

1. Select Reinforcing Bars from the Input menu or click the  button from the 
tool bar. Select the Beam Stirrups tab by clicking the tab title or use the tab 



 

Operating spSlab/spBeam  4-43 

key on the keyboard to toggle to the tab title then select the Beam Stirrups 
tab using the arrow keys. The dialog boxes of Figure 4-42 will appear. 

 
Figure 4-42 Defining Beam Stirrups 

2. Select the span for which stirrups will be defined from the Span list box on 
the upper left corner. The length of the selected span will be shown right 
above the ADD button. 

3. Enter the amount of stirrups of the selected span in the Count input box. (see 
Note) 

4. Select stirrup size from the Size drop-down list.  
5. Enter the spacing of the stirrups of the selected span in the Spacing input box. 

The unit of spacing is inch [mm]. 
6. Enter the number of legs in the Leg input box. 
7. For first stirrup set modify the default location of first stirrup if required. 
8. Press ADD button to add the new data into the list box below the buttons. 
9. Repeat steps 2 to 8 to define stirrups for all the spans. You may use the Span 

COPY button below the Span list to simply copy the data of one span to other 
spans. 

10. In order to mirror stirrup set or sets at the end of the span use APPEND button. 
11. If the stirrup data of a span needs to be modified, select the data from the data 

list box on the lower part of the dialog box then modify the data as mentioned 
above. Press MODIFY button when finished to update the corresponding data 
in the data list. 
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12. To delete the stirrup data for a span, select the data of the span from the data 
list box then press the DELETE button. 

13. Press OK button to exit the dialog box so that spSlab will use these reinforcing 
bar properties. 

Note: If stirrups do not apply in a part of a span, the Count should be set to 0 
(zero) and the Spacing should be the length of the part of the span where no 
stirrups are defined. For example, the following configuration shows stirrups in the 
left and right ends of a span with an empty space (46.0 in. long, no stirrups) in the 
middle part of the span. 

Count Bar Size Spacing Legs 

32 #5 4.50 2 

0 #5 46.0 2 

32 #5 4.50 2 

Defining Flexure Bars for Beams and One-Way Slab Systems  
The reinforcing bar size, number of bars, bar length, etc. for one-way beam 
systems can be defined by users if the Run Mode of Investigation and beams/one-
way slab floor system are selected in the General Information dialog box. This 
menu item is not available if Run Mode of Design is selected in the General 
Information dialog box. 

 
Figure 4-43 Defining Flexure Bars for Beams/One-Way slab Systems 
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To define flexure bars for beam in beams/one-way slab systems follow the steps 
described in section Defining Beam Bars. 

Defining Stirrups for Beams and One-Way Slab Systems  
The stirrup size, number of stirrups, etc. for beams/one-way slab systems can be 
defined by users if the Run Mode of Investigation and beams/one-way slab floor 
system are selected in the General Information dialog box. This menu item is not 
available if Run Mode of Design is selected in the General Information dialog 
box. 

 
Figure 4-44 Defining Beams Stirrups in Beams/One-Way Slab Systems 

To define beam stirrups in beams/one-way slab systems follow the steps described 
in section Defining Beam Stirrups. 

Defining Torsional Longitudinal Bars for Beams  
The torsional longitudinal reinforcement bars are distributed along the perimeter of 
the section in addition to the flexure bars. They can be defined by users if the Run 
Mode of Investigation, beams/one-way slab floor system, and torsional analysis 
and design are selected in the General Information dialog box. This menu item is 
not available if Run Mode of Design is selected in the General Information 
dialog box. 

To define torsional longitudinal bars for beams in beams/one-way slab systems: 
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1. Select Reinforcing Bars from the Input menu or click the  button from the 
tool bar. Select the Torsion Bars tab by clicking the tab title or use the tab 
key on the keyboard to toggle to the tab title then select the Torsion Bars tab 
using the arrow keys. The dialog boxes of Figure 4-45 will appear. 

 
Figure 4-45 Defining Torsion Bars for Beams in Beams/One-Way Slab 

Systems 

2. Select the span for which reinforcing bars will be defined from the Span list 
box on the upper left corner. The length of the selected span will be shown 
right above the ADD button. 

3. Select bar size from the Bar Size drop-down list.  
4. Define the type of the reinforcing bars in the selected span by selecting from 

the Type drop-down list, which is right below the Bar Size drop-down list. 
Two types are available: Continuous and Discontinuous.  

5. Define the number of reinforcing bars in the selected span by entering the 
number in the Number of Bars input box. 

6. Define the cover by entering the number in the Cover input box. The unit of 
cover is inch [mm]. 

7. For discontinued bars, define the length and the starting point of the 
reinforcing bars by entering the values in the Start and Length input boxes. 
The unit of both is foot [m]. 

8. Press ADD button to add the new data into the list box below the buttons. 
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9. Repeat steps 2 to 8 to define reinforcing bars for all the spans. You may use 
the SPAN COPY button below the Span list to simply copy the data of one span 
to other spans. 

10. If the reinforcing data of a span needs to be modified, select the data from the 
data list box on the lower part of the dialog box then modify the data as 
mentioned above. Press MODIFY button when finished to update the 
corresponding data in the data list. 

11. To delete the reinforcing data for a span, select the data of the span from the 
data list box then press the DELETE button. 

12. Press OK button to exit the dialog box so that spSlab will use these reinforcing 
bar properties. 

Defining Load Cases  
Up to 6 load cases of dead load, live load or lateral load can be defined in the 
Load Cases dialog box. The default five load case labels (types) are SELF (dead 
load), Dead (dead load), Live (live load), Wind (wind load), and EQ (seismic 
load). 

To define load cases: 

1. Select Load Cases command from the Input menu or click the  button on 
the tool bar. Dialog box as in Figure 4-46 will appear. 

 
Figure 4-46 Defining Load Cases 

2. Enter a name for the new load case in the Label edit box. The name could be 
any character string defined by the user. 
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3. Select the type of the new load case from the Type drop-down list. The 
available types are Dead Load, Live Load and Lateral Load. 

4. Press ADD button to add the new load case into the load case list box on the 
lower part of the dialog box. 

5. Repeat steps 2 to 4 to define all the load cases. The maximum number of load 
cases is 6. Once the maximum number is reached, the ADD button will be 
disabled. 

6. To enter reserved load case SELF press the SELFWEIGHT button. 
7. To modify an existing load case, select the load case from the load case list 

box then change the label or type the selected load case as mentioned above 
and press the MODIFY button. 

8. To delete an existing load case, select the load case from the load case list box 
then press the DELETE button. 

9. Press OK button to exit the dialog box so that spSlab will use these load cases. 
Note: Only one case of live load can be defined. Load case label must be unique 
for each of the load cases. To ignore self weight in both strength and deflection 
calculations remove load case SELF from the list of load cases. 

Defining Load Combinations  
spSlab allows you to change the magnification factors applied to the load cases. 
The default values depend on the code selected with the General Information 
command. 

To define load factors: 

1. Select Load Combinations from the Input menu or click the  button from 
the tool bar. The dialog box of Figure 4-47 will appear if the ACI code was 
selected in the GENERAL INFORMATION dialog box. 
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Figure 4-47 Define Load Combinations 

2. The load cases and the corresponding factors that are defined in the Load 
Cases dialog box are shown on the top of the Load Combinations dialog box. 

3. Enter the load factors for each of the load cases in the input box below the 
corresponding load case label.  

4. Press the ADD button to add the combination defined above into the big list 
box in the lower part of the dialog box. 

5. Repeat steps 2 to 4 to define all the load combinations. Up to fifty load 
combinations may be defined. All the combinations are indexed automatically 
from U1 to U50. 

6. To change the factors of an existing combination, select the load combination 
from the load combination list box on the lower part of the dialog box then 
change the factors as mentioned above. Press the MODIFY button when 
finished to update the data in the load combination list box. 

7. To delete an existing combination, select the load combination from the load 
combination list box then press the DELETE button. 

8. Select OK button when all the desired load factors have been modified to exit 
so that spSlab will use the new data. 

Span Loads  
spSlab computes the self weight of the floor system. Other loads applied to the 
structure have to be specified by the user. There are several types of applied loads 
that may be entered. They are found in the Input menu. Surface loads are placed 
over the entire strip. Partial loads consist of uniform or trapezoidal loads, 
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concentrated loads, and concentrated moments that may exist anywhere within the 
span length. For beams/one-way slab systems torsional loads can be defined either 
as concentrated or distributed torques. 
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Distributed

Torque
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Concentrated Force
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Uniform

M

x
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Figure 4-48 Span Load Types 

Note: The loads shown in the Figure 4-48 are all positive and may not match the 
typical sign conventions. 

The following table describes input for the span load types shown in Figure 4-48. 

Wa For uniformly distributed loads, Wa is the intensity of the load 
in units of lbs/ft [kN/m], positive Wa is downward. For 
trapezoidal loads, Wa is the intensity at the left end in units of 
lbs/ft [kN/m], positive Wa is downward. For concentrated 
force, Wa is the force P in units of kips [kN], positive Wa is 
downward. For concentrated moments, Wa is the moment M 
in units of ft-kips [kNm], positive Wa is clockwise. For 
concentrated torque, Wa is the external torque T in units of ft-
kips [kNm], positive Wa is such that applying the right hand 
screw rule the torque vector points to the right. For distributed 
torque, Wa is the external torque intensity Ta in units of ft-
kips/ft [kNm/m], positive Wa is such that applying the right 
hand screw rule the torque vector points to the right. 

Wb For trapezoidal loads, Wb is the intensity at the right end in 
units of lbs/ft [kN/m], positive Wb is downward. For 
distributed torque, Wb is the external torque intensity Tb in 
units of ft-kips/ft [kNm/m], positive Wa is such that applying 
the right hand screw rule the torque vector points to the right. 
For all the other partial load types, Wb is not available. 
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La For distributed loads, La is the distance where the load begins 
from the centerline of the column at the left of the span, in 
units of ft [m]. For concentrated loads and moments, La is the 
distance where the load exists from the centerline of the 
column at the left of the span in units of ft [m]. 

Lb For distributed loads, Lb is the distance where the load ends 
from the centerline of the column at the left of the span, in 
units of ft [m]. For concentrated loads and moments, Lb is 
unavailable.  
Note: Although the particular loading may not actually act 
over the entire transverse width, all line loading is converted 
internally by spSlab to act over the full width of the slab. In 
the design direction, partial loads given as acting over less 
than 1/20 of the span length will be averaged over 1/20 by the 
program. 

Defining Area Load on Span  
Area loads are uniform loads acting over the entire strip. These loads have units of 
lb/ft2 [kN/m2].  

To input area loads: 

1. Select the Span Loads command from the Input menu or click the  button 
on the tool bar. Select the AREA LOAD from the TYPE drop-down list on the 
SPAN LOADS dialog box. The dialog box of Figure 4-49 will appear. 

2. Select the load case from the CURRENT CASE list box on the upper left corner 
as shown in the dialog above. 

3. Select the span on which the area loads will be applied from the SPAN drop-
down list. 

4. Enter the un-factored superimposed area load magnitude acting over the entire 
area of the strip in the Magnitude edit box. Positive surface loads act 
downward.  

5. Press the ADD button to update the area loads in the area load list box on the 
lower part of the dialog box. 

6. Repeat steps 2 through 5 until the loads have been updated. You can use the 
COPY button as a shortcut. 
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7. To change the data of an existing area load, select the area load from the area 
load list box then change the magnitude as mentioned above. Press the 
MODIFY button when finished to update the data in the area load list box. 

8. To delete an existing area load, select the load from the area load list box then 
press the DELETE button. 

9. Press OK button to exit the dialog box so that spSlab will use the new data. 

 
Figure 4-49 Defining Area Load on Span 

Defining Line Load on Span  
You may enter uniform or trapezoidal loads that do not span from column 
centerline to column centerline in the direction of analysis. These loads are called 
line loads and are input through the SPAN LOADS dialog of the Input menu. Partial 
loads are assumed to act over the entire strip width. 

To input line loads: 

1. Select the Span Loads command from the Input menu or click the  button 
on the tool bar. Select the LINE LOAD from the TYPE drop-down list. The 
dialog box of Figure 4-50 will appear. 

2. Select the load case of the line load that will be defined from the Current 
Case list box. 

3. From the Span drop-down list, select the span number of the span whose line 
loads you would like to input. 

4. Define un-factored load values and their locations in the corresponding text 
boxes.  
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Figure 4-50 Defining Line Load on Span 

5. Select Add to add the line load defined into the line load list box. 
6. Repeat steps 2 through 5 until all the line loads have been entered then press 

OK button to exit the dialog box so that spSlab will use the new loads. 
To change line loads data: 

1. Select the line load you want to change from the line load list box on the 
lower part of the dialog box by clicking the left mouse button on the load or 
tabbing to the list box and using the arrow up and down keys. 

2. Make your changes to the load by modifying the load type, the load 
magnitude, and/or location. 

3. Select Modify to replace the old data with the new data. 
To delete line load data: 

1. Select the line load you want to delete from the line load list box by clicking 
the left mouse button on the load or tabbing to the list box and using the arrow 
up and down keys. 

2. Press the DELETE button. 

Defining Point Force on Span  
You may enter concentrated vertical loads. These loads are input through the Span 
Load command of the Input menu. Point loads are assumed to act over the entire 
strip width. 

To input point loads: 
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1. Select the Span Loads command from the Input menu or click the  button 
on the tool bar. Select the Point Force from the Type drop-down list. The 
dialog box of Figure 4-51 will appear. 

 
Figure 4-51 Defining Point Forces on Span 

2. Select the load case of the point force that will be defined from the Current 
Case list box. 

3. From the Span drop-down list, select the span number of the span whose 
point loads you would like to input. 

4. Define un-factored load values and their locations in the corresponding text 
boxes.  

5. Select Add to add the point load defined into the point load list box on the 
lower part of the dialog box. 

6. Repeat steps 2 through 5 until all the point loads have been entered then press 
OK button to exit the dialog box so that spSlab will use the new loads. 

To change point load data: 

1. Select the point force you want to change from the point load list box by 
clicking the left mouse button on the load or tabbing to the list box and using 
the arrow up and down keys. 

2. Make your changes to the load by modifying the load type, the load 
magnitude, and/or location. 

3. Select Modify to replace the old data with the new data. 
To delete point load data: 
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1. Select the point force you want to delete from the point load list box to the 
right by clicking the left mouse button on the load or tabbing to the list box 
and using the arrow up and down keys. 

2. Press the DELETE button. 

Defining Point Moment on Span  
You may enter concentrated moment. This load is input through the Span Load 
command of the Input menu. Point moments are assumed to act over the entire 
strip width. 

To input point moments: 

1. Select the Span Loads command from the Input menu or click the  button 
on the tool bar. Select the Point Moment from the Type drop-down list. The 
dialog box of Figure 4-52 will appear. 

 
Figure 4-52 Defining Point Moments on Span 

2. Select the load case of the point moment that will be defined from the 
Current Case list box. 

3. From the Span drop-down list, select the span number of the span whose 
point moments you would like to input. 

4. Define un-factored moment values and their locations in the corresponding 
text boxes.  

5. Select Add to add the point moment defined into the point moment list box on 
the lower part of the dialog box. 
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6. Repeat steps 2 through 5 until all the point moments have been entered then 
press OK button to exit the dialog box so that spSlab will use the new 
moments. 

To change point load data: 

1. Select the point moment you want to change from the point moment list box 
by clicking the left mouse button on the load or tabbing to the list box and 
using the arrow up and down keys. 

2. Make your changes to the moment by modifying the moment type, the 
moment magnitude, and/or location. 

3. Select Modify to replace the old data with the new data. 
To delete point load data: 

1. Select the point moment you want to delete from the point moment list box to 
the right by clicking the left mouse button on the load or tabbing to the list 
box and using the arrow up and down keys. 

2. Press the DELETE button. 

Defining Line Torque on Span  
You may enter line torque for beams/one-way slab systems if Torsion Analysis 
and Design is selected in the GENERAL INFORMATION dialog box. This load is 
input through the Span Load command of the Input menu. 

To input line loads: 

1. Select the Span Loads command from the Input menu or click the  button 
on the tool bar. Select the LINE TORQUE from the TYPE drop-down list. The 
dialog box of Figure 4-53 will appear. 

2. Select the load case of the line load that will be defined from the CURRENT 
CASE list box. 

3. From the SPAN drop-down list, select the span number of the span whose line 
loads you would like to input. 

4. Define un-factored torque values and their locations in the corresponding text 
boxes.  

5. Select Add to add the line torque defined into the list box. 
6. Repeat steps 2 through 5 until all the line torques have been entered. Then 

press OK button to exit the dialog box so that spSlab will use the new loads. 



 

Operating spSlab/spBeam  4-57 

 
Figure 4-53 Defining Line Torque on Span 

To change line torque data: 

1. Select the line torque you want to change from the load list box on the lower 
part of the dialog box by clicking the left mouse button on the load or tabbing 
to the list box and using the arrow up and down keys. 

2. Make your changes to the load by modifying the load type, the load 
magnitude, and/or location. 

3. Select Modify to replace the old data with the new data. 
To delete line torque data: 

1. Select the line torque you want to delete from the load list box by clicking the 
left mouse button on the load or tabbing to the list box and using the arrow up 
and down keys. 

2. Press the DELETE button. 

Defining Point Torque on Span  
You may enter point torque for beams/one-way slab systems if Torsion Analysis 
and Design is selected in the GENERAL INFORMATION dialog box. This load is 
input through the Span Load command of the Input menu. 

To input point torque: 

1. Select the Span Loads command from the Input menu or click the  button 
on the tool bar. Select the POINT TORQUE from the TYPE drop-down list. The 
dialog box of Figure 4-54 will appear. 
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2. Select the load case of the point torque that will be defined from the CURRENT 
CASE list box. 

3. From the SPAN drop-down list, select the span number of the span whose 
point moments you would like to input. 

4. Define un-factored torque values and their locations in the corresponding text 
boxes.  

5. Select ADD to add the point torque defined into the list box on the lower part 
of the dialog box. 

6. Repeat steps 2 through 5 until all the point torques have been entered. Then 
press OK button to exit the dialog box so that spSlab will use the new torques. 

 
Figure 4-54 Defining Point Torque on Span 

To change point torque data: 

1. Select the point torque you want to change from the list box by clicking the 
left mouse button on the load or tabbing to the list box and using the arrow up 
and down keys. 

2. Make your changes to the moment by modifying the torque magnitude, and/or 
location. 

3. Select MODIFY to replace the old data with the new data. 
To delete point load data: 

1. Select the point moment you want to delete from the point moment list box by 
clicking the left mouse button on the load or tabbing to the list box and using 
the arrow up and down keys. 
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2. Press the DELETE button. 

Defining Support Loads and Displacements  
You may enter prescribed support displacements and rotations as well as apply 
concentrated forces and moments to the system at support locations. These loads 
are input through the Support Loads and Displacements command of the Input 
menu. 

To input support loads and displacements: 

1. Select the Support Loads and Displacements command from the Input 
menu or click the  button on the tool bar. The dialog box of Figure 4-55 will 
appear. 

 
Figure 4-55 Defining Support Loads and Displacements 

2. Select the load case of the support loads and displacements that will be 
defined from the CURRENT CASE list box. 

3. From the SUPPORT drop-down list, select the support number of the support 
whose loads you would like to input. 

4. Define un-factored values of the displacement, rotation, forces, and moment.  
5. Select Add to add the support loads and displacements defined into the load 

list box on the lower part of the dialog box. 
6. Repeat steps 2 through 5 until all the support loads and displacements have 

been entered then press OK button to exit the dialog box so that spSlab will 
use the new moments. 

To change support and displacement loads data: 
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1. Select the entry you want to change from the load list box by clicking the left 
mouse button on the load or tabbing to the list box and using the arrow up and 
down keys. 

2. Make your changes to the values. 
3. Select Modify to replace the old data with the new data. 
To delete support and displacement load data: 

1. Select the entry you want to delete from the load list box by clicking the left 
mouse button on the load or tabbing to the list box and using the arrow up and 
down keys. 

2. Press the DELETE button. 

Defining Lateral Effects  
spSlab can combine the gravity load analysis with a lateral load analysis. Lateral 
loads are entered as joint moments obtained elsewhere by a frame analysis. The 
joint moments are combined with the gravity load moments to produce load 
patterns 5 through 8. 

To input lateral load moments: 

1. Define at least one lateral load case from the Load Cases dialog box.  
2. Select Lateral Effects from the Input menu. If no lateral case is defined this 

command is disabled. Once selected, Figure 4-56 will appear. 

 
Figure 4-56 Lateral Moment dialog box 
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3. Select load cases from the CURRENT CASE list box. At least one lateral load 
case must be defined in the LOAD CASES dialog box before you can see the 
load case in the CURRENT CASE list box. 

4. Select span number on which lateral loads will be defined from the SPAN 
drop-down list. 

5. Enter the moments at the left end and right end of the span in the Moment at 
Left and Moment at Right input boxes, respectively. 

6. Press the ADD button to add the lateral load defined above into the lateral load 
list box in the lower part of the dialog box. 

7. Repeat steps 2 through 5 to define all the lateral loads.  
8. To change an existing lateral load, select the load from the lateral load list box 

then change the moments as mentioned above. Press the MODIFY button when 
finished to update the data in the lateral load list box. 

9. To delete an existing lateral load, select the load from the lateral load list box 
then press the DELETE button. 

10. Select OK button when all the desired lateral loads have been modified to exit 
so that spSlab will use the new data. 

Executing Calculations (menu Solve)   

Execute  
The Execute command starts the design portion of spSlab after you have finished 
inputting all the data.  

To design the system: 

Select the Execute command from the Solve menu or click the  button on the 
tool bar. If any data required to analyze and design the system has not been input 
prior to executing this command, spSlab will display an "Invalid model!" message. 
You must complete the data before execution.  

An analysis status window shows the current state of the execution as shown in 
Figure 4-57. If the state of each of the computations is OK, the analysis is 
successful. If any error is encountered ERROR will be shown and the computation 
is terminated. 
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Figure 4-57 Analysis Status Window 

Viewing Results Report  
Once the analysis and/or design is performed, you can view the results, shear and 
moment diagrams, and deflected shapes. This section provides procedures 
performing these functions. 

To view the analysis and design results: 

1. Select Report command from the Solve menu or click the  button from the 
tool bar. A dialog box similar to Figure 4-58 will appear. 

 
Figure 4-58 View and Print Results dialog box 

2. Select the results you want to view from the drop-down list. The contents of 
the results box will be changed based on your selection. The Customize 
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option allows for more than one result selection to be viewed in the results 
report. 

3. Press the COPY button to copy the current results into the Windows clipboard. 
Then you may use CTRL + V to paste the contents of the clipboard to any 
other editors such as Word or Notepad. 

4. Press the CLOSE button to close the result dialog box. 

Saving Results Report  
Analysis and design results are automatically saved to a text file named 
"projectname.out" in the same folder as the project data file (.slb file). The 
contents of the .out file depends on which option is selected from the drop-down 
list on the Results Report dialog box.  

For example, if the project name is "Example 1 - FlatPlate (ACI Note)" and Input 
Echo is selected from the Results Report dialog box as shown in Figure 4-59, 
a text file named "Example 1 - FlatPlate (ACI Note).out" is generated 
automatically in the same directory as "Example 1 - FlatPlate (ACI Note).slb". 

 
Figure 4-59 Input Echo is selected from Results Report dialog box 

The file "Example 1 - FlatPlate (ACI Note).out" is a pure text file and can be 
opened, edited and printed using Word or Wordpad as shown in Figure 4-60. 
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Figure 4-60 Output file is opened using Wordpad 

Note: Once another option is selected from the Results Report dialog box, the 
contents of the .out file is changed based on the selection. 

Output files (.out file) may not be in proper format if opened using Microsoft 
Notepad. Please use Word or Wordpad. 

View Program Output (menu View)   

Zooming in on Floor System  
In order to view the floor system in greater detail, spSlab allows you to magnify 
a portion of the floor system for closer analysis. 

Using zoom with a magnifier: 

1. Select Zoom from the View menu then a sub menu appears beside the View 
menu. 

2. Select Window from the sub menu. Notice that the Window command is 
checked and the cursor is changed to a magnifier. The other way to magnify 
window is to click the  button on the tool bar. 

3. Move the cross cursor to the upper left corner of the portion of the system you 
want to enlarge. 
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4. Press and hold down the left mouse button while dragging the cursor to the 
lower right portion of the system enclosing the desired area within the dashed 
box.  

5. Release the mouse to enlarge that portion. 
Using Zoom In and Zoom Out command: 

1. Select Zoom from the View menu and a sub menu appears. 
2. Select the In(2x) menu command from the sub menu. The current active 

window will be magnified by two times. The other way to do this is to click 
the  button on the tool bar. 

3. Select the Out(0.5x) menu command from the sub menu. The current active 
window will be reduced by two times. The other way to do this is to click the 

 button on the tool bar. 
Note: To return to original (default) zoom, select Restore from the View menu, or 
select  from tool bar. To move model in a view window, use Pan from the View 
menu, or select  from tool bar. 

Change Isometric View Angle  
You can modify the X and Z angles at which the floor system is displayed in the 
isometric view window. By default, the floor system is viewed at -45° about the X 
axis and 45° about the Z axis. The right hand rule is used to determine the angle of 
rotation about the X and Z axes and the X axis is always rotated first. 

To change angles: 

1. Select Change View Angle from the View menu. The dialog box of Figure 
4-61 appears displaying the currently set angles. 

 
Figure 4-61 Isometric View dialog box 

2. Change the angles of rotation about the X and Z axes. The X axis is rotated 
first then the Z axis is rotated. The floor system is rotated about the axis using 
the right hand rule. 
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3. Select OK button to accept the new angles and to modify the isometric view. 
Note: A more convenient way to change the view angles instantly without entering 
angles in the dialog box is to use the keyboard shortcut CTRL + ARROW Keys. 
For example, press CTRL +  and CTRL +  to rotate the floor system around Z 
axis and press CTRL +  or CTRL +  to rotate around X axis. 

Viewing Specific Member Type  
In order to see the floor system members in greater detail, you can select specific 
member types to view by enabling and disabling them. 

To select member type: 

1. Select the View Options command from the View menu. The dialog box of 
Figure 4-62 will appear showing the currently displayed member types. 
Depending on the floor system, some of the member types will be shaded gray 
and unavailable. 

 
Figure 4-62 View Options dialog box 

2. To hide a member type from a view of the floor system you must remove the 
 sign from the check box. Click the left mouse button on the check box of 

the member type you would like to hide. To view a previously hidden member 
type, click the left mouse button on the check box to add the  sign to the 
check box. 

3. Select OK button to view only the selected member types. 

Plan View  
To switch to plan view: 

1. Select the Plan View command from the View menu or click  button on the 
tool bar. The dialog box of Figure 4-63 will appear.  
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Figure 4-63 Plan View Window 

2. Right click on the view window to show the pop-up menu. You may save the 
current view window as bitmap (BMP) file or metafile (EMF) on the 
Windows clipboard by selecting Copy Bitmap or Copy Metafile, respectively. 
You may also select the commands from the pop-up menu to zoom in or zoom 
out the view window and preview it before printing it out.  

 
Figure 4-64 Pop-up Menu of View Window 

3. Select the Options command from the pop-up menu, and then you may 
decide what geometry members need to be shown on the view window as 
shown in Figure 4-65. To hide a member type from a view of the floor system 
you must remove the  sign from the check box. Click the left mouse button 
on the check box of the member type you would like to hide. To view a 
previously hidden member type, click the left mouse button on the check box 
to add the  sign to the check box. 
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Figure 4-65 Geometry Options of Plan View 

4. Select OK button to view only the selected member types. 

Elevated View  
To switch to elevated view: 

1. Select the Elevated View command from the View menu or click  button 
from the tool bar. The dialog box of Figure 4-66 will appear.  

 

 
Figure 4-66 Elevated View Window 

2. Right click on the view window to show the pop-up menu. You may save the 
current view window as bitmap (BMP) file or metafile (EMF) onto the 
Windows clipboard by selecting Copy Bitmap or Copy Metafile, respectively. 
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You may also select the commands from the pop-up menu to zoom in or zoom 
out the view window and preview it before printing it out.  

 
Figure 4-67. Pop-up Menu of View Window 

3. Select the Options command from the pop-up menu, and then you may 
decide what geometry members need to be shown on the view window as 
shown in Figure 4-68. To hide a member type from a view of the floor system 
you must remove the  sign from the check box. Click the left mouse button 
on the check box of the member type you would like to hide. To view a 
previously hidden member type, click the left mouse button on the check box 
to add the  sign to the check box. 

 
Figure 4-68 Geometry Options of Elevated View 

4. Select OK button to view only the selected member types. 

Side View  
To switch to side view: 

1. Select the Elevated View command from the View menu or click  button 
from the tool bar. The dialog box of Figure 4-69 will appear.  
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Figure 4-69 Side View Window 

2. Right click on the view window to show the pop-up menu. You may save the 
current view window as bitmap (BMP) file or metafile (EMF) onto the 
Windows clipboard by selecting Copy Bitmap or Copy Metafile, respectively. 
You may also select the commands from the pop-up menu to zoom in or zoom 
out the view window and preview it before printing it out.  

 
Figure 4-70 Pop-up Menu of View Window 

3. Select the Options command from the pop-up menu, and then you may 
decide what geometry members need to be shown on the view window as 
shown in Figure 4-71. To hide a member type from a view of the floor system 
you must remove the  sign from the check box. Click the left mouse button 
on the check box of the member type you would like to hide. To view a 
previously hidden member type, click the left mouse button on the check box 
to add the  sign to the check box. 
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Figure 4-71 Geometry Options of Side View 

4. Select OK button to view only the selected member types. 

Isometric View  
To switch to isometric view: 

1. Select the Isometric View command from the View menu or click  button 
on the tool bar. The dialog box of Figure 4-72 will appear.  

 
Figure 4-72 Isometric View Window 

2. Right click on the view window to show the pop-up menu. You may save the 
current view window as bitmap (BMP) file or metafile (EMF) onto the 
Windows clipboard by selecting Copy Bitmap or Copy Metafile, respectively. 
You may also select the commands from the pop-up menu to zoom in or zoom 
out the view window and preview it before printing it out.  
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Figure 4-73 Pop-up Menu of View Window 

3. Select the Options command from the pop-up menu, and then you may 
decide what geometry members need to be shown on the view window as 
shown in Figure 4-74. To hide a member type from a view of the floor system 
you must remove the  sign from the check box. Click the left mouse button 
on the check box of the member type you would like to hide. To view a 
previously hidden member type, click the left mouse button on the check box 
to add the  sign to the check box. 

 
Figure 4-74 Geometry Options of Isometric View 

4. Select OK button to view only the selected member types. 

Loads  
To show the loads: 

1. Select the Loads command from the View menu or click  button from the 
tool bar. The dialog box of Figure 4-75 will appear.  
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Figure 4-75 Loads View Window 

2. Right click on the view window to show the pop-up menu. You may save the 
current view window as bitmap (BMP) file or metafile (EMF) onto the 
Windows clipboard by selecting Copy Bitmap or Copy Metafile, respectively. 
You may also select the commands from the pop-up menu to zoom in or zoom 
out the view window and preview it before printing it out.  

 
Figure 4-76 Pop-up menu of View Window 

3. Select the Options command from the pop-up menu, and then you may 
decide what kind of loads need to be shown on the view window as shown in 
Figure 4-77. To hide a load case, load type, or live load pattern you must 
remove the  sign from the check box. Click the left mouse button on the 
check box of the member type you would like to hide. To view a previously 
hidden load type, click the left mouse button on the check box to add the  
sign to the check box. 
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Figure 4-77 Loads Options 

4. If you want to hide the load values, remove the  sign before SHOW VALUES 
check box.  

5. If you want to hide the load units, remove the  sign before SHOW UNITS 
check box.  

6. Select OK button to view only the selected member types. 

View Graphical Results  

Viewing Internal Forces Diagrams  
Once the design has been performed, you may view the shear, moment, and 
internal torque (beams/one-way slab systems with torsion) diagrams for any span 
at any available load combination. 

To view shears and moments diagram: 

1. Select the Internal Forces command from the View menu or click the  
button on the tool bar. A view window similar to Figure 4-78 will appear. The 
upper half view window shows the shear diagram and the lower half the view 
window shows the moment diagram. If torsion is enabled for beams/one-way 
slab systems than internal torque diagram will also be shown in this window. 
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Figure 4-78 View Internal Forces Diagram 

2. The current coordinate values can be captured based on the position of the 
mouse cursor. The status bar in Figure 4-79 shows the name of the diagram, 
two coordinate values of the current mouse cursor position, and the current 
design code used in the project. 

 
Figure 4-79. Coordinate Value Shown in Status Bar 

3. Click the right mouse button anywhere on the view window to show the pop-
up menu. You may Restore, Zoom, Pan or Print View directly by selecting 
commands from this pop-up menu. 

4. Click the Options command from the pop-up menu to change the span for 
which the internal forces diagrams will be shown and to choose if legend will 
be displayed or not. Figure 4-80 shows the OPTIONS dialog box. Select a span 
number from the SHOW DIAGRAM FOR drop-down list and select a load 
Envelope or combination from the SELECT LOAD COMBINATIONS check list 
box. Use DRAW LEGEND checkbox to control whether legend is drawn or not. 
Press the OK button to close the dialog box and redraw the view windows. 
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Figure 4-80 View Internal Forces Diagram Options 

Note: The pop-up menu can be accessed from each of the view windows of spSlab. 

The Restore command cannot be executed in the pop-up menu until the Zoom or 
Pan command is stopped by pressing the ESC key. Without stopping the 
Zoom/Pan command, one can only restore a view using the Restore command in 
View menu or  button in the tool bar. This occurs in all spSlab view windows. 

Viewing Moment Capacity  
Once the design has been performed, you may view the moment capacity diagrams 
for any span at any available loading pattern. The moment capacity window will 
be split in half horizontally. The middle strip moment capacity will occupy the 
upper half and the column strip moment capacity will occupy the lower half where 
each diagram will be scaled to fill the entire half of the window.  

To view moment capacity: 

1. Select the Moment Capacity command from the View menu or click the  
button on the tool bar. A view window similar to Figure 4-81 will appear. 

2. Right click on the Moment Capacity view window and select Options 
command from the pop-up menu. A dialog box similar to Figure 4-82 will 
appear. 

3. The current coordinate values can be captured based on the position of the 
mouse cursor. The status bar shows the name of the diagram, two coordinate 
values of the current mouse cursor position, and the current design code used 
in the project. 

4. Click the right mouse button anywhere on the view window to show the pop-
up menu. You may Restore, Zoom, Pan or Print View directly by selecting 
commands from this pop-up menu. 
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Figure 4-81 View Moment Capacity Diagram 

5. Click the Options command from the pop-up menu to change the span for 
which the moment capacity will be shown. Select which span will be shown 
in the SHOW DIAGRAM FOR drop-down list. Use DRAW LEGEND checkbox to 
control whether legend is drawn or not. Select which part of the selected span 
will be shown in the Show frame box. 
To view capacity of longitudinal reinforcement, use COMBINED M-V-T 
checkbox (Figure 4-82b) for beams designed or investigated per CSA A23.3-
04188 with Combined M-V-T option. 

6. Press the OK button to close the dialog box and redraw the view windows. 

                                                           
188 CSA A23.3-04, 11.3.9.2, 11.3.9.3, 11.3.10.6 
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a)   b)  

Figure 4-82 View Moment Capacity Option dialog box (a) two-way system 
(b) beam with M-V-T option selected in Solve Options (CSA A23.3-04 only) 

Viewing Shear Capacity  
Once the design has been performed, you may view the slab shear capacity 
diagrams for any span at any available loading pattern.  

To view shear capacity: 

1. Select the Shear Capacity command from the View menu or click the  
button on the tool bar. A view window similar to Figure 4-83 will appear. 

 
Figure 4-83 View Shear Capacity 



 

Operating spSlab/spBeam  4-79 

2. Right click on the Shear Capacity view window and select Options command 
from the pop-up menu. A dialog box similar to Figure 4-84 will appear. 

a)  b)  

Figure 4-84 View Shear Capacity Option dialog box(a) One-way and two-
way system (b) Two-way system with shear distributed to slab strips 

3. The current coordinate values can be captured based on the position of the 
mouse cursor. The status bar shows the name of the diagram, two coordinate 
values of the current mouse cursor position, and the current design code used 
in the project. 

4. Click the right mouse button anywhere on the view window to show the pop-
up menu. You may Restore, Zoom, Pan or Print View directly by selecting 
commands from this pop-up menu. 

5. Click the Options command from the pop-up menu to change the span for 
which the shear capacity will be shown. Select which span will be shown in 
the SHOW DIAGRAM FOR drop-down list. Use DRAW LEGEND checkbox and 
CRITICAL SECTION checkbox to control if the legend and critical sections are 
drawn or not. Select which part of the selected span will be shown in the 
SHOW frame box. 

6. Press the OK button to close the dialog box and redraw the view windows. 

Viewing Reinforcement  
Once the design has been performed, you may view the reinforcement diagrams 
for any span at any available loading pattern. The reinforcement window will be 
split in half horizontally. The middle strip reinforcement will occupy the upper 
half, and the column strip reinforcement will occupy the lower half where each 
diagram will be scaled to fill the entire half of the window.  

To view reinforcement: 

1. Select the Reinforcement command from the View menu or click the  
button on the tool bar. A view window similar to Figure 4-85 will appear. 
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Figure 4-85 View Reinforcement 

2. Right click on the Reinforcements view window and select Options command 
from the pop-up menu. A dialog box similar to Figure 4-86 will appear. 

3. The current coordinate values can be captured based on the position of the 
mouse cursor. The status bar shows the name of the diagram, coordinate value 
of the current mouse cursor position in the design direction, and the current 
design code used in the project. 

4. Click the right mouse button anywhere on the view window to show the pop-
up menu. You may Restore, Zoom, Pan or Print View directly by selecting 
commands from this pop-up menu. 
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Figure 4-86 View Reinforcement Options dialog box 

5. Click the Options command from the pop-up menu to change the span for 
which the shear capacity will be shown. Select the span you want to show 
from the Show diagram for drop-down list. Select which part of the selected 
span will be shown from the Show frame box. Checking the SHOW REBAR 
LABELS will show labels beside each reinforcement on the view. Similarly bar 
length can be included by checking INCLUDE BAR LENGTH. Bar labels can 
also be arranged vertically if ROTATE BAR LABELS is checked. Set the vertical 
scale (relative to the horizontal scale which is set automatically) to which 
members are drawn in the SLAB THICKNESS SCALE edit box. 

6. Press the OK button to close the dialog box and redraw the view windows. 

Viewing Deflected Shapes  
Once the design has been performed, you may view the deflection shapes for any 
span at any available loading pattern.  

To view the deflection shapes: 

1. Select the Deflection command from the View menu or click the  button on 
the tool bar. A view window similar to Figure 4-87 will appear. 

2. Right click on the deflection view window and select Options command from 
the pop-up menu. A dialog box similar to Figure 4-88 will appear. 

 
Figure 4-87 View Deflection Diagram 
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3. The current coordinate values can be captured based on the position of the 
mouse cursor. The status bar shows the name of the diagram, two coordinate 
values of the current mouse cursor position, and the current design code used 
in the project. 

4. Click the right mouse button anywhere on the view window to show the pop-
up menu. You may Restore, Zoom, Pan or Print View directly by selecting 
commands from this pop-up menu. 

 
Figure 4-88 View Deflection Option dialog box 

5. Click the Options command from the pop-up menu to change the span for 
which the deflection will be shown. Select the span you want to show from 
the SHOW DIAGRAM FOR drop-down list. Check the Draw Legend checkbox to 
include the legend in the drawing. Enter the scale factor in the SCALE FACTOR 
edit box. The bigger the scale factor, the more apparent the deflections will be 
on the diagram.  

6. Press the OK button to close the dialog box and redraw the view windows. 

Print Results  

Printing Analysis and Design Results  
Once the analysis and/or design is performed, you can print the results. This 
section provides procedures for performing these functions. 

To print the analysis and design results: 

1. Select Report command from the Solve menu or click the  button from the 
tool bar. A dialog box similar to Figure 4-89 will appear. 
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Figure 4-89 View and Print Results dialog box 

2. Select the results you want to view from the drop-down list. The contents of 
the results list box will be changed based on your selection. 

3. Press the PRINT button on the dialog box to print the results through a printer. 
The printer could be a local printer which is connected to your computer 
directly, or a network printer. 

4. Press the CLOSE button to close the result dialog box. 

Printing Current View Window  
Once the design has been performed, you may print the diagrams and views for 
any span at any available loading pattern by selecting the Print View command 
from the File menu. 

To print a displaying window: 

1. To select the diagram or view you want to print, single click the left mouse 
button on the diagram or view window. 

2. Select the Print View command from the File menu. A print preview window 
similar to Figure 4-90 will be shown. 
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Figure 4-90 Print Preview of a View Window 

3. Press the ZOOM IN or ZOOM OUT buttons or simply click the left mouse button 
on the preview to magnify or reduce the size of the preview paper.  

4. Press the NEXT PAGE button if more than one page need to be printed. 
5. Press the PRINT button to print the view. The printer could be a local printer 

which is connected to your computer directly, or a network printer. 
6. Press the CLOSE button to close the preview window and go back to spSlab. 

Print Preview  
The Print Preview command allows you to preview and print the current view 
window (floor system geometry in the plan, elevated and isometric views, prints 
the shear and moment diagrams, and the deflected shapes).  

1. To obtain a view window you must first perform the design, then select what 
you want to view from the View menu. You may have more than one view 
window opened. The current view window is the one activated and on top of 
the others on your screen.  
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2. Selecting this command closes the spSlab main window and opens the print 
preview window as shown in Figure 4-90.  

3. On the print preview window, press the ZOOM IN or ZOOM OUT buttons or 
simply click the left mouse button on the preview window to magnify or 
reduce the size of the preview paper.  

4. Press the NEXT PAGE button if more than one page needs to be printed.  
5. Press the PRINT button to print the view. The printer could be a local printer 

which is connected to your computer directly, or a network printer.  
6. Press the CLOSE button to close the preview window and go back to spSlab. 

 
Figure 4-91 Print Preview Window 

Copy Graphs to Clipboard  

Copy Bitmap (BMP format)   
spSlab can copy any of the ten view windows onto Windows clipboard as bitmap. 
The bitmap on clipboard can then be pasted into Microsoft Word or other 
Windows applications including presentation software such as Microsoft 
PowerPoint. 
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To copy view window to clipboard as bitmap: 

1. Select the view window that will be copied by single clicking left mouse 
button on it. 

2. Select  from the tool bar to copy the selected view window to clipboard. 
3. Switch to other word processing software, such as Microsoft Word, then press 

the CTRL + V to paste the bitmap on clipboard to a Word file. 

Copy Metafile (EMF format)   
Since bitmap files cannot easily be resized or re-proportioned without significant 
distortion to the image, metafiles are generally used for situations requiring 
scalability of the image. 

Advantages of metafiles are: 

• Large, simply structured images require less memory than bitmaps for display 
and make optimal use of the resolution of the output device. 

• Metafiles can be resized with none of the distortion which normally 
accompanies resizing of bitmaps. 

• A metafile can contain SelectPalette statements, allowing custom palettes to 
be displayed in applications such as Microsoft Word. 

The Enhanced MetaFile (EMF) format is an extension of the Windows metafiles 
format developed for use with 32 bit Windows applications. It is only available to 
native 32 bit applications. 

To copy view window to clipboard as Enhanced MetaFile (EMF): 

1. Select the view window that will be copied by single clicking left mouse 
button on it. 

2. Select  from the tool bar to copy the selected view window to clipboard. 
3. Switch to other word processing software, such as Microsoft Word, then press 

the CTRL + V to paste the bitmap on clipboard to a Word file. 

Customizing Program (menu Options)   

Changing Colors  
Colors can be changed for background of views, geometry items such as slabs and 
beams, text on views, result diagrams, etc. 

To change colors: 
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1. Select Colors command from the Options menu. Figure 4-92 will appear. 

 
Figure 4-92 Changing Colors dialog box 

2. From the General frame box on the left side, select the item whose color 
needs to be changed from the list box. 

3. Select a color from the Change color to drop-down list. Once a new color is 
selected from the drop-down list the color in the list box above the drop-down 
list is updated instantly. 

4. From the Results category box on the right side, select the item whose color 
needs to be changed from the list box. 

5. Select a color from the Change color to drop-down list. Once a new color is 
selected from the drop-down list the color in the list box above the drop-down 
list is updated instantly. 

6. If you want to print views in black and white, select the Print Black and 
White check box. 

7. If you want to save the settings as default, select the Save setting for future 
use check box. 

8. Input the line thickness in the Printed Line Thickness edit box. The diagram 
line thickness will be based on the number you input. 

9. Press the OK button to save the settings and close the dialog box. 

Changing Fonts  
Fonts can be selected separately for both the graphical output and the text output 
via Options|Font command. 
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To change the graphical output font: 

1. Select the Font|Graphical Output command from the Options menu. 
A view window similar to Figure 4-93 will appear. 

 
Figure 4-93 Changing Graphical Output Font dialog box 

2. Select the font, font style and size from the lists. Font sizes different from 
those on the list can be typed in the Size text box. 

3. In the EFFECT frame select if strikeout and/or underline effect have to be 
applied. Alternatively to the COLOR dialog box, the font color can be chosen 
in this dialog box too. 

4. The script of the font by default is Western and should not be changed. 
5. Press the OK button to save the new setting and close the dialog box. 

 
Figure 4-94 Changing Text Output Font dialog box 

To change the text output font follow the same procedure as for the graphical 
output font except that font effects are not available for text output and the list of 
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fonts only contains non-proportional fonts which are suitable for tabulated text 
output (Figure 4-94). 

Changing Startup Defaults  
To change the startup defaults: 

1. Select the Startup Defaults command from the Options menu. A view 
window similar to Figure 4-95 will appear. 

 
Figure 4-95 Changing Startup Defaults dialog box 

2. Input the name of the engineer in the Engineer edit box. The name of the 
engineer will be shown on the view print. 

3. Select the design code from the Design code drop-down list. Four design 
codes are available: ACI 318-08, ACI 318M-08, ACI 318-05, ACI 318M-05, 
ACI 318-02, ACI 318M-02, ACI 318-99, ACI 318M-99, CSA A23.3-04,  
CSA A23.3-04E, CSA A23.3-94 and CSA A23.3-94E. 

4. Select the rebar database from the Rebar database drop-down list. Four 
defined databases are available: ASTM A615, ASTM A615M, CSA G30.18 
and prEN 10080. If you would like to use rebar defined by yourself, select the 
User Defined from the drop-down list. You may define your own rebar 
database by selecting the Rebar Database from the Options menu. 

5. Press the OK button to save the new setting and close the dialog box. 

Changing Rebar Database  
User can define his own reinforcement database. The defined database, such as 
ASTM A615M, cannot be changed. 

To change the reinforcement database: 

1. Select the Rebar Database from the Options menu. Figure 4-96 will appear. 
2. Select User-defined from the Current Bar Set drop-down list. Rebar data of 

the other databases can only be viewed and cannot be changed. 
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Figure 4-96 Changing Reinforcement Database 

3. To select the reinforcement that needs to be changed from the reinforcement 
list box, single click the left mouse button on it. The size, diameter, area, and 
weight of the selected bar are shown in the corresponding text boxes, 
respectively.  

4. Enter the new values of bar size, diameter, area, and weight. 
5. Press the ADD button to add the bar as a new bar into the reinforcement list 

box on the lower part of the dialog box. If any data inconsistency is found by 
spSlab, an error of "Inconsistent bar data" will be shown.  

6. Press the MODIFY button to update an existing bar. 
7. To delete a bar, select the bar from the reinforcement list box then click the 

DELETE button.  
8. After finishing the definitions of your own reinforcement database, you may 

save them into a file on the hard drive by pressing the SAVE TO FILE button 
and specifying a file name for your database. This file can be imported into 
spSlab by pressing the READ FROM FILE button. 

Working with View Windows (menu Window)   

Cascade  
The Cascade command displays all the open windows in the same size, arranging 
them on top of each other so that the title bar of each is visible. The current active 
view widow will be on the top after the execution of the Cascade command. 
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Tile Horizontal  
The Tile Horizontal command arranges all open windows horizontally so that no 
window overlaps another. The current active view widow will be on the most left 
or on the upper-left corner of the screen after the execution of the Tile Horizontal 
command. 

Tile Vertical  
The Tile Vertical command arranges all open windows vertically so that no 
window overlaps another. The current active view widow will be on the most left 
or on the upper-left corner of the screen after the execution of the Tile Vertical 
command. 

Remaining Commands  
The remaining menu items are in a list of the windows that are available for 
viewing. Selecting any window from this menu will restore the window to its 
previous size and position from an icon.  

Obtaining Help Information (menu Help)   

Opening Table of Contents of the Help System  
To open table of contents of the Help system: 

1. Select Help Topics from the Help menu. 
2. Select the chapter you need from the content tree view in the left pane of the 

Help window. The contents of the selected chapter appear in the right pane of 
the Help window. 

Displaying Help Topic Associated with Selected Element  
To display the topic associated with the selected element: 

1. Select Context Help from the Help menu. The mouse cursor changes to  
2. Click the element for which you need information about. The program will 

display the topic which is associated with the element you clicked. 

Obtaining Information about the Program  
The following information about the program is displayed in the ABOUT SPSLAB 
dialog box: 

• program version and short description 
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• licensing information 

• the copyright information 

The licensing information depends on the type of license being used. If it is a trial 
license then the LICENSE EXP field shows when the trial period expires and the 
LOCKING CODE field displays a unique fingerprint of the computer on which the 
program is running. This locking code needs to be provided to StructurePoint in 
order to generate a permanent license. For other, non-trial licenses, license ID is 
displayed. You may be asked to provide this ID when you contact StructurePoint 
for technical support. 

To obtain the information about the program: 

1. Select the About spSlab command from the Help menu. A dialog box of 
Figure 4-97 will appear.  

a)

 

 

b)

 

 
Figure 4-97 About spSlab dialog boxes with 

(a) a trial license (b) a network license 

2. Press OK button to exit the dialog box. 



 

Chapter 5 – Output Description 
Output Description 

Output Elements  
spSlab generates the text and graphical output of the input data and the results of 
the calculations. The text output is generated when user opens the Results Report 
dialog window. An ASCII text file is generated in the same sub-folder as the input 
data file. The name of the output file is created by adding the extension ".OUT" to 
the name of the input data file. Depending on the report options selected, the text 
output will contain a selection of the following sections (see the illustrated 
examples in the following chapter): 

• Program Information 

• [1] Input Echo 

• [2] Design Results 

• [3] Column Axial Forces And Moments 

• [4] Internal Forces – Load Cases 

• [5] Internal Forces – Load Combinations 

• [6] Internal Forces – Envelopes 

• [7] Deflections 

• [8] Required Reinforcement 

Program Version  
The program version number appears at the top of each report page along with the 
licensing and copyright information. Additionally, legal disclaimer is displayed on 
the first page of the text output. 
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Input Echo  
Section Input Echo reports the data used in the analysis. spSlab defaults common 
data; all other data must be input. Carefully check the contents of the section and 
compare it with the intended design model. The following paragraphs describe the 
blocks included in the section. 

General Information   
This block is similar in its content to the dialog window General Information. It 
contains the information on project input data file name, project description, 
selected design code and units, selected reinforcement database, calculation mode 
(design or investigation), number of supports, cantilevers. The selections available 
in the SOLVE OPTIONS dialog box are also listed in this block. 

Material Properties  
This block contains the information on concrete properties for slabs, beams and 
columns. It also contains the information on reinforcing steel properties for slabs 
and beams. 

Reinforcement Database   
This block lists the properties of the bars from the bar table selected for the 
project. Bar diameter, cross-section area and unit weight for each bar are reported. 
The values reported are consistent with the units used in particular model. 

Span Data   
This block is similar in its content to the dialog window Span Data. The block is 
divided into two parts. First part reports the span-by-span geometry of the concrete 
slab (length, left and right side width, depth and code required minimum 
thickness). The second part contains the span-by-span geometry of longitudinal 
beams and ribs (for joist slabs). 

Support Data  
This block is similar in its content to the dialog window Support Data. The block 
is divided into four parts. The first part reports the geometry of top and bottom 
columns and the stiffness share factor. For circular column the transverse 
dimension C2 is reported as zero. The second part contains the geometry of drop 
panels: thickness, lengths, widths. If dimensions of a drop panel are invalid it will 
be marked. Invalid or excessive drop panel geometry is not used in the analysis. 
The third part contains the geometry of column capitals: depth, slope 
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(depth/extension ratio), extensions. The fourth part contains the geometry of 
transverse beams: width depth, eccentricity (offset) from column centroid. 

Load Data   
This block contains the complete information on load input. The block is divided 
into three parts. The first part reports the defined load cases, load combinations 
and corresponding load factors. This part summarizes the contents of the dialog 
windows Load Cases and Load Combinations. The second part reports the 
magnitudes of defined span loads. It summarizes the contents of the dialog 
window Span Loads. The third part reports the magnitudes of lateral actions (joint 
moments) if defined in the model. It summarizes the contents of the dialog 
window Lateral Load Effects. 

Reinforcement Criteria   
This block is similar in its content to the dialog window Reinforcement Criteria. 
The block is divided into three parts. The first part reports the requirements for 
slab and rib bars. The second part reports the requirements for longitudinal beams. 
Both parts contain the information on bar sizes, covers, spacings, and user selected 
allowable steel percentages. The requirements for top and bottom bars are given. 
For longitudinal beams additionally the criteria for transverse bars (stirrups) are 
listed. 

Reinforcing Bars  
This block is available only when Investigation Mode is selected. This block is 
similar in its content to the dialog window Reinforcing Bars. The block is divided 
into three parts. The first part reports the span-by span user selected top bars for 
column, middle and beam strips accordingly. Similarly, the second part reports the 
user selected bottom bars for column, middle and beam. For longitudinal bars the 
program reports bar sizes, lengths and concrete cover. The third part presents the 
beam transverse reinforcement (stirrups) defined by the user. 

Note: When switching from Design Mode to Investigation Mode, spSlab 
automatically assumes the results of the Design Mode as an input for Investigation 
Mode. 

Design Results  
Section Design Results presents the summary of the design results of the slab 
system. The following paragraphs describe the blocks included in the section. 
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Strip Data and Moment Distribution   
This block is available only for two-way systems. It contains the information on 
design strip width and moment distribution factors. 

Top Reinforcement   
This block is available only when Design Mode is selected. It reports the negative 
reinforcement requirements. The block contains the values of corresponding 
design strip widths (column, middle, and beam), maximum factored design 
moments per strip and critical location, minimum and maximum steel areas, bar 
spacings, steel areas required by ultimate condition, selected bar sizes and 
numbers. The quantities are given for left, center and right location of each span. 
For a detailed discussion, see Chapter 2, "Area of Reinforcement".  

Note: This block does not include reinforcement quantities necessary to transfer 
unbalanced moments at supports. 

Top Bar Details   
The block contains a span-by-span listing of the longitudinal bars selected in 
column, middle and beam strips. This reinforcement schedule is intended as a 
guide for bar placement. In more complex cases the bar schedule selected by the 
program may have to be adjusted by the user for constructability reasons. The 
selected bar sizes are limited by user specified minimum and maximum sizes. Bar 
sizes and numbers are selected to satisfy the minimum and required steel areas in 
conjunction with the bar spacing requirements of the code. The program calculates 
the bar lengths based on the computed inflection points and the recommended 
minima of the code. The bar lengths are adjusted by appropriate development 
lengths. Hooks and bends are not included in bar length tables and figures. For 
beams bars are placed in single a layer (see Figure 2-21), provided there is 
sufficient beam width. For a detailed discussion, see Chapter 4, "Reinforcement 
Selection". 

Note: This block does not include additional reinforcement bars necessary to 
transfer negative unbalanced moment at supports. 

Band Reinforcement at Supports  
This section is available only when the CSA code is selected. It describes how the 
negative reinforcement in column strips should be concentrated over supports. 
This section reports the width of the column strip and the widths of the band strip 
and the remaining strip that the column strip is subdivided into. It also gives the 
area of reinforcement as well as the number of bars required in each strip. The sum 
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of number of bars in the band strip and in the remaining strip should be equal to 
the total number of bars in the column strip over each support. The number of bars 
in the column strip should be consistent with the number of bars listed in the Top 
Bar Details table. 

Note: This block does not include additional reinforcement bars necessary to 
transfer negative unbalanced moment at supports. 

Bottom Reinforcement   
This block is available only when Design Mode is selected. It reports the positive 
reinforcement requirements. The block contains the values of corresponding 
design strip widths (column, middle, and beam), maximum factored design 
moments per strip and critical location, minimum and maximum steel areas, bar 
spacings, steel areas required by ultimate condition, selected bar sizes and 
numbers. The quantities are given for mid-span regions of each span. For 
a detailed discussion, see Chapter 2, "Area of Reinforcement". 

Bottom Bar Details  
This block contains a span-by-span listing of the longitudinal bars selected in 
column, middle and beam strips. The reinforcement schedule is intended as a 
guide for bar placement. In more complex cases the bar schedule selected by the 
program may have to be adjusted by the user for constructability reasons. The 
selected bar sizes are limited by user specified minimum and maximum sizes. Bar 
sizes and numbers are selected to satisfy the minimum and required steel areas in 
conjunction with the bar spacing requirements of the code. The program calculates 
the bar lengths based on the computed inflection points and the recommended 
minimums of the code. The bar lengths are adjusted by appropriate development 
lengths. Hooks and bends are not included in bar length tables and figures. For 
beams bars are placed in single a layer (see Figure 2-21), provided there is 
sufficient beam width. For a detailed discussion, see Chapter 2, "Reinforcement 
Selection". 

Flexural Capacity   
This block lists the selected top and bottom steel areas and corresponding negative 
and positive moment capacity values in each span. The data is subdivided between 
column, middle and beam strips. Each span is subdivided into segments reflecting 
the changes in geometry and bar placement. 
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Longitudinal Beam Shear Reinforcement Required   
This block is available only when Design Mode is selected. It reports the 
requirements of transverse reinforcement for each longitudinal beam. The capacity 
of concrete cross-section φVc in each span is shown. The table contains the 
segmental values of the factored shear force Vu and required intensity of stirrups 
(Av/s). The segmental values cover the distance between left and right critical 
sections, and include locations where there is change of geometry of loading. 

Longitudinal Beam Shear Reinforcement Details  
This block is available only when Design Mode is selected. It is intended as a 
guide for stirrup placement. The output presents the program selected stirrup sizes, 
numbers and spacings. Distances between groups of stirrups are also reported.  

Beam Shear (and Torsion) Capacity  
If torsion is not considered then this block lists the concrete section shear capacity 
φVc, selected stirrup intensities and spacings and corresponding beam shear 
capacity φVn values in each span. The maximum factored shear forces Vu in beam 
strip along the span is also reported. 

In the case of combined shear and torsion analysis (beams/one-way slab systems 
only), this block lists section properties, shear and torsion transverse reinforcement 
capacity, and longitudinal torsional reinforcement capacity. The provided and 
required capacities are expressed in terms of the provided and required areas of 
reinforcement. 

Slab Shear Capacity   
This block lists the values of one-way slab shear capacity φVc in each span. The 
maximum factored shear force Vu and the location of the critical section Xu are 
also reported. 

Flexural Transfer of Unbalanced Moments at Supports   
There are two blocks reporting the design values for additional reinforcement 
necessary to transfer unbalanced support moments. One block is for negative 
unbalanced moments and the other for positive unbalanced moment. These blocks 
contain the results for critical (effective) section width as per the code, the 
maximum negative or positive unbalanced moment, the corresponding load 
combination and governing load pattern, the reinforcing steel areas provided and 
additional steel required. The provided reinforcement area (main longitudinal bars) 
is reduced by the ratio of critical (effective) strip width to total strip width and 
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does not include the required area due to unbalanced moments. The additional 
reinforcement is the difference between that required by unbalanced moment 
transfer by flexure and that provided for design bending moment. When additional 
reinforcement is required, it is selected based on the bar sizes already provided at 
the support. For a detailed discussion, see Chapter 2, "Area of Reinforcement" and 
"Additional Reinforcement at Support". 

Punching Shear Around Columns  
The block contains two tables with values pertaining to punching shear check in 
critical sections around the columns. The first table lists geometrical properties of 
punching shear critical section. The reported properties of the critical section are 
overall dimensions in the direction of analysis, b1, and in the perpendicular 
direction, b2, perimeter, b0, location of centroid with respect to column center line, 
CG, distance from centroid to the left, cleft, and right, cright, edge of critical section, 
area of concrete resisting shear transfer, Ac, and moment of inertia of critical 
section, Jc. The second table lists two sets of punching shear calculations – direct 
shear alone and direct shear with moment transfer. The output contains the values 
of the allowable shear stress φvc, reactions Vu, unbalanced moments Munb, 
governing load pattern, fraction of unbalanced moment φv, punching shear stress 
vu. The calculation for moment transfer adjusts the unbalanced moment to the 
centroid of the critical section. The "shear transfer" is the unbalanced moment 
multiplied by γv. When calculated shear stress vu exceeds the allowable value φvc, 
the program prints a warning flags for this support. For a detailed discussion, see 
Chapter 2, "Shear Analysis of Slabs". 

Punching Shear Around Drops  
The block contains two tables with values pertaining to punching shear check in a 
critical section around the drop panels. The first table lists geometrical properties 
of punching shear critical section (see description in the Punching shear around 
Columns block). The second table displays the reactions Vu, governing load 
pattern, the punching shear stress around the drop vu, and the allowable shear 
stress φvc. When calculated shear stress vu exceeds the allowable value φvc, the 
program prints a warning flags for this drop panel. For a detailed discussion, see 
Chapter 2, "Shear Analysis of Slabs". 

Integrity Reinforcement at Supports  
This section is available only when the CSA code is selected. It lists the shear 
transferred to the column and the minimum area of bottom reinforcement crossing 
one face of the periphery of a column and connecting slab to the column to provide 
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structural integrity. For a detailed discussion, see Chapter 2, "Integrity 
Reinforcement". 

Corner Reinforcement  
This block refers to the reinforcement required in the exterior corners of a slab 
with beams between columns. The ratio of flexural stiffness of beam section to 
flexural stiffness of slab is listed as well as the area of reinforcement and the 
distance over which the reinforcement is required. The area applies to each layer 
of reinforcement in each direction. For a detailed discussion, see Chapter 2, "Slab 
Corners". 

Shear Resistance at Corner Columns  
This section is available only when the CSA code is selected. It reports results of 
one-way shear check at corner columns. The results include the factored shear 
resistance and the factored shear force at the column. Also, the minimum length of 
the critical shear section and the angle at which the minimum length is obtained 
are listed. For a detailed discussion, see Chapter 2, "Shear Resistance at Corner 
Columns" in “Shear Analysis of Slabs”. 

Deflections  
This block lists the summary of section properties, maximum instantaneous 
deflections and maximum long-term deflections, if they are selected in solution 
options. Also, if a solution option "Gross (uncracked) sections" is selected, only 
gross moment of inertia, Ig, is reported in the section properties table and the 
values of all deflections reported are based on gross section properties. If solution 
option "Effective (cracked) sections" is used, the values of deflections reported are 
based on averaged effective moments of inertia, Ie,avg, which are then reported in 
the section properties table together with other properties of cracked sections. For 
a detailed discussion, see Chapter 2, "Deflection Calculation".  

Material Takeoff   
This block lists the approximate total and unit quantities of concrete, and 
reinforcement. Note that the reinforcement estimate is for one direction only and 
ignores items such as hooks, bends, and waste. For a detailed discussion, see 
Chapter 2, "Material Quantities".  
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Column Axial Forces and Moments  
Section Column Axial Forces and Moments presents the summary of axial forces 
(reactions) and bending moments in bottom and top columns and in springs 
attached to the column-slab joints. Also, moments at far ends of columns are 
reported. If moment redistribution is selected (beams/one-way slab systems only) 
both redistributed and un-redistributed values can be included. The values reported 
represent the loading of a single floor only. Any actions on the columns from the 
floors above must be added to this story’s actions to properly analyze/design the 
columns. The output contains column axial forces and moments due to all load 
cases, including all live load patterns, and all load combinations. Positive axial 
forces mean compression and positive moments mean that fibers on the left hand 
side are in tension for top columns and for bottom column fibers on the right hand 
side are in tension. Also, reactions of additional translational and rotational springs 
applied at joints are reported in this block. Positive values mean upward 
translational spring reaction and clockwise rotational spring reaction. 

Internal Forces - Load Cases  
This section presents the summary of unfactored bending moments and shear 
forces for individual load cases including selfweight, dead load, live load and 
lateral cases. The reported values are presented using span-by-span segmental 
approach. If moment redistribution is selected (beams/one-way slab systems only) 
both redistributed and un-redistributed values can be included. 

Internal Forces - Load Combinations  
This section presents the summary of bending moments and shear forces for each 
load combination. The reported values for each load combination are presented 
using span-by-span segmental approach. The negative and positive values of 
bending moments and shear forces are presented in separate columns in order to 
provide consistent format with enveloped output. If moment redistribution is 
selected (beams/one-way slab systems only) both redistributed and un-
redistributed values can be included. 

Internal Forces - Envelopes  
This section presents the summary of bending moments and shear forces for 
envelope of all load combinations. The reported values are presented using span-
by-span segmental approach. The negative and positive values of bending 



 

5-10  Output Description 

moments and shear forces are presented in separate columns for user convenience. 
The factored values presented in this section are used for design purposes 
(longitudinal and transverse reinforcement). If moment redistribution is selected 
(beams/one-way slab systems only) both redistributed and un-redistributed values 
can be included. 

Deflections  
This section presents the summary of deflections for unfactored (service) load 
cases including selfweight and dead load (DL), live load (LL) and combined 
(DL+LL) load cases. The reported values are presented using span-by-span 
segmental approach. If solution option "Gross (uncracked) sections" is selected, 
the values of deflections reported are based on gross section properties. If solution 
option "Effective (cracked) sections" is used, the values of deflections reported are 
based on substitute effective moment of inertia of the section. For a detailed 
discussion, see Chapter 2, "Deflection Calculation".  

Required Reinforcement  
This section presents the summary of enveloped design moments and the required 
areas of longitudinal reinforcement required for flexure. If combined M-V-T 
option (available only for beam design/investigation per CSA A23.3-04) is 
selected in the Solve Option window then longitudinal reinforcement required for 
combined flexure, shear, and torsion (M-V-T) is also reported with the 
corresponding values of bending moment, shear force, and torsional moment. The 
values are tabulated for every design strip at every design segment. 

Graphical Output  
spSlab provides the following graphical output features: 

• Diagrams of Internal Forces, 

• Moment (and longitudinal reinforcement capacity due to combined M-V-T 
action, available only for beams designed/investigated per CSA A23.3-04) 
Capacity Diagram, 

• Shear (and Torsion) Capacity Diagram, 

• Deflection Diagram, 

• Reinforcement Diagram. 
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These diagram windows can be customized. The Options dialog allows selecting 
either a single span or all spans. Other elements of the graphs can also be 
modified. spSlab print preview of the current graphical window. The user has also 
the choice to export the graphics to a metafile or bitmap file. 

Detailed information on using the graphical output features is included in chapter 
"Operating the Program". 

 





 

Chapter 6 – Examples 
Examples 

In this chapter several examples are presented to demonstrate capabilities of the 
program. Generally program results match closely the results found in the 
referenced text books. When discrepancies are observed, they result from 
variations in assumptions and solutions methods, and numerical accuracy. 

Both beams/one-way slab systems as well as two-way slab systems are presented 
in the examples. The output of beams/one-way slab examples shows that spBeam 
program was used to solve them. This is to illustrate that spBeam program is 
available as a limited version of spSlab including only beams/one-way slab 
capabilities. 

Example 1 Spandrel beam with moment redistribution  

Problem description   
Determine the required reinforcement for the spandrel beam at an intermediate 
floor level as shown, using moment redistribution to reduce total reinforcement 
required. (Note: the self weight is already included in the specified dead load 
below.) This example refers to Example 8-2 from PCA Notes on ACI 318-08 
Building Code Requirements for Structural Concrete, Portland Cement 
Association, 2008. 

Columns:  16 × 16 in. 
Story height: 10 ft 
Spandrel beam: 12 × 16 in. 
f′c = 4000 psi 
fy  = 60,000 psi 
DL = 1167 lb/ft 
LL = 450 lb/ft 
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25' - 0" 15' - 0" 20' - 0"

A B C D

Columns 16" × 16" (typ.)

Spandrel beam
12" × 16" (typ.)

 
Figure 6-1 Example spandrel beam problem 

Preparing Input 
1. From the Input menu, select General Information. A dialog box appears. 

• In the LABELS section, input the names of the project, frame, and 
engineer.  

• In the FRAME section, input 4 for NO OF SUPPORTS.  

• In the FLOOR SYSTEM section, click the radial button next to ONE WAY / 
BEAM.  

• Leave all other options in the General Information tab to their default 
settings of ACI 318-08 design code, ASTM A615 reinforcement, and 
DESIGN run mode option.  

• In the Solve Options tab, click the check box next to MOMENT 
REDISTRIBUTION. Press OK. 
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2. Nothing needs to be changed in the Material Properties menu.  

 

 
3. From the Input menu, select Spans. A dialog box appears. 

• Under the Slabs/Flanges tab, input 25 for LENGTH, 0 for THICKNESS, 
and 0 for WIDTH LEFT and WIDTH RIGHT. Press MODIFY.  

• Press the drop down arrow next to SPAN and select Span 2. Input 15 for 
LENGTH, 0 for THICKNESS, and 0 for WIDTH LEFT and WIDTH RIGHT. 
Press MODIFY.  
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• Press the drop down arrow next to SPAN and select Span 3. Input 20 for 
LENGTH, 0 for THICKNESS, and 0 for WIDTH LEFT and WIDTH RIGHT. 
Press MODIFY.  

• Select the Longitudinal Beams tab. Input 12 for WIDTH and 16 for 
DEPTH. Press MODIFY. 

• Press COPY. Press the CHECK ALL button. Press OK. 

• Press OK again. 
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4. From the Input menu, select Supports. A dialog box appears. 
• Under the Columns tab, input 16 for both the C1 and C2 values in both 

the ABOVE and BELOW rows. Press MODIFY. (Note: the default HEIGHT 
ABOVE and HEIGHT BELOW values of 10 are correct.) 

• Press COPY. Press the CHECK ALL button. Press OK. 

• Under the Moment Redistribution tab, click on SUPPORT 2 in the list in 
the bottom half of the SUPPORT DATA dialog box. 

• Input 20 for both the LEFT and RIGHT REDISTRIBUTION LIMITS. Press 
MODIFY. 

• Press COPY. Click the check box next to SPAN 3. Press OK.  

• Press OK again. 
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5. Nothing needs to be changed in the Reinforcement menu.  

  
6. From the Input menu, select Load Cases. A dialog box appears. 

• Since we are not considering lateral forces, click on WIND in the LABEL 
column on the list in the bottom half of the LOAD CASES dialog box and 
press the DELETE button. 

• Click on EQ in the LABEL column and press the DELETE button. Press 
OK. 



 

Examples  6-7 

 
7. From the Input menu, select Load Combinations. A dialog box appears.  

• Delete all the load combinations by clicking anywhere on the list in the 
bottom half of the LOAD COMBINATIONS dialog box and pressing the 
DELETE button. Repeat this procedure until all the load combinations are 
gone.  

• Input 0 in the SELF field, 1.2 in the DEAD field, and 1.6 in the LIVE 
field. Press ADD. 

• Press OK. 

 
8. From the Input menu, select Span Loads. A dialog box appears. 

• Press the drop down arrow next to TYPE, and select LINE LOAD. 
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• Input 1167 for both the START and END MAGNITUDE.  

• Input 25 for the END LOCATION. Press ADD. 

• Use the drop down arrow next to SPAN to select SPAN 2. Keep the START 
and END MAGNITUDES of 1167 lb/ft but change the END LOCATION to 
15. Click the ADD button. 

• Again use the drop down arrow next to SPAN to select SPAN 3. Keep the 
START and END MAGNITUDES of 1167 lb/ft but change the END 
LOCATION to 20. Click the ADD button 

 
9. In the top left corner of the SPAN LOADS dialog box, there is a section called 

CURRENT CASE. Click on LIVE. 
• Use the drop down arrow next to SPAN to select SPAN 1. 

• Making sure that LINE LOAD is still the selected LOAD TYPE, input 450 
for both the START and END MAGNITUDE. 

• Input 25 for the END LOCATION. Press ADD. 

• Use the drop down arrow next to SPAN to select SPAN 2. Keep the START 
and END MAGNITUDES of 450 lb/ft but change the END LOCATION to 15. 
Click the ADD button. 

• Again use the drop down arrow next to SPAN to select SPAN 3. Keep the 
START and END MAGNITUDES of 1167 lb/ft but change the END 
LOCATION to 20. Click the ADD button 
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• Press OK. 

 
10. From the Solve menu, select Execute. Press CLOSE. 
11. From the Solve menu, select Results Report. 

• Use the scroll bars to scroll through the results file.  

• Use the ARROW keys or the mouse wheel to browse through different 
parts of the results quickly. Press the CLOSE button to close the RESULTS 
REPORT dialog box and return to spBeam. 

12. To view diagrams, select Loads, Internal Forces, Moment Capacity, Shear 
Capacity, Deflection, or Reinforcement from the View menu. Right click in 
any of these diagrams to get new copy, printing, or display options.  

13. You may print the results file by selecting Print Results from the File menu. 
To print any of the diagrams you selected to view, use the Print Preview 
command found by right clicking in the diagram’s window. After viewing the 
results, you may decide to investigate the input beams under the same loads 
but with a modified reinforcement configuration.  

14. From the Input menu, select General Information. In the General 
Information dialog box change the RUN MODE option to INVESTIGATION. Do 
not change any of the other options. Press OK 

15. From the Input menu, select the different commands under Reinforcement 
Criteria and Reinforcing Bars to modify the reinforcement configuration 
computed by the program. 

16. Repeat steps 10 and subsequent to perform the investigation and view the 
results.  
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Text Output 
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Graphical Output 

Loads 
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Internal Forces 
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Moment Capacity 
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Shear Capacity 
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Deflection 
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Reinforcement 
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Example 2 Spandrel beam with torsion  

Problem description 
Design a precast, nonprestressed concrete spandrel beam for combined shear and 
torsion. Roof members are simply supported on spandrel ledge. Spandrel beams 
are connected to columns to transfer torsion. Continuity between spandrel beams is 
not provided. This example refers to Example 13-1 from PCA Notes on ACI 318-
08 Building Code Requirements for Structural Concrete, Portland Cement 
Association, 2008. 

 

40' - 0" 40' - 0" 40' - 0" 40' - 0"

70' - 0"

A

A

16" × 16"
P/C cols

16" × 16"
P/C cols

“L” spandrel beam

10' - 0" × 30" + 2"
double tee (typ)

Interior ledge beam

Partial plan of precast roof system

R
oo

f s
pa

n

 
Design Criteria: 
Live load  =  30 lb/ft2 
Dead load =  90 lb/ft2 (double tee + topping + insulation + roofing) 
f′c =  5000 psi (wc = 150 pcf) 
fy  =  60,000 psi 

Roof members are 10 ft wide double tee units, 30 in. deep with 2 in. topping.. 
Design of these units is not included in this design example. For lateral support, 
alternate ends of roof members are fixed to supporting beams. 
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48"

8"

16"

8"

4"

12"

Section A-A
CL col

30" TT

3/8" welded pad
(reverse ends on alternate TT’s)

3/8" elastomeric pad

2"
topping

 

Preparing Input 
1. From the Input menu, select General Information. A dialog box appears. 

• In the LABELS section, input the names of the project, frame, and 
engineer.  

• In the FRAME section, input 2 for NO OF SUPPORTS.  

• In the FLOOR SYSTEM section, click the radial button next to ONE WAY / 
BEAM.  

• Leave all other options in the General Information tab to their default 
settings of ACI 318-08 design code, ASTM A615 reinforcement, and 
DESIGN run mode option.  

• In the Solve Options tab, click the check box next to TORSION ANALYSIS 
AND DESIGN. 

• Under TORSION TYPE, click the radial button next to EQUILIBRIUM.  

• Under the heading STIRRUPS IN FLANGES, click the radial button next to 
YES. 
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• Press OK.  

   
2. From the Input menu, select Material Properties. A dialog box appears. 

• Input 5 for Comp. strength for both Slabs and Beams and Columns.  

• Press OK.  

 
 

3. From the Input menu, select Spans. A dialog box appears. 
• Under the Slabs/Flanges tab, input 40 for LENGTH, 16 for THICKNESS, 

and 0.667 for WIDTH LEFT and 1.333 WIDTH RIGHT. Press MODIFY.  
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• Select the Longitudinal Beams tab. Input 16 for WIDTH and 48 for 
DEPTH. Press MODIFY. 

• Press OK. 

 

 
4. From the Input menu, select Supports. A dialog box appears. 

• Under the Columns tab, input 0 for STIFFNESS SHARE %. 
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• Next, input 16 for both the C1 and C2 values in both the ABOVE and 
BELOW rows. Press MODIFY. (Note: the default HEIGHT ABOVE and 
HEIGHT BELOW values of 10 are correct.)   

• Press COPY. Press the CHECK ALL button. Press OK.  

• Press OK again. 

 
5. From the Input menu, select Reinforcement. A dialog box appears.  

• Under the Slabs and Ribs tab, change the CLEAR COVER for both TOP 
and BOTTOM BARS to 1.75. 

• Under the Beams tab, change the CLEAR COVER for both TOP and 
BOTTOM BARS again to 1.75. 

• Use the drop down arrow for MINIMUM STIRRUP BAR SIZE to select #4.  

• Press OK. 
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6. From the Input menu, select Load Cases. A dialog box appears. 

• Since we are not considering lateral forces, click on WIND in the LABEL 
column on the list in the bottom half of the LOAD CASES dialog box and 
press the DELETE button. 

• Click on EQ in the LABEL column and press the DELETE button. 

• Press OK. 
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7. From the Input menu, select Load Combinations. A dialog box appears.  

• Delete all the load combinations by clicking anywhere on the list in the 
bottom half of the LOAD COMBINATIONS dialog box and pressing the 
DELETE button. Repeat this procedure until all the load combinations are 
gone.  

• Input 0 in the SELF field, 1.2 in the DEAD field, and 1.6 in the LIVE 
field. Press ADD. 

• Press OK. 

 
8. From the Input menu, select Span Loads. A dialog box appears. 

• Press the drop down arrow next to TYPE, and select LINE LOAD. 
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• Input 4080 for both the START and END MAGNITUDE. (Note: this value 
was obtained by converting the area loads on the roof and the beam’s self 
weight into line loads.)  

Dead Load = Superimposed Load + Self Weight of Spandrel Beam =  
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• Input 40 for the END LOCATION. Press ADD. 

• Critical section for torsion is at the face of the support because of 
concentrated torques applied by the double tee stems at a distance less 
than d from the face of the support. The critical section for shear is also at 
the face of support because the load on the spandrel beam is not applied 
close to the top of the member and because the concentrated forces 
transferred by the double tee stems are at a distance less than d from the 
face of support. A small dummy load of 0.001 kips at the face of support 
is therefore introduced in order to move the critical section for shear from 
the default location of d away from the support to the face of the support. 

• Use the drop down arrow next to TYPE, and select POINT FORCE. 

• Input 0.001 for the MAGNITUDE and 0.667 for the LOCATION. Press 
ADD. 

• Use the drop down arrow next to TYPE, and select POINT FORCE. 

• Input 0.001 for the MAGNITUDE and 39.333 for the LOCATION. Press 
ADD. 

• Use the drop down arrow next to TYPE, and select LINE TORQUE. 

• Input 3.15 for both the START and END MAGNITUDE. (Note: this value 
was obtained by multiplying the superimposed line load by the moment 
arm of 12 in.) 

Torsion Line Load (Dead) = ftftkip
ftin

inft
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• Keep the END LOCATION of 40 and press ADD.  
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9. In the top left corner of the SPAN LOADS dialog box, there is a section called 

CURRENT CASE. Click on LIVE. 
• Use the drop down arrow next to TYPE to select LINE LOAD. I 

• Input 1050 for both the START and END MAGNITUDE. (Note: this value 
was obtained by converting the area loads on the roof to line loads on the 
beam.) 

Live Load = ftlb
ft

psf /1050
2

70
30 =⎟

⎠

⎞
⎜
⎝

⎛×  

 
• Input 40 for the END LOCATION. Press ADD. 

• Use the drop down arrow next to TYPE, and select LINE TORQUE. 

• Input 1.05 for both the START and END MAGNITUDE. (Note: this value 
was obtained by multiplying the live line load by the moment arm of 12 
in.) 

 ftftkip
ftin

inftpsf /05.1
/12

12
2

7030 ⋅=×⎥
⎦

⎤
⎢
⎣

⎡
⎟
⎠
⎞

⎜
⎝
⎛×  

• Input 40 for the END LOCATION. Press ADD. 

• Press OK.  
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10. From the Solve menu, select Execute. Press CLOSE. 
11. From the Solve menu, select Results Report. 

• Use the scroll bars to scroll through the results file.  

• Use the ARROW keys or the mouse wheel to browse through different 
parts of the results quickly. Press the CLOSE button to close the RESULTS 
REPORT dialog box and return to spBeam. 

12. To view diagrams, select Loads, Internal Forces, Moment Capacity, Shear 
Capacity, Deflection, or Reinforcement from the View menu. Right click in 
any of these diagrams to get new copy, printing, or display options.  

13. You may print the results file by selecting Print Results from the File menu. 
To print any of the diagrams you selected to view, use the Print Preview 
command found by right clicking in the diagram’s window. After viewing the 
results, you may decide to investigate the input beams under the same loads 
but with a modified reinforcement configuration.  

14. From the Input menu, select General Information. In the General 
Information dialog box change the RUN MODE option to INVESTIGATION. Do 
not change any of the other options. Press OK 

15. From the Input menu, select the different commands under Reinforcement 
Criteria and Reinforcing Bars to modify the reinforcement configuration 
computed by the program. 

16. Repeat steps 10 and subsequent to perform the investigation and view the 
results.  
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Text Output 
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Graphical Output 

Loads 
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Internal Forces 
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Moment Capacity 
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Shear Capacity 
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Deflection 
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Reinforcement 
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Example 3 Design of a Continuous Beam  

Problem description 
The system shown in the following figure consists of five spans symmetric about 
the centerline. We will be designing beam ABCD assuming that the other half of 
the beam will be loaded and designed the same way. All beams have a width of 12 
in. and a depth of 22 in. – including the 5 in. thick deck. Span length and widths 
are shown in the figure. Columns have a 12 in. × 12in. cross-section and a length 
equal to a typical story height of 13 ft. The system will be analyzed and designed 
under a uniform live load of 130 psf and a dead load that consists of the slab 
system’s own weight plus 80 psf. Use f’c = 4 ksi, fy = 60 ksi, and γconcrete = 150 pcf. 
This example refers to example 16.1 from Structural Concrete: Theory and Design 
by Hassoun and Al-Manaseer, Third Edition, 2008. 

24'

26'

12' 12' 12' 12'

13'

A

B

C

Symmetrical 
about

CL CL

CL
D

 

Preparing Input 
1. From the Input menu, select General Information. A dialog box appears. 
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• In the LABELS section, input the names of the project, frame, and 
engineer.  

• In the FRAME section, input 6 for NO OF SUPPORTS as the spBeam models 
the entire continuous beam.  

• In the FLOOR SYSTEM section, click the radial button next to ONE-WAY / 
BEAM.  

• Leave all other options in the General Information tab to their default 
settings of ACI 318-08 design code, ASTM A615 reinforcement, and 
DESIGN run mode option.  

• In the Solve Options tab, keep the default settings. Press OK. 

   
2. Nothing needs to be changed in the Material Properties menu.  
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3. From the Input menu, select Spans. A dialog box appears. 

• Under the Slabs/Flanges tab, input 24 for LENGTH, 5 for THICKNESS, 
and 0 for WIDTH LEFT and WIDTH RIGHT. Press MODIFY. (Note: Since 
the slab has no width, we must convert the area loads to line loads along 
the beam and also add the self-weight of the slab to the dead load. This 
calculation will be shown in Step 8.) 

• Press COPY. Select the check box next to Span 5. Press OK. This will give 
Span 5 the same geometry as Span 1. 

• Press the drop down arrow next to SPAN and select Span 2. Input 26 for 
LENGTH, 5 for THICKNESS, and 0 for WIDTH LEFT and WIDTH RIGHT. 
Press MODIFY.  

• Press COPY. Unselect the check box next to Span 1 and select the check 
boxes next to Spans 3 and 4. Press OK. 

• Select the Longitudinal Beams tab. Input 12 for WIDTH and 22 for 
DEPTH. Press MODIFY. 

• Press COPY. Press the CHECK ALL button. Press OK. 

• Press OK again. 
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4. From the Input menu, select Supports. A dialog box appears. 

• Under the Columns tab, input 13 for both HEIGHT ABOVE and HEIGHT 
BELOW. Press MODIFY. (Note: the default C1 and C2 values for both the 
column above and below the support can be left alone since all the 
columns’ cross sections are 12 in. × 12 in.) 

• Press COPY. Press the CHECK ALL button. Press OK. 

• Press OK again. 
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5. From the Input menu, select Reinforcement Criteria. A dialog box appears. 

• Under the Beams tab, use the drop down arrows to change both the MIN 
and MAX BAR SIZE for TOP BARS to #9.  

• Use the drop down arrows to change both the MIN and MAX BAR SIZE for 
BOTTOM BARS to #8. Press OK. 

 
6. From the Input menu, select Load Cases. A dialog box appears. 

• Since we are not considering lateral forces, click on WIND in the LABEL 
column on the list in the bottom half of the LOAD CASES dialog box and 
press the DELETE button. 
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• Click on EQ in the LABEL column and press the DELETE button. Press 
OK. 

 
7. From the Input menu, select Load Combinations. A dialog box appears.  

• Delete all the load combinations by clicking anywhere on the list in the 
bottom half of the LOAD COMBINATIONS dialog box and pressing the 
DELETE button. Repeat this procedure until all the load combinations are 
gone.  

• Input 1.2 in the SELF field, 1.2 in the DEAD field, and 1.6 in the LIVE 
field. Press ADD. 

• Press OK. 
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8. From the Input menu, select Span Loads. A dialog box appears. 
• Press the drop down arrow next to TYPE, and select LINE LOAD. 

• Input 1647.5 for both the START and END MAGNITUDE. (Note: This 
value was obtained by converting the area loads of the of the slab’s self 
weight (without the beam) and superimposed dead load into a line load.) 

Dead Load =  

ft/lb5.1647

)pcf150
ftin144
in12in5()ft12*psf80()ft12pcf150ft

12
5( 22

=

=×
×

−+××
 

• Input 24 for the END LOCATION. Press ADD. 

• Click on SPAN 1 on the list in the bottom half of the SPAN LOADS dialog 
box. Press the COPY button. (Note: there is a CASE COPY button that 
should not be pressed.) 

• Click the check box next to SPAN 5 and press OK. 

• Back in the SPAN LOADS dialog box, use the drop down arrow next to 
SPAN to select SPAN 2. Keep the START and END MAGNITUDES of 
1647.5 lb/ft but change the END LOCATION to 26. Click the ADD 
button. 

• Click on SPAN 2 in the list at the bottom half of the SPAN LOADS dialog 
box. Press the COPY button. 

• Click the check boxes next to SPAN 3 and 4. Press OK. 
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9. In the top left corner of the SPAN LOADS dialog box, there is a section called 
CURRENT CASE. Click on LIVE. 
• Use the drop down arrow next to SPAN to select SPAN 1. 

• Making sure that LINE LOAD is still the selected LOAD TYPE, input 1560 
for both the START and END MAGNITUDE. 

Live Load = ft/lb1560)ft12psf130( =×  
• Input 24 for the END LOCATION. Press ADD. 

• Click on SPAN 1 on the list in the bottom half of the SPAN LOADS dialog 
box. Press the COPY button. (Note: the CASE COPY button should not be 
pressed.) 

• Click the check box next to SPAN 5 and press OK. 

• Back in the SPAN LOADS dialog box, use the drop down arrow next to 
SPANS to select SPAN 2. Keep the START and END MAGNITUDES of 1560 
lb/ft but change the END LOCATION to 26. Click the ADD button. 

• Click on SPAN 2 in the list at the bottom half of the SPAN LOADS dialog 
box. Press the COPY button. 

• Click the check boxes next to SPAN 3 AND 4. Press OK. 

• Press OK again. 

 
10. From the Solve menu, select Execute. Press CLOSE. 
11. From the Solve menu, select Results Report. 
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• Use the scroll bars to scroll through the results file.  

• Use the ARROW keys or the mouse wheel to browse through different 
parts of the results quickly. Press the CLOSE button to close the RESULTS 
REPORT dialog box and return to spBeam. 

12. To view diagrams, select Loads, Internal Forces, Moment Capacity, Shear 
Capacity, Deflection, or Reinforcement from the View menu. Right click in 
any of these diagrams to get new copy, printing, or display options.  

13. You may print the results file by selecting Print Results from the File menu. 
To print any of the diagrams you selected to view, use the Print Preview 
command found by right clicking in the diagram’s window. After viewing the 
results, you may decide to investigate the input beams under the same loads 
but with a modified reinforcement configuration.  

14. From the Input menu, select General Information. In the General 
Information dialog box change the RUN MODE option to INVESTIGATION. Do 
not change any of the other options. Press OK 

15. From the Input menu, select the different commands under Reinforcement 
Criteria and Reinforcing Bars to modify the reinforcement configuration 
computed by the program. 

16. Repeat steps 10 and subsequent to perform the investigation and view the 
results.  
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Text Output) 
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Graphical Output 

Loads 
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Internal Forces 
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Moment Capacity 
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Shear Capacity 
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Deflection 
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Flexural Rebar 
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Transverse Rebar 
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Example 4 Flat Plate Floor System  

Problem description 
An office building is planned using a flat plate floor system with the column 
layout as shown in figure below. No beams, drop panels, or column capitals are 
permitted. Specified live load is 100 psf and dead load will include the weight of 
the slab plus an allowance of 20 psf for finish floor plus suspended loads. The 
columns will be 18 in. square, and the floor-to-floor height of the structure will be 
12 ft. The slab thickness will be 8.5 in. according to ACI Code. Design the interior 
panel C, using material strengths fy = 60,000 psi and f’c = 4000 psi. Straight-bar 
reinforcement will be used. This example refers to Example 13-3 from Design of 
Concrete Structures by Nilson, Darwin, and Dolan, Thirteenth Edition, 2004  

22'-0"22'-0"22'-0"9"

22'-0"

22'-0"

22'-0"

9"

9"

9"

All columns 18" × 18"

A B

B C
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Preparing Input 
1. From the Input menu, select General Information. A dialog box appears.  

• In the LABELS section, input the names of the project, frame, and 
engineer.  

• In the FRAME section, input 4 for NO OF SUPPORTS.  

• In the FLOOR SYSTEM section, click the radial button next to TWO-WAY.  

• Leave all other options in the General Information tab to their default 
settings of ACI 318-08 design code, ASTM A615 reinforcement, and 
DESIGN run mode option.  

 
2. Nothing needs to be changed in the Material Properties menu.  
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3. From the Input menu, select Spans. A dialog box appears. 

• Under the Slabs/Flanges tab, input 22 for LENGTH, 8.5 for THICKNESS, 
and 11 for WIDTH LEFT and WIDTH RIGHT. Press MODIFY.  

• Press COPY. Press the CHECK ALL button. Press OK. 

• Press OK again. 

 
4. From the Input menu, select Supports. A dialog box appears. 

• Under the Columns tab, input 12 for the HEIGHT in both the ABOVE and 
BELOW rows. 
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• Input 18 for both the C1 and C2 values in both the ABOVE and BELOW 
rows. Press MODIFY.  

• Press COPY. Press the CHECK ALL button. Press OK.  

• Press OK again. 

 
5. From the Input menu, select Reinforcement Criteria.  

• Use the drop down arrow next to MAX BAR SIZE for both TOP BARS and 
BOTTOM BARS to select #6 bars.  

• Press OK.  
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6. From the Input menu, select Load Cases. A dialog box appears. 
• Since we are not considering lateral forces, click on WIND in the LABEL 

column on the list in the bottom half of the LOAD CASES dialog box and 
press the DELETE button. 

• Click on EQ in the LABEL column and press the DELETE button. Press 
OK. 

 
7. From the Input menu, select Load Combinations. A dialog box appears.  

• Delete all the load combinations by clicking anywhere on the list in the 
bottom half of the LOAD COMBINATIONS dialog box and pressing the 
DELETE button. Repeat this procedure until all the load combinations are 
gone.  

• Input 1.2 in the SELF field, 1.2 in the DEAD field, and 1.6 in the LIVE 
field. Press ADD. 

• Press OK. 
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8. From the Input menu, select Span Loads. A dialog box appears. 

• Input 20 for the MAGNITUDE. Press ADD.  

• Press COPY. Press the CHECK ALL button. Press OK. 

• In the top left corner of the SPAN LOADS dialog box, there is a section 
called CURRENT CASE. Click on LIVE. 

• Input 100 for MAGNITUDE. Press ADD. 

• Press COPY. Press the CHECK ALL button. Press OK. 

• Press OK again. 
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9. From the Solve menu, select Execute. Press CLOSE. 
10. From the Solve menu, select Results Report. 

• Use the scroll bars to scroll through the results file.  

• Use the ARROW keys or the mouse wheel to browse through different 
parts of the results quickly. Press the CLOSE button to close the RESULTS 
REPORT dialog box and return to spBeam. 

11. To view diagrams, select Loads, Internal Forces, Moment Capacity, Shear 
Capacity, Deflection, or Reinforcement from the View menu. Right click in 
any of these diagrams to get new copy, printing, or display options.  

12. You may print the results file by selecting Print Results from the File menu. 
To print any of the diagrams you selected to view, use the Print Preview 
command found by right clicking in the diagram’s window. After viewing the 
results, you may decide to investigate the input beams under the same loads 
but with a modified reinforcement configuration.  

13. From the Input menu, select General Information. In the General 
Information dialog box change the RUN MODE option to INVESTIGATION. Do 
not change any of the other options. Press OK 

14. From the Input menu, select the different commands under Reinforcement 
Criteria and Reinforcing Bars to modify the reinforcement configuration 
computed by the program. 

15. Repeat steps 10 and subsequent to perform the investigation and view the 
results.  



 

Examples  6-73 

Text Output 
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Graphical Output 

Loads 
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Internal Forces 
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Moment Capacity 
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Shear Capacity 
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Deflection 
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Reinforcement 
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Example 5 Two-way slab system  

Problem description 
Using the Equivalent Frame Method, determine design moments for the slab 
system in the direction shown, for an intermediate floor. This example refers to 
Example 20-2 from PCA Notes on ACI 318-08 Building Code Requirements for 
Structural Concrete, Portland Cement Association, 2008. 

22'-0" 22'-0"

17'-6"
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17'-6"

design strip
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Story height = 12 ft 
Edge beam dimensions = 14 × 27 in. 
Interior beam dimensions = 14 × 20 in. 
Column dimensions = 18 × 18 in.  
Service live load = 100 psf 
Dead load = self weight 
f′c = 4000 psi (for all members), normal weight concrete 
fy  = 60,000 psi 

Preparing Input 
1. From the Input menu, select General Information. A dialog box appears.  

• In the LABELS section, input the names of the project, frame, and 
engineer.  

• In the FRAME section, input 4 for NO OF SUPPORTS.  
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• In the FLOOR SYSTEM section, click the radial button next to TWO-WAY.  

• Leave all other options in the General Information tab to their default 
settings of ACI 318-08 design code, ASTM A615 reinforcement, and 
DESIGN run mode option.  

 
2. Nothing needs to be changed in the Material Properties menu.  

 
3. From the Input menu, select Spans. A dialog box appears. 

• Under the Slabs/Flanges tab, input 17.5 for LENGTH, 6 for THICKNESS, 
and 11 for WIDTH LEFT and WIDTH RIGHT. Press MODIFY.  

• Press COPY. Press the CHECK ALL button. Press OK. 
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• Select the Longitudinal Beams tab. Input 14 for WIDTH and 20 for 
DEPTH. Press MODIFY. 

• Press COPY. Press the CHECK ALL button. Press OK. 

• Press OK again. 

 

 
4. From the Input menu, select Supports. A dialog box appears. 

• Under the Columns tab, input 12 for the HEIGHT in both the ABOVE and 
BELOW rows. 
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• Input 18 for both the C1 and C2 values in both the ABOVE and BELOW 
rows. Press MODIFY.  

• Press COPY. Press the CHECK ALL button. Press OK. 

• Under the Transverse Beams tab, input 14 for WIDTH and 27 for 
DEPTH. Press MODIFY. 

• Press COPY. Click the check box next to SUPPORT 4. Press OK.  

• Use the drop down arrow next to SUPPORT to select SUPPORT 2.  

• Input 14 for WIDTH and 20 for DEPTH. Press MODIFY.  

• Press COPY. Click the check box next to SUPPORT 3 and unclick the check 
box next to SUPPORT 1. Press OK.  

• Press OK again. 
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5. Nothing needs to be changed in the Reinforcement menu.  
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6. From the Input menu, select Load Cases. A dialog box appears. 

• Since we are not considering lateral forces, click on WIND in the LABEL 
column on the list in the bottom half of the LOAD CASES dialog box and 
press the DELETE button. 

• Click on EQ in the LABEL column and press the DELETE button. Press 
OK. 

 
7. From the Input menu, select Load Combinations. A dialog box appears.  

• Delete all the load combinations by clicking anywhere on the list in the 
bottom half of the LOAD COMBINATIONS dialog box and pressing the 
DELETE button. Repeat this procedure until all the load combinations are 
gone.  
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• Input 1.2 in the SELF field, 1.2 in the DEAD field, and 1.6 in the LIVE 
field. Press ADD. 

• Press OK. 

 
8. From the Input menu, select Span Loads. A dialog box appears. 

• In the top left corner of the SPAN LOADS dialog box, there is a section 
called CURRENT CASE. Click on LIVE. 

• Input 100 for MAGNITUDE. Press ADD. 

• Press COPY. Press the CHECK ALL button. Press OK. 

• Press OK again. 
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9. From the Solve menu, select Execute. Press CLOSE. 
10. From the Solve menu, select Results Report. 

• Use the scroll bars to scroll through the results file.  

• Use the ARROW keys or the mouse wheel to browse through different 
parts of the results quickly. Press the CLOSE button to close the RESULTS 
REPORT dialog box and return to spBeam. 

11. To view diagrams, select Loads, Internal Forces, Moment Capacity, Shear 
Capacity, Deflection, or Reinforcement from the View menu. Right click in 
any of these diagrams to get new copy, printing, or display options.  

12. You may print the results file by selecting Print Results from the File menu. 
To print any of the diagrams you selected to view, use the Print Preview 
command found by right clicking in the diagram’s window. After viewing the 
results, you may decide to investigate the input beams under the same loads 
but with a modified reinforcement configuration.  

13. From the Input menu, select General Information. In the General 
Information dialog box change the RUN MODE option to INVESTIGATION. Do 
not change any of the other options. Press OK 

14. From the Input menu, select the different commands under Reinforcement 
Criteria and Reinforcing Bars to modify the reinforcement configuration 
computed by the program. 

15. Repeat steps 10 and subsequent to perform the investigation and view the 
results.  
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Graphical Output 

Loads 
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Internal Forces 
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Moment Capacity 
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Shear Capacity 
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Deflection 
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Beam Strip Flexural and Transverse Reinforcement 
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Middle Strip Flexural Reinforcement 
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Column Strip Flexural Reinforcement 

 



 

Appendix 
Conversion Factors - English to SI 

 
To convert from  To  Multiply by 

in. m (1000 mm)  0.025400 
ft m  0.304800 
lb N (0.001 kN)  4.448222 

kip (1000 lbs)  kN  4.448222 
plf (lb/ft)  N/m  14.593904 

psi (lb/in.2)  kPa  6.894757 
ksi (kips/in.2)  MPa  6.894757 

psf (lb/ft2)  N/m2 (Pa)  47.88026 
pcf (lb/ft3)  kg/m3  16.018460 

ft-kips  kN • m  1.355818 
 

Conversion Factors - SI to English 
 

To convert from To  Multiply by  
m (1000 mm) in  39.37008  

m ft  3.28084  
N (0.001 kN) lb  0.224809  

kN kip (1000 lbs)  0.224809  
kN/m plf (lb/ft)  68.52601  
MPa psi (lb/in2)  145.0377  
MPa ksi (kips/in2)  0.145038  

kN/m2 (kPa) psf (lb/ft2)  20.88555  
kg/m3  pcf (lb/ft3)  0.062428  
kN • m  ft-kips  0.737562  
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Contact Information 
 

Web Site:  http://www.StructurePoint.org 

E-mail:  info@StructurePoint.org  
 support@StructurePoint.org  

 StructurePoint, LLC.  
 5420 Old Orchard Road  
 Skokie, IL 60077  
 USA  
Phone:  (847) 966-4357  
Fax:  (847) 966-1542  
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